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I NTRODUCT ION

COURSE DESCRIPT ION

This course covers the concepts and functionality you need to know in order to use the InEight
Estimate software successfully. As a result, you will be able to build cost estimates and bid proposals
with precision and efficiency.

COURSE OBJECTIVES

As a result of this course, you will be able to use the InEight Estimate software to:

l Construct and modify cost estimates

l Calculate profit and finalize bid proposals

HOW TO USE THIS MANUAL

This training manual serves as the working guide during the E101 Essentials of Project Modeling and
Estimating instructor-led course. The first seven lessons of this document follow a natural progression
of putting an estimate together, from set up of a project to finalization of a bid. The remaining lessons
cover additional functionality that will help you build and review your project estimate more
effectively.

LESSONS

The following lessons are covered in this course:

Course Lessons

Lesson Topic



Course Lessons

Lesson 1 Estimating Core Concepts

Lesson 2 General Navigation

Lesson 3 Library Setup

Lesson 4 Project Setup

Lesson 5 Estimate Direct Costs

Lesson 6 Estimate Indirect Costs

Lesson 7 Finalize the Estimate

LESSON FORMAT

This manual is designed to be a “hands on” learning guide. As such, each lesson is organized into
sections:

Section Description

Objectives Specify what you will learn in each lesson.

Topics Organize the subject matter, with explanations of key concepts and terms.

Step by
Steps

Walk you through the “mechanics” of how to perform specific functions in the
software. For each step by step, you will use the Training Job that comes pre-
loaded in the InEight Estimate Estimating software.

Exercises Allow you to practice and reinforce what you learn. For each exercise, you will
use the Training Job that comes pre-loaded in the InEight Estimate Estimating
software.

Review Asks you questions to check what you have learned within each lesson.

CALL-OUTS

Throughout the document, you will also find important call-out banners.

Tips are for important notes and information you want to remember.

Notes are for critical information you need to know.
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ONGOING USE

This manual is also designed to be a comprehensive reference guide you can use outside of the
classroom and revisit as needed. Each lesson is compartmentalized so that you can refer back to each
lesson as needed.
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LESSON 1 — EST IMAT ING CORE
CONCEPTS

LESSON DURATION: 30 MINUTES

LESSON OBJECTIVES

After completing this lesson, you will be able to:

l Explain the estimating process in InEight Estimate

l Explain key terms and concepts

LESSON TOPICS



1 . 1 OVERV IEW OF THE EST IMAT ING
PROCESS

The estimating process typically progresses through the following five steps. If you are an Owner you
may not take part in all five of these steps, but may instead do a few in an iterative process as you
progress through stage gate approval phases.

1. Enter project details.

2. Enter proposal deliverables.

3. Calculate Direct & Indirect Project Cost.

4. Add Markup, Contingency, & Fees.

5. Distribute Cost + Markup to required structure.

The below table displays how these five steps correspond with specific forms in InEight Estimate:

Note the forms used in InEight Estimate to accomplish the steps above:

l Job Properties

l Pay Item & Proposal

l CBS (Cost Breakdown Structure)

l PBS (Price Breakdown Structure)
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The rest of this section walks you through an overview of each step in the process and its
corresponding form in InEight Estimate.

STEP 1 – ENTER PROJECT DETAILS

When you decide to estimate a new project, the first step is to create a new estimate and set it up with
the general project details. In InEight Estimate, you’ll enter basic information and project specific
settings in the Job Properties form from the Setup tab.

The Job Properties form is organized into tabs to help you keep track of all the basic information and
settings for the project. It begins with the Overview tab. You will move from left to right entering your
project specific information and adjusting any settings that differ from the default.

STEP 2 – ENTER PROPOSAL DELIVERABLES

For Contractors who are submitting a proposal to a client, this step enables you to enter the client
provided deliverables clients are requesting pricing for. Most Owners will skip this step unless there is
a need to track various funding sources or prepare for internal or external company billing.

In InEight Estimate this list of items is recorded in the Pay Item & Proposal Register on the Setup tab.
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• Notice that your pay items have no pricing when first entered because you have yet to figure out
costs. You will come back to this form later in the process to distribute your costs and markup.

STEP 3 – CALCULATE DIRECT & INDIRECT PROJECT
COST

Once you’ve set up your estimate, you will perform take-offs and cost analysis to determine the total
estimated cost to complete the entire scope of work.

The Cost Breakdown Structure (CBS) Register is the main form where you will do your cost estimating.

l It is the hierarchy of work activities that make up the estimate

l Each row in the CBS represents a work activity and is called a cost item
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STEP 4 – ADD MARKUP, CONTINGENCY, & FEES

Once you have estimated all project costs, you may need to add markup, contingency or other fees and
define the job’s profit in the Price Breakdown Structure form.
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STEP 5 – D ISTRIBUTE COST + MARKUP TO REQUIRED
STRUCTURE

You now have a target price or total estimated value that you can spread to your required project
deliverables, back in the Pay Item & Proposal form. InEight Estimate has tools within this form to help
automatically distribute your cost, overhead and all markups to the listed items.
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1 . 2 KEY CONCEPTS AND TERMS

To help you get started in InEight Estimate, you should know a few key terms:

l Job Folder

l Library

l Form

l Cost Item

l Pay Item

l Resource

l Assembly

1 .2 .1 JOB FOLDER

Job folders hold all the information for an individual project estimate. It is possible to import master
data into a job folder, but when you work in a job folder it is independent, meaning any activity
performed in that folder will not affect any other jobs and will not affect the library.
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When moving back and forth between jobs, make sure to always double-check that you
are in the right job.

1 .2 .2 L IBRARY

The Library is a storehouse for master data, such as:

• Labor, equipment, and material unit cost rates

• Standard account codes

• Units of measure

When you create a new job from scratch, default data and settings copy from the Library into your new
job folder, except for the resource rates. Multiple list of resource rates can be maintained in the library
so you must select which rates to populate a new estimate with. Four tag fields are available to filter
the resource rates you bring into an estimate from the master library. For example, you may select a
subset of your labor rates based on the geographical location of the project.

1 .2 .3 FORM

Any screen you open in InEight Estimate is considered a Form. There are three types of forms:
Standard, Register, and Record forms.

Standard Forms resemble typical data entry forms with fields available to fill in key project
information. They also may contain radio buttons or checkboxes to define settings for the job.

InEight Estimate uses tabs to group and organize entry fields and settings in a logical way,
so that the information is easy to access.
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Register Forms have a grid format of rows and columns, giving it a spreadsheet look and feel. Register
forms allow you to see information for multiple items at once. The Cost Breakdown Structure (CBS)
Register is an example of a register form.

In a register form, you can open a Record for individual items you want to drill into.

The Tab key is the best way to move among fields in InEight Estimate (instead of the
Enter key).

The below figure displays a Cost Item Record accessed by double clicking on that item on the Cost
Breakdown Structure (CBS) Register.
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1 .2 .4 COST ITEM

Cost items are the individual cost-related activities that make up the project. Cost items are organized
into a hierarchy in the Cost Breakdown Structure (CBS) Register. Each row in the CBS is considered a
cost item.

1 .2 .5 PAY ITEM

Pay items typically represent the owner required deliverables a contractor must submit pricing for. Pay
items are used to distribute the cost calculated in the Cost Breakdown Structure, with all markup,
including any fees or contingencies calculated in the Price Breakdown Structure. This allows the total
estimate value to be distributed to a structure that is different than the CBS. Pay Items are
predominantly used by contractors to prepare a bid sheet. Owners may use pay items to identify
funding sources or for various reporting needs.

1 .2 .6 RESOURCE

Resources are the building blocks of a detailed cost estimate.
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Resources are the people, equipment, material, and supplies needed to complete the project.
Resources are employed to cost items to develop an estimate, and are organized into seven categories
or types:

1. Labor

2. Construction Equipment

3. Rented Construction Equipment

4. Installed Equipment

5. Installed Materials

6. Supplies

7. Unique

1 .2 .7 RESOURCE ASSEMBLY

A Resource Assembly is a group of resources that are often used together. For example, for civil work,
you may group together an operator foreman, operator, and laborer, along with a loader and
excavator. When estimating, you can employ this assembly which includes all of the pre-selected
resources.

1 .2 .8 COST ITEM ASSEMBLY

A Cost Item Assembly is a predefined group of cost items that has cost based on estimator inputs to a
set of questions. Cost item assemblies provide parameter-driven estimating and can also refer to
reference tables. They allow companies to create intelligent construction systems to automatically
estimate various scopes of work, based upon a user providing specification and dimension variables.
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LESSON 1 REVIEW

1. Which InEight Estimate form is used to enter basic information about the job as well as
define our cost basis?

a. Pay Item & Proposal

b. Job Properties

c. Library

d. Job Folder

2. All default data and settings copy from the Library into your new job folder except:

a. Labor rates

b. Equipment rates

c. Material rates

d. All of the above

3. These are considered the “building blocks” of the job – you employ them to cost items to
develop your estimate.

a. Assemblies

b. Pay Items

c. Resources

d. Forms

LESSON 1 SUMMARY

As a result of this lesson, you can:

l Explain the estimating process in InEight Estimate

l Explain key terms and concepts
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LESSON 2 — GENERAL
NAV IGAT ION

LESSON DURATION: 45 MINUTES

LESSON OBJECTIVES

After completing this lesson, you will be able to:

l Navigate the InEight Estimate system interface

l Navigate system settings

l Manage columns in InEight Estimate registers

LESSON TOPICS



2 . 1 GENERAL NAV IGAT ION

This section explores the layout of InEight Estimate.

As a new user to the InEight, the First-time sign in dialog box opens when you first sign in, and presents
questions about your working environment in the Project Suite environment. Preferences are set for
language, date, and number formats and the User Agreement, which you must accept before you
begin. The First-time sign in dialog boxes only show for the initial sign-in to any of the InEight products.

STEP BY STEP — ESTIMATE PREFERENCES SETUP

1. Select your preferred language, and then click Next.

2. Scroll to the bottom of the user agreement, and then select the check box for the terms and
conditions and privacy policy. Click Next.

Make sure you have scrolled to the end of the user agreement
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3. Select a date format and number format, and then click Next.

2 .1 .1 ESTIMATE FIRST TIME ACCESS

Platform’s primary function lets you connect and share data between all Eight applications involved in
managing a project. This allows project management workflows to pass between jobsite, field office,
and front office seamlessly in a consistent and standardized user interface.

STEP BY STEP — LAUNCH ESTIMATE

1. After selecting a project from the home page, you can access Estimate from the Main menu in
Platform by selecting Estimate, or by clicking Launch on the Estimate tile.

2. When you select Estimate from the home page for the first time, you must click Download to
access the Estimate Launcher file.
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l The EstimateLauncher.msi file shows.
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l Opening the EstimateLauncher.msi file opens the InEight Estimate Launcher Setup
window.

3. Select Open, and then click Next to start the one-time Estimate Launcher download. Afterwards,
you will be able to open Estimate from the Main menu or the home page.

4. Click Finish to complete the Estimate Launcher Setup installation.
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5. Select Estimate again to start the Estimate Launcher, which extracts the required files to launch
the Estimate application.

After setting up your Estimate preferences and installing the Estimate launcher, you can begin using
Estimate.
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STEP BY STEP — ESTIMATE SUBSEQUENT USE

1. Launch Estimate by selecting Estimate from the Main menu.

l Estimate in the cloud looks and functions much like the Estimate on-premise version. For
example, opening a job from the landing page brings you to the Cost Breakdown Structure
register, or the register designated as the start page in the application settings.
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2 .1 .2 BACKSTAGE VIEW

When you open Estimate, you land in the Backstage view. You can also get to the Backstage view from
other tabs, by selecting the File tab.

Section Description

1 Create new jobs, open, save, or close opened jobs.

2 Access the library and open the Jobs page. In the Jobs page, you can access the
following options:

l Job Register
l Delete Job
l Compare Jobs
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Section Description

l Connected Analytics

3 Access templates, snapshots, and archive or restore options.
l Templates – Create job templates.
l Snapshots – Open the Snapshots page where you can create job snapshots
and open the Snapshot Register to access previously created snapshots.

l Archive / Restore – Open the Archive / Restore page where you can access
the following options:

o Archive Job
o Restore job
o Merge Jobs with Archive
o Archive Template
o Restore Template

4 Open the Settings page where you can access the following options:
l General – Customize General, Title Bars, Navigation Bar, Job Startup, and
Language options.

l Decimal Precision – Manage decimal precision for various values in
Estimate.

l Restore Defaults – Click to restore default values for selected settings.

5 Create a new job from scratch, from a template, from an existing job, or by using the
Bid Wizard..

6 View up to 10 recently opened jobs as a list or thumbnail tiles to quickly access
recently opened jobs. You can click the Favorites icon to the left of the job code to
label up to five jobs as favorites. The jobs labeled as favorites show at the top of the
list.

7 Change between the list view or tile view using the List-Tile view icon at the top
right of the section. The source for the thumbnail images in the tiles is from the
estimate project in InEight Platform. The following image shows the tile view.

InEight Inc.  |  Release 25.1 Page 45 of 411

Estimate Essentials User Guide 2.1 General Navigation



Section Description

8 Open the Job Register where you can search and open jobs that do not show in
Open a recent job list.

2.1.2 .1 ARCHIVE / RESTORE

From the Backstage View, you can back up and restore your jobs using the Archive/Restore feature.

STEP BY STEP — ARCHIVE AND RESTORE A JOB

1. Click File to open the Backstage View.

2. Select Archive / Restore.
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l Several options appear for archiving and restoring your jobs and library

3. Select Archive Job.

l The Job Register appears

4. Select the Training Job, then click OK.

5. When prompted to include attachments, click Yes.

l The Save As window appears

6. Browse to where you want to save the job, then click Save.

7. To restore the job, select Restore Job Archive from the Archive / Restore page of the Backstage
View.

8. Browse to the archived job and select it.

9. Click Open.

l If the job already exists, a prompt will appear asking if you want to overwrite it

l To overwrite it, select Yes

l If you select No, you will be prompted to save it under a new Job Code

2.1.2 .2 SETTINGS

From the Settings in the Backstage view, you can adjust some system settings:

l General Settings

l Default Job Start page

l Decimal Precision
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l Language

2.1.2 .3 PROMPT TO SAVE

An important setting to visit in the Tools menu is Prompt to Save. InEight Estimate does not
automatically save your work. Instead, it will prompt you to save as often as you specify in the general
settings.

2.1.2 .4 DECIMAL PRECISION

The Decimal Precision setting is also helpful. This is where you can specify the way your numbers
display in the system. For example, you may want your costs to display to the hundredth decimal place
(2), and your quantities to display as whole numbers with nothing to the right of the decimal (0).

Changing decimal precision does not affect the way your numbers are calculated.
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2 .1 .3 OPEN A JOB FOLDER

From the Backstage view, you can open a job folder by selecting Start. This opens the Start page,
where if you see your job, click to open it. If it’s not showing, clickMore Jobs on the bottom left, and
then select the job from the Job Register. The Job Register lists all of your existing job folders.

STEP BY STEP — OPEN A JOB FOLDER

1. From the Backstage view, under the Open a recent Job section, double click on your job.

2. The job folder opens by default to the Cost Breakdown Structure Register.
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You can change the default form that opens when you start up a job. From the Backstage view,
click on Settings to change the Job Startup > Start Page settings.

2 .1 .4 COMMON NAVIGATION

Access the common navigation slide-out panel by selecting the main menu located on the top left side
of the Estimate page. This feature provides a common navigation user experience that is shared
amongst all InEight products. The primary intent of this navigation menu is to provide a consistent
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InEight product experience, with similar Project Suite graphical interfaces, while working within
multiple InEight products.

Estimate's on-premise software is authenticated by your Windows login credentials, which is shown
below the main menu.

2 .1 .5 HELP BUBBLES

Help bubbles appear at various times in InEight Estimate, including the first time you open InEight
Estimate. These messages contain important information to clarify key functions in the system.

You can dismiss the message until the next time by closing it with the X in the corner or dismiss it
permanently by clicking the Never offer this help again link.
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2 .1 .6 DATA MAP

Found in the Price tab, the Data Map is a great way to view a high level summary of your estimate and
can be accessed at any time during the estimating process. You can see totals of direct costs, indirect
costs, profit, and overall bid price.
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2 .1 .7 INE IGHT ESTIMATE LAYOUT

The layout of InEight Estimate is workflow based. You will move from left to right on the tabs as you
enter your data for the project and work on developing your estimate.

2 .1 .8 OVERVIEW - SETUP TAB

Section Description

1 Initialize From the initialize section, you can access the following registers. Job
Properties is where you enter the basic project details. Foundation Setup
Data is where you populate all account codes and validated fields. The
Pay item & Proposal Register provides an alternate structure to distribute
estimated values. Bid Wizard helps automate the process of setting up
estimates by copying information that already exists in other jobs.

2 Resources In the Resources section, Resource Rates opens the Resource Rate
Register, where detail costs for labor, equipment and material is stored.
The Resource Assemblies opens the Resource Assembly Register,
where you create a combination of resources as an assembly and reuse
it as needed in multiple cost items.

3 Assemblies You can create a Cost Item Assembly to automatically estimate different
scopes of work based on input values. Standard tables – allow you to
create tables of reference data that can be accessed in any cost item
assembly.

4 Reports The Reports section is available from any tab. Depending on the tab you
access it from will bring you to reports specific to that tabs data. Here
you will find reports on resources such as Resources Changes,
Resource Utilization, and Resource Cost Details.
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2 .1 .9 OVERVIEW – ESTIMATE TAB

Section Description

1 Breakdown
Structures

From the Breakdown Structures section in the Estimate tab you can
access the Cost Breakdown Structure (CBS) Register, Account Code
Utilization Register, and Work Breakdown Structures (WBS) Register.

2 Resources Resource Rate Register is where you create or modify the rate charged
for labor, material and equipment resources. Different views of the
Resource Rate register such as Resource Utilization and Resource Cost
Details are available from the Resources section.

3 Excel
Workbook

InEight Estimate's integration with Microsoft Excel is a two-way
integration that allows you to update register fields in Estimate with data
contained in an Excel workbook, and update Excel cells with data
contained in a register field in Estimate. This is where you open the
embed excel workbook which is maintained as part of the estimate job
folder and where you preform the sync functions to send values back and
forth.

4 Schedule From the Schedule icon, you can access bi-directional integration with
Microsoft Project and Oracle Primavera. The Cash Flow graph displays
the projected cash flow of your project, along with the job financing
expense, individual cost category costs and resource utilization.

5 Indirect Cost
Items

Indirect Cost Items filters the CBS register to display cost items that
contain overhead costs that are not directly associated with any
particular deliverable items. Clicking on % Price Add on or Prime Bond
opens up these individual records.

6 Overhead
and Profit

Price Breakdown Structure (PBS) Register is a visual run-down of the
costs and profit that make up your Target Price. You can access the
Direct and Indirect Markup records or see totals of direct costs, indirect
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Section Description

costs, profit and overall bid price summarized in a Data Map.

7 Alternates Alternates are used to define alternate scenarios in order to assess the
impact of those scenarios.

8 Reports From the Reports section, you can run reports on CBS Summary, CBS
Details, CBS Outline, CBS Estimate Summary, CBS Currency
Comparison.

2 .1 .10 OVERVIEW – QUOTE TAB

Section Description

1 Setup Quotes are organized using Address book, Quote Group Tags,
Minority Setup and attachments in the Setup section. Address book
stores and maintains all information pertaining to subcontractors,
vendors, architects/engineers, etc. that you work with regularly. The
Minority Setup tab within Job Properties stores information about the
agency that authorizes the status of Minority Enterprises along with
their different types. You can use Quote Group Tags to group together
multiple resources or cost items that will be sent in a single request for
quote package to solicited contractors or vendors..

2 Quote
Management

Quote Management allows you to access the Requests for Quote
(RFQs) register and Quotes. Request for Quotes (RFQs) are
invitations to sellers, requesting that they submit pricing to provide
services, equipment or material based on the line items and resources
included in your estimate. The Quote Register stores all of the quote
responses you receive for that job.
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Section Description

3 Quote
Comparison &
Award

The Quote Comparison & Award section allows you to perform
comparative analysis across all the quotes you’ve received. You can
view a comparison of submitted pricing by resources or cost items.

4 Reports From the Reports section in Quotes you can run reports on Quote
Summary, Quote Record, Compare & Award, and Minority
Participation.

2 .1 .11 OVERVIEW – PRICE TAB

Section Description

1 Pay Items From the Pay Items section you can lock Cost items to Pay items and
access the Pay item & Proposal register. Under Pricing in Job Properties,
you can set up how the tool calculates profit and spreads pricing to your
pay items. In the Competitors section, you can keep track of companies
that have submitted bids as well as record and track competitor bid
prices.

2 Overhead
and Profit

The Price Breakdown Structure (PBS) Register is a visual run-down of
the costs and profit that make up your Target Price. You can access the
Direct and Indirect Markup records or see totals of direct costs, indirect
costs, profit and overall bid price summarized in a Data Map.

3 Audit Log You can access the PBS Changes register (which logs any changes that
effect the Target Price) and turn on/off logging PBS changes..

4 Alternates Alternates are used to define alternate scenarios in order to assess the
impact of those scenarios on the total estimate value.
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Section Description

5 Reports From the Reports section in the Price tab, you can generate reports for
Standard Proposal, DOT Proposal, Pay Item Summary, Pay Item
Currency Comparison, Pay Item Price Breakdown.

2 .1 .12 OVERVIEW - SYSTEM TAB

Section Description

1 Custom You can customize the titles and colors for different fields. You can export
and import saved Views, Titles, Colors and Output Settings. You can
customize reports generated by Estimate using External reports. External
References allows you to open external programs with Estimate.

2 Help You can access a comprehensive help system from the Help menu. You can
get information about the Estimate Version and all new updates about the
different versions.

2 .1 .13 OVERVIEW - INTEGRATIONS TAB
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Section Description

1 Publish
Estimate to a
New Project

Sends job data to InEight Platform Integration. You can continue using
Estimate during the publish and will be notified after the data has been
sent successfully.

2 Publish Cost
Items to Active
Project

Sends cost items to the active project.

3 App Logs Shows a list of InEight Project Suite application logs that you can
export to Excel.

2 .1 .14 L IBRARY

Click on the Library icon and the Library opens in its own window.

Users with sufficient security can access master information available in the Library.

The Library is covered in greater detail in 3.1 Library Overview on page 82

2 .1 .15 OPEN FORMS

The following steps assume you already opened the Training Job.

STEP BY STEP — OPEN FORMS

1. Click on the Setup tab.

2. In the Initialize section of the Setup tab, click on the drop-down menu for Job Properties.

3. Select Overview to open the Job Properties form.
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l Notice that each form opens in its own tab within the active job folder

l You can tab between these forms as you are working in InEight Estimate

l Once you are in a register, the Actions and More Actions tabs are available to you. The options
available are contextual to that register
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2 . 2 SYSTEM SETT INGS OPT IONS

From the Backstage View, you can access system settings. System settings contain options and settings
that effect the entire InEight Estimate system. These settings include:

l General settings (options)

l Title Bars

l Navigation Bar

l Job Startup

l Language

All of the settings under the Options branch are user-level settings.
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The following step by step walks you through configuring general settings (options).

STEP BY STEP — DECIMAL PRECISION

1. With InEight Estimate open, click on the File tab to go to the Backstage view.

2. Select Settings.

3. Select General under Options in the node tree on the left.

4. To activate Prompt to Save, select the Prompt to Save checkbox.

5. Select how often you want to be prompted (in minutes).

6. Select Decimal Precision in the tree on the left.

7. Review the default settings.

Units of Measure will default to English, and Currency will default to U.S. Dollar.
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2 . 3 COLUMNS

Within each register, you can move, sort, filter and group your columns to view the information the
way you need to see it.

2 .3 .1 MOVE COLUMNS

You can move columns by selecting a column header and using drag-and-drop. If there are columns on
the register that you don’t use, you can hide and unhide them from view, as needed.

STEP BY STEP — MOVE COLUMNS

1. In the CBS, click on the Currency column header and drag the column to the left, dropping it to
the right of the Description column.

Page 62 of 411 InEight Inc.  |  Release 25.1

2.3 Columns Estimate Essentials User Guide



2. Hide the Optional Code column by dragging the Optional Code column header down until a black
X appears, then let go.

l The Optional Code is now hidden from view

l To unhide a column, right click on any column header and select Column Chooser; a
Customization window appears, which contains all the hidden columns in that register

3. Find the column you want to unhide and drag-and-drop it to the location where you want it to
go.
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l You can also unhide a column using the Go To Column feature

4. Right click on a column header and select Go To Column.

5. Click on the drop-down menu and select the column you want to unhide.
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6. Click OK.

2 .3 .2 SORT AND FILTER COLUMNS

You can sort and filter your columns to drill down to specific information.

STEP BY STEP — SORT COLUMNS

You can sort on any column by clicking once on the column header.

1. In the CBS Register, click on the Total Cost (Forecast) column to sort the column in ascending
order (e.g., 1 to 10, A to Z).

2. Click the Total Cost (Forecast) column a second time to sort in descending order (e.g.,10 to 1, Z
to A).

Use Ctrl-click to unsort a column and reset it to its original state.

STEP BY STEP — FILTER COLUMNS

1. In the CBS, hover over the Unit of Measure column header for the filter icon to appear.

2. Click on the filter icon in the Unit of Measure column to select a filter value.

l From the filter list, you can select any of the values defined for that column or you can use
one of the predefined values (Custom, Blanks, Non blanks).
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3. Make your selection, then click Close.

4. To clear the filter, click on the red X at the bottom of the form or click on the filter icon on the
header of the column you filtered and select (All), then click OK.
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2.3.2 .1 FILTER EDITOR OVERVIEW

Column filters can be managed on individual columns or for the entire register using the Filter Editor.
The Filter Editor tool lets work with all the column filters for a register view in one place as well as
creating more complex filters through the use of grouping and applying And/Or statements.

When you add a new Group, a new Condition is automatically added to that Group.

With each additional Condition statement, you need to select an operator and a value in order for your
customized filter to take effect on your chosen column. Many new comparison operators have been
added to this version as shown below:

CREATING COMPLEX FILTERS USING THE FILTER EDITOR

You can define filters across any of the columns available in the CBS register. You can also open the
Filter Editor using the button in the column filter drop-down, but regardless of how you access it, the
Filter Editor dialog permits defining a filter for the entire register and not just the selected column.

InEight Inc.  |  Release 25.1 Page 67 of 411

Estimate Essentials User Guide 2.3 Columns



Because all the register fields are available, more complex filters can be created by using Grouping and
Or operators. In the following example, a filter has been defined to return all Terminal Cost Items that
either have a cost source of Plug, or exceed $100,000 of Total Cost (Forecast).
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When modifying a filter, the Filter Editor can be invoked by clicking the Edit Filter button located on
the bottom right of the CBS page.
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STEP BY STEP — FILTER EDITOR

1. In the CBS, hover over the Unit of Measure column header for the filter icon to appear.

2. Click the Filter icon in the Unit of Measure column to select a filter value; select the desired
UoM.

3. Select the Filter Editor button, and the Filter Editor data box appears.

l By default, an And statement is created with a Begins with operator and a blank
value.

4. Select your preferred operator and enter in your preferred value.

5. To add additional And/Or statements, select the word And in the top left corner. A drop-down
appears.
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6. Choose which And/Or statement to add and then select the Preferred Operator.

7. Enter in your Preferred Value to complete your additional statement.

8. Click OK.

l Select the X to delete a single statement.

9. Select the And statement in the top left corner to begin clearing all And/Or statements.

10. From the drop-down, select the option Clear All.

11. Once done, select Apply and then click OK.

2 .3 .3 GROUP COLUMNS

Sometimes you may want to organize your information into groups. Instead of filtering your
information down to one value (e.g., unit of measure = Ton), you can look at your information with a
separate group for each value (e.g., a group for Tons, a group for Cubic Feet, etc.).

STEP BY STEP — GROUP COLUMNS

1. From the CBS register, group the Unit of Measure column by dragging it into the grouping area
(where it says “Drag columns here to group”).
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l Notice that the cost items in the register are now grouped together by their units of
measure, and each group of cost items is subtotalled by costs, hours, quantities, etc.

2. To ungroup, right click in the grouping area and select Clear Grouping

l The column returns to its original location

You can group by more than one column to have multiple grouping levels.

2 .3 .4 SAVED VIEWS

Once you have set up a view the way you like it, you can save the view so you won’t have to configure
it again later. InEight Estimate also comes with some pre-built views to help you organize the screen
the way you want to see it.

Views are accessed from the Saved Viewsmenu in the top right portion of a register.

The following steps assume you have made changes to your register view and want to save it for future
use.
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STEP BY STEP — CREATE A SAVED VIEW

1. In the CBS register, click on the Saved Views drop-down menu and the Save disc icon appears.

2. Click on the Save disc icon.

l The Save Current View window appears

3. Enter the View Name, then select OK.

l The new view displays in the drop-down menu

Saved views are user-specific; you will only see your own saved views when you are
logged in.

2 .3 .5 SUBTOTAL CALCULATOR

You can select multiple cost items and use the Subtotal Calculator to summarize and display Unit Cost,
Man-Hours/Unit and Units/Man-Hour. Highlight a cost item in the CBS and right click on a Total Cost
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column (e.g., Total Cost (Forecast), Labor Total Cost, Owned Equipment Total Cost, etc.). Select
Subtotal Calculator from the right click menu, and enter the number of units to use in your calculation.

2 .3 .6 REGISTER RUNNING TOTALS

You can select multiple rows in a register and see the sum total amount at the bottom of the register.

For example, you can hold down the CTRL key and multi-select cost items 2.1.1, 2.2.1, and 2.3.2 in the
CBS register, you can see the sum of the three selected cost items toward the bottom row of the
register.
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Estimate calculates subtotals for quantities when the UOMs match. Superior cost items are not
included in the subtotals to avoid any double counting in the subtotal.

It is not necessary to export data to Microsoft Excel and run separate calculations to better understand
costs of multiple items. The sigma symbol shows in the subtotaled row to indicate it is the total of the
selected rows.

2 . 4 F IND FEATURE

The Find feature lets you search across all columns in the register with a single operation. The
matching results are then highlighted in yellow. A scroll bar annotation is provided to indicate the rows
in the grid containing matches. This lets you easily navigate to the search results in the register.

The Find feature also includes the flexibility to perform more precise searches using various syntax in
the search bar. The Find search bar shows the currently selected and total number of search results.

If you type in two words, such as total cost, the grid considers them as individual
conditions and selects records that contain either total or cost.

Search Syntax Example

+ To find records that contain both search terms
like total cost, type + before the second word.
For example: total +cost.

- Type - to exclude records that contain a
specific word, for example: total-cost. You
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Search Syntax Example

can combine different operators. Use + and -
to select records that contain both pay and
item, excluding records that contain
assignment. For example: pay +item -
assignment.

"quotes" To search for a string that contains a space
character, you need to enclose this string in
quotation marks. For example: "total cost".

: To search against a specific column, type the
first letters of the column's display name plus
a colon character. For example: optional:
unassigned. Now the grid displays records
containing unassigned in the optional code
column.

If you add another column-specific condition, the grid joins them using the + logical operator. Then the
record shows the result that matches both options. The same happens when you join a column-specific
condition with the one applied to all columns. An example of this search criteria looks like this:
optional: unassigned +"pay item".

STEP BY STEP — FIND FEATURE

1. From the Cost Breakdown Structure (CBS) Register, bring up the Find feature using CTRL+F.

2. In the search bar, type inMaterials.

3. When all the searches are highlighted in yellow, use the up or down arrows to the right of the
search bar to navigate to the next search result in the register.
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4. To add the Find feature to the register functions header, select the Options icon to the far
right of the search bar. Then select Always Expanded.

5. To search in a specific column only, select the Options icon to the far right of the search
bar. Then select Search in Selected Column Only. Search a specific term in your
selected column.

6. To close the Find functionality, click the Close icon to the left of the search bar. You can
also hold down the Shift key and then select the F3 key to use this feature.

A drop-down can be used to see a list of previous searches.

2 . 5 KEYBOARD SHORTCUTS

2 .5 .1 NAVIGATING IN A REGISTER

Press To

Arrow keys Move one cell up, down, left, or right

Tab Move to the next cell in the same row

SHIFT+Tab Move to the previous cell in the same row

Home Move to the beginning of the cell
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Press To

End Move to the end of the cell

Page Down Move to the last row in the register

ALT+Down Arrow Shows the contents of drop-down list choices for applicable fields

Numpad * Expands the subordinate leaves of a tree structure for the currently
highlighted branch

Numpad + key Expands the currently highlighted section to display subordinate
sections

Numpad - key Collapses the currently highlighted section to remove the display
of subordinate sections

CTRL+Spacebar Selects and Deselects a row

CTRL+Tab Toggles the display of open windows

ALT Activates form menus

ALT+F4 Closes active form

CTRL+G Opens the Go To Column navigator

2 .5 .2 NAVIGATING IN A RECORD

Press To

Left and right arrow keys Move one character left or right in an editable field

TAB Move to the next editable field in the record

SHIFT+TAB Move to the previous editable field in the record

Home Move to the beginning of the field

End Move to the end of the field

ALT+Down Arrow Shows the contents of drop-down list choices for applicable fields

F4 Shows the contents of drop-down list choices for applicable fields

CTRL+Spacebar Selects and deselects a row
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Press To

CTRL+TAB Toggles the display of open windows

ALT Activates form menus

ALT+F4 Closes active form

CTRL+G Opens the Go To Column navigator

2 .5 .3 MENU AND KEYSTROKE COMMANDS

All forms have their own set of commands specific to the form. Commands for a form show in the
ribbon on contextual tabs (Actions and More Actions) when it is open and the form is active. Click a
command on the tab to order it. Some routine commands can be ordered using the standard Windows
keystroke combinations (e.g., Ctrl+C, Ctrl+V) or right-click with the mouse when the field is selected.

2 .5 .4 FUNCTION KEYS IN ESTIMATE

F1 Open to the Help

F2 (grid) Edit cell value: Enter edit mode for cells that are editable on the grid

F2 (tree list) Edit cell value: Enter edit mode for cells that are editable on the tree
list

F3 Find next: Finds the next value based on the search criteria

F4 (grid) Show selection register or options in the drop down

F5 Refresh, wherever available

F5 Collapse subordinate Items

F6 Expand subordinate Items

In the Account Code Utilization Register, F5 can either refresh or collapse subordinates
based on whether an account code is selected.
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LESSON 2 REVIEW

1. The _________ is a great way to get a summary view of your bid. You can see totals of
direct costs, indirect costs, profit and the overall bid price.

a. Job Folder

b. Data Map

c. System tab

d. Resource Rate Register

2. You can group by more than one column to have multiple grouping levels.

1. True

2. False

3. Display settings for Units of Measure, Currency, and Colors can be adjusted from the
_______ tab.

a. Setup

b. Estimate

c. System

d. Help

LESSON 2 SUMMARY

As a result of this lesson, you can:

l Navigate the InEight Estimate system interface

l Navigate system settings

l Manage columns in InEight Estimate registers
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LESSON 3 — L IBRARY SETUP

LESSON DURATION: 60 MINUTES

LESSON OBJECTIVES

After completing this lesson, you will be able to use the following forms and explain their purpose:

l Library Job Properties

l Library Foundation Setup Data Register

l Library Resource Rate Register

l Library Assembly Register

LESSON TOPICS



3 . 1 L IBRARY OVERV IEW

The Library is where you set up and maintain master information that imports into your projects,
including resource rates, tags, units of measure, cost item assemblies, and master breakdown
structures. It is also where security roles and permissions are configured.

You access the Library from the Backstage view in Estimate. Click on the Library link to open.

You can also access the Library by clicking on the Library icon, when on the InEight Estimate landing
page.
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When the Library opens, you see ribbons available under the main menu tabs. Each Menu tab has
unique sections which hold the necessary forms. In this lesson you will learn about each tab and their
components.

3 .1 .1 L IBRARY TABS

The Library has four tabs which organizes the forms under sections. The tabs are:

l Setup

l Estimate

l System

l Integrations

The Actions and More Actions tabs appear when you open a register and contain functions for the
register you have active. .

3.1.1 .1 SETUP TAB

Name Description

1 Job
Properties

The job properties maintained in the library will serve as the default
settings for any new estimate that is created from scratch. When
creating a new job it will inherit all the job properties set in the master
library.

2 Foundation
Setup Data

A master set of account codes, tags, and units of measure. When a
new folder is created, the master set is automatically copied from the
Library to the new folder.

3 Address Book Used to store and maintain all information pertaining to the companies
with whom you work and contact regularly (subcontractors, vendors,
architects, etc.).

4 Trench
Calculator

Stores and maintains common trench configurations that are used from
project to project.

5 Shift Rate Allows you to set up shift rate configurations that you can access at the

Overview - Setup Tab
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Name Description

Calculator project level.

6 Resources Opens the Library Resource Rate Register where you can create and
edit all resources and resource cost details available for import into
your projects.

7 Most Used
Resources

For quick access to the Labor, Equipment and Materials tabs of the
Master Resource Rate Register.

8 Resource
Assemblies

Takes you to the Library Resource Assembly Register where you can
set up resource assemblies to import into individual projects.

9 Cost Item
Assemblies

Cost Item Assemblies are predictive models to quickly and accurately
estimate elements of a job that can be repetitive in nature on the job or
from job to job.

10 Standard
Tables

The Standard Tables are used to create and/or list job-level table data
that is accessible by any of the Cost Item Assemblies that exist in a job.
The Standard Table Record allows the user to create and or modify a
Table record. The Standard Table Register lists all the job level tables
created / available in the project.

11 User Roles Opens the Register where you assign users to a role which can include
the forms, tabs and menu commands to which each role has access.
The user names that are used when setting up your User Profiles come
from Active Directory, and they are the user names that each user uses
when logging onto his/her personal computer.

12 Access
Control

Allows you to customize your system permissions by restricting
destinations or commands that only designated roles should have
access to.

13 Reports Opens the Reports window, where you can access all system reports
and configure the default report settings.

Overview - Setup Tab (continued)
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3.1.1 .2 ESTIMATE TAB

Name Description

1 Cost
Breakdown
Structure
(CBS)

Opens the Library Cost Break Structure register, where you can define the
CBS that will automatically import when a new project is created.

2 Account
Code
Utilization

Used to roll estimate line items into an account code hierarchy and
benchmark against historical projects in a way that is consistent across
projects.

3 Work
Breakdown
Structures

Opens the Library Work Breakdown Structure register, where you can
define additional Work Breakdown Structures that will automatically import
when a new project is created.

4 Master
Workbook

Opens the master Microsoft Excel template which will be embed into each
new estimate job folder. The cells in the embed excel workbook can be
linked to send information to or from InEight Estimate Fields.

5 Indirect Cost
Items

Takes you to the Library Cost Breakdown Structure Register where you
can edit and define indirect cost items.

6 Job Finance Takes you to the Library Cost Breakdown Structure Register where you
can edit the Job Financing cost item.

7 Price % Add
On

Takes you to the Price % Add On record, where you can define the price %
add to be included in the Library CBS.

8 Prime Bond Opens to the Library Prime Bond record where you can define the bond
tables that will import automatically when a new project is created. 

Overview - Estimate Tab
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Name Description

9 Reports Opens the Reports window, where you can access all system reports and
configure their report settings.

Overview - Estimate Tab (continued)

3.1 .1 .3 SYSTEM TAB

Name Description

1 Customize Window to customize the field titles that are displayed throughout various
screens in the system, including all cost category titles, user-defined Tags,
and more.

2 Saved
Views

Allows you to save your views onto a disk or load from a disk. 

3 Titles Allows you to save titles onto a disk or load from a disk. 

4 Colors Allows you to save your colors onto a disk or load from a disk.

5 Output
Settings

Allows you to save your output settings onto a disk or load from a disk.

6 External
Reports

Menu to not only generate reports created by Estimate, but also to open
programs, folders, documents, reports, or Internet resources with the
associated program.

7 External
References

Allows you to open programs, folders, documents, reports, or Internet
resources with the associated program.

Overview - System Tab
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Name Description

8 Help
Section

Offers you links to Estimate’s general Help menu, information about
Estimate (i.e., version number, system information, tech support, etc.),
What’s New in the new version, and InEight’s external website.

Overview - System Tab (continued)

EXTERNAL REPORTS

The External Reports menu lets you generate reports created by Estimate, and also lets you open
program files, folders, documents, or other internet resources.

Each menu item can be added to the External Reports menu. Upon selecting one of the menu items,
the associated program, file, folder document or URL will open, as defined by the command entered in
the Open column.
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To add a new menu text, first select the Add button and enter in a name in theMenu Text field, then
type in the location of the new Menu text under the Open field.
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Customized Job Folder Tags match the view of the fields in the Job Properties form.
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3.1.1 .4 INTEGRATIONS

Name Description

1 Publish Estimate to
a New Project

Lets you publish an estimate job to a new project. This
requires the installation of the data provider plug-in.

2 Publish Cost Items
to Active Project

Lets you publish cost items to an active project. This
requires the installation of the data provider plug-in.

3 App Logs Lets you open the Estimate application logs in Project
Suite, view log details, and export to Excel.

Overview - Integrations Tab

APP LOGS

The InEight Project Suite App Log lets you drill down to the Detail level which helps you find, analyze
and solve application errors.
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3 . 2 L IBRARY JOB PROPERT IES

The Library Job Properties form serves as a template for new jobs. Some of the tabs on the Library Job
Properties form hold basic settings that will require a default selection which will apply to all new jobs
created from scratch. Time can be saved when utilizing Library Job Properties, because the data and
settings you fill out will be automatically imported into a new job. Once imported, these settings can
be changed at the job level if necessary.

It may be helpful to complete the following tabs / fields at the Library level:

l Overview Tab Notes Field:  Filling out the Notes section at the Library level would be helpful for
any instructions or reminders that you want to display on all projects’ Job Properties form. For
example, “Always double check currency exchange rates”

l Cost Basis Tab:  Shift arrangements may or may not be standard across all projects, as well as
wage rates and scales. The cost basis default rules should be established within the library.

l Fuel Cost Tab:  Entering a default fuel cost here will factor with the utilization of your equipment

InEight Inc.  |  Release 25.1 Page 91 of 411

Estimate Essentials User Guide 3.2 Library Job Properties



to be included in your equipment rates

3 . 3 L IBRARY ADDRESS BOOK

Estimate's vendor and contact information in the address book register integrate with InEight
Platform's vendor and contact master data libraries.

Vendors and contacts are created and maintained in Platform's master data library as a single source
repository of vendor and contact data.
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The vendor and contact data structure shows a new hierarchy where multiple contacts can be assigned
to one vendor.

3 .3 .1 PRE-EXIST ING ESTIMATE DATA

Upon upgrading to version 23.6, address book records show a combined list of both pre-existing
Estimate Address Book records and Platform vendors and contacts. Pre-existing Estimate Address Book
records are still editable, but Platform records are not. The pre-existing disconnected vendors and
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contacts show a red glyph to the left of the Vendor ID column which shows that these records are
disconnected from Platform.

The existing contact records also have a vendor record associated with it. New vendors and contacts
must be added via Platform, and changes to any Platform originated records must be modified in
Platform. This promotes the use of Platform as the single source of creation and maintenance for
vendor master data.

3 .3 .2 ESTIMATE SPECIF IC DATA

Certain vendor affiliated qualification information required for estimating purposes such as licensed,
bonded and insured data, or minority participation, is maintained directly in Estimate only rather than
in Platform.

There can be other Estimate vendor and contact data that only exist in Estimate and not in Platform,
such as License, Bond, Insurance and Minority Certifications, and Default Quotes.
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3 .3 .3 ADDRESS BOOK LAYOUTS

You can choose between three address book page arrangements, vendors and contacts, vendors and
default quotes, and contacts.

3.3.3 .1 VENDORS AND CONTACTS

Vendors and Contacts are arranged where the vendor is the primary record in the register, and the
contacts associated with the vendor are shown as secondary detail records.
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3.3.3 .2 VENDORS AND DEFAULT QUOTES

Vendors and default quotes are arranged where the vendor is the primary record in the register, and
the default quote group assignments for the vendor are shown as secondary detail records.
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3.3.3 .3 CONTACTS

Contacts are arranged where the contacts are shown in a flat list and are not secondary detail records
under the Vendor. This layout can be used to search more easily for contacts regardless of their vendor
assignment.
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3 .3 .4 V IEW VENDORS AND CONTACTS IN INEIGHT
PLATFORM

Select View Vendors or View Contacts to open a new InEight Platform master data vendors and
contacts browser.

To view or edit a vendor, click the Vendor ID. The Platform Edit vendor > Vendor Details page opens.

3 .3 .5 VENDOR AND CONTACT CREATION

You can quickly create ad hoc vendors and contacts via the Quote Register and Record forms.

After you receive vendor quotes and you are ready to enter quote information, it can be an optimal
moment to create new vendors and contacts if they are not currently in the Address Book. Creating
vendors and contacts on the fly while the vendor quote information is readily available, and then
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entering the quote information is more expedient than leaving the quote to create the vendor and
contact in Platform. This is especially useful when you have multiple new vendor quotes.

You can create vendors and contacts on the fly in both the Quote Register > Address Book Register
Library and directly from the Quote record.

For example, when you are in a quote record and need to quickly create a new vendor because the
vendor you received a quote from does not yet exist, you can select the Vendor Quick Add button, and
then enter in the vendor details in the Vendor Record – Library form.
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You can also add additional qualification information in the License/Bond/Insurance and Minority
Certifications tabs.
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The additional qualification information is added and maintained in Estimate and cannot
be added to the vendor record when creating vendors directly in Platform.

After the vendor is created, it is included in the Library Address Book and can be chosen as a vendor to
be used on a quote.
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If you have a new contact to add, you can select the Contact Quick Add button, and then enter the
contact information.

After the contact is created, it becomes associated with the newly created vendor in the Library
Address Book.
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The vendor and contact information are stored in Platform where it can be easily accessed by selecting
one of the vendor ID links in the Library Address Book. The vendor can also be used by other Platform
applications.
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3 .3 .6 MERGE AND UPLOAD CONTACTS AND
VENDORS INTO PLATFORM

You can manage and retain all vendor information in the Estimate Address Book that are not linked
(disconnected) with Platform, including contacts and companies that are referenced in multiple
estimates, quotes and RFQs.

Disconnected Vendors and Contacts can be merged with existing Platform vendors and contacts, or
they can be uploaded to create new Platform vendors and contacts by navigating to the Library > Setup
> Address Book. You can also upload new Estimate vendors and contacts into Platform's master data
repository.

Estimate's process of uploading contacts and vendors into Platform's master data library (as a means
for all InEight products to access as a source system of contact and vendor data) not only lets you send
this information to Platform, but it provides you with a mechanism to clean up and simplify existing
Estimate Address Book data. For example, your current Estimate Address Book might contain many
duplicate contacts containing the same first and last name, but with different addresses, emails, or
mobile numbers. Merging these records helps administer customer data better so that you can
eventually only maintain a single contact or vendor that has the most up to date and most accurate
information.

3.3.6 .4 DISCONNECTED CONTACTS AND VENDORS

Pre-existing Estimate vendors and contacts that are disconnected from Platform show a red glyph to
the left of the Vendor ID column, and only exist in Estimate at this time. To only show the disconnected
records, click the column filter in the Vendor ID column, and then select (Blanks). You can either delete
the disconnected records or choose to merge or upload them into Platform.

Showing only the disconnected vendors or contacts helps you see the vendors and contacts that are
not connected with Platform.
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All new library address book records must be created in Platform.

Vendor and contact ID's that show a blank do not currently have an associated Platform vendor
association, as these vendors were originally created in Estimate. These vendors have not been merged
into Platform, and therefore have no association with the vendor master data that resides in Platform.

INACTIVE CONTACTS AND VENDORS

You can mark a vendor as Do Not Use in a contact record, which indicates the status of the contacts
associated vendor, and can only be set in Estimate when vendors are disconnected from Platform. The
record changes to red to signify it is inactive and cannot be used, but is not deleted from the system.
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To change the Do Not Use status, select the Vendor ID Platform link for the vendor record in Estimate.
In Platform, the Do Not Use flag can be maintained by selecting the Status field in Master Data Libraries
> Vendors, and automatically integrates with Estimate.
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STEP BY STEP — MERGE ESTIMATE VENDORS TO PLATFORM

1. Choose one connected and disconnected vendor, then selectMerge Vendors with Platform.

l Note that the connected Estimate vendor previously exists in Platform, prior to the
merge of the two vendor records.

2. SelectMerge.

l Notice that the primary vendor is checked, as this record already exists in Platform.
l Other records where the Primary field is not checked are records to be merged into
the primary record.

l Fields in yellow for the non-primary records are deltas. These deltas will not be
merged, and differences will be lost once they are merged, as the data that exists in
Platform takes precedence. If you want any of the disconnected data to exist in
Platform, you need to manually change the data in Platform. The advantage for this
is to allow for the disconnected Estimate vendors to become associated with an
already existing Platform vendor, which lets the contact to still be keyed in areas it
was used in Estimate, such as in Quotes and RFQs.

3. Select Yes in the Attention dialogue box to acknowledge that the attributes of the primary
contact will exist.
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STEP BY STEP — UPLOAD ESTIMATE VENDORS TO PLATFORM

1. Choose a disconnected vendor with an associated contact, and then select Upload Vendors to
Platform.

2. Click the + symbol to the left of the Vendor ID to expand all the records. Select Upload to sync
the vendor shown with the contact in this window to Platform.

l The preview dialog box opens.

3. Select Yes in the Attention dialogue box to confirm that the vendor will be uploaded to Platform
and synchronized back to the Estimate Address Book library.
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STEP BY STEP — MERGE CONTACTS TO PLATFORM

1. Choose one connected and one disconnected contact, and then selectMerge Contacts with
Platform.

l Prior to the merge, note that the connected Estimate contact previously exists in Platform,
prior to the merge of the two contact records.

2. SelectMerge.
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l Notice that the primary contact is checked, as this record already exists in Platform.

l Other records where the Primary field is not checked are records to merge into the
primary record.

l Fields in yellow for the non-primary records are deltas. These deltas will not be merged,
and differences will be lost after they are merged, as the data that exists in Platform takes
precedence. If you want any of the disconnected data to exist in Platform, you need to
manually change the data in Platform. The advantage for this is to allow for the
disconnected Estimate contact to become associated with an already existing Platform
contact, which lets the contact to still be keyed in areas it was used in Estimate, such as in
Quotes and RFQs.

3. Select Yes in the Attention dialogue box to acknowledge that the attributes of the primary
contact will exist.

l A message shows it was successful, and the entry is created in Platform.
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STEP BY STEP — UPLOAD CONTACTS TO PLATFORM

1. Choose a disconnected contact, and then select Upload Contacts to Platform.

2. Select Upload to send the contact shown in this window to Platform.

l The purpose of the preview dialog is to let you see what will be created in Platform, and to
correct any issues before completing the operation.

3. Select Yes in the Attention dialogue box to upload the contact to Platform, synchronize back to
Estimate, and save to the library.
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l A message shows it was successful, and the entry is created in Platform.
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STEP BY STEP — CREATE VENDORS AND CONTACTS VIA QUOTE
RECORD

1. Navigate to the Quote register and open an existing quote.

2. Click the Vendor Quick Add icon in the Quote Record register.

3. In the Vendor Record - Library window, enter a new Vendor ID and Vendor Name. Under the
Vendor Name field, enter in the other non-required information such as the Address and Phone
Number.
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4. On the right side of the window, enter any relevant information in the tabs, such as vendor
notes and license, bond and insurance information, and then click OK.

The new vendor is now added to the Estimate Address Book Register - Library.
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The following steps help to confirm that the vendor was created correctly, and that it can
be used to update or maintain the vendor after it has already been created, including steps
to create a new contact on the fly.
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5. Click the new Vendor ID in the Estimate Address Book Register - Library.

The new vendor opens in Project Suite > Master data libraries > Vendors.
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6. Click the Contact Quick Add icon in the Quote Record register.

7. In the Contact Record - Library window, enter the First Name, Last Name, Company, and
Primary Email. Under the Primary Email field, enter in the other non-required information such
as the Address and Phone Number, and then click OK.
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The new contact is now added to the Estimate Address Book Register - Library.
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8. Click the new contact Vendor ID in the Estimate Address Book Register - Library.
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The vendor opens in Project Suite > Master data libraries > Vendors, and includes the new
contact.
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3 . 4 L IBRARY JOB PROPERT IES PR IC ING

3 .4 .1 JOB PROPERTIES OVERVIEW

In Job Properties Overview > Pricing, there are balanced price and markup options in the bid pricing
area which lets you categorize costs, markup various costs in an estimate, and distribute that markup
throughout the bid which establishes balanced bid prices.

3 .4 .2 BALANCED PRICE OPTIONS

This option determines if a pay item will use the cost or billing amount values of the assigned cost
items as the basis for determining a balanced bid price. This also determines if the AutoPrice command
will use the cost or billing amount values.
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3.4.2 .1 CALCULATE BALANCED PAY ITEM PRICES USING
COST AMOUNT:

3.4 .2 .2 CALCULATE BALANCED PAY ITEM PRICES USING
BILLING AMOUNT:
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3.4.2 .3 DISTRIBUTION OF UNASSIGNED COSTS/BILLING
AMOUNT BY INDIVIDUAL CATEGORIES

Any costs in the estimate not assigned to a pay item needs to be proportionally spread back to all pay
items to determine a balanced bid price. This option lets the user choose the basis for calculating the
weighted distribution of any unassigned costs plus markup.

l Individual Categories - this option uses each individual cost categories as the basis for
establishing the weighted distribution amounts.
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l Top Level Cost Categories - This option uses the ten top level cost categories (labor, owned
equipment, rented equipment, supplies, materials, etc.) as the basis for establishing the
weighted distribution amounts.

l Total Cost[/Billing Amount] - This option uses Total Cost as the basis for establishing the
weighted distribution amounts.
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3.4.2 .4 MARKUP OPTIONS

This option determines how markup is applied to pay items when establishing a balanced bid price.

l Using Weighted Distribution. Marking up Pay Items using weighted distribution takes the total
markup and proportionally spreads the amount using the chosen weighted distribution method.

l Keeping Markup rates to Assigned Costs. This option uses the cost category amounts of all
assigned cost items and calculates the markup by applying markup percentages as defined in the
direct and indirect cost markup records. Excluding cost items from the dependency tab of the
markup record precludes the application of that markup percentage to the assigned costs on
that pay item.
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3.4.2 .5 CATEGORIZE BUSINESS OVERHEAD AS INDIRECT
COST

This option controls where cost Items with a cost segment of business overhead appear in the PBS.

l Indirect Cost - Business Overhead is included as a subcategory of indirect costs in the PBS.
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l Markup - Business Overhead is included as a subcategory of Markup in the PBS.

3.4.2 .6 CALCULATE PROPOSAL RECAP FORECAST MARKUP

This option determines how the Markup is determined in the Forecast column of the Proposal Recap
data block on the Pay Item & Proposal form.

l Unit Markup (current) × Forecast (T/O) Quantity - The Forecast Markup amount is determined as
the sum of each Pay Items Unit Markup (current) multiplied by the Pay Items Forecast (T/O)
Quantity.
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l Forecast Price Total Price - Total Cost/Billing. The markup amount is determined by subtracting
the sum of the total jobs cost based on forecast (T/O) quantities from the forecast bid price,
which is the sum of all pay item current unit prices multiplied by the pay items forecast (T/O
quantity).
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3 . 5 L IBRARY FOUNDAT ION SETUP DATA

Foundation Setup Data is where all drop-down options within Estimate fields are stored. These can
serve as category labels, alternate structures or validated tag fields. The different validated fields are
organized into tabs on this form.

You should be aware of these category labels:

Category Labels

Name Definition

Account
Codes

These codes will be set up on the back end and will help you compare your
cost and production rates to similar cost items in past projects.

Tags Some tags are already set up for you. Additional tags can be created and used
to group and filter your items.

Work
Breakdown
Structures

Use this format when you need to have multiple variations and summary
reports of an estimate. WBS retains the same relationships between items as
in the original estimate and only changes the view and how items are arranged
in hierarchy.

Units of
Measure

These are standardized to relate to one another by a conversion factor. If you
need to create a new unit of measure, you will need to reference it to a base
unit of measure and can include a conversion factor to allow you to convert
back and forth between English and Metric.

Currencies The default currency is set to U.S. Dollar, but you can also enter the exchange
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Category Labels

rate for other currencies (such as Canadian) so you can estimate with
whatever currency you need. Multiple currencies can be used in the same
project. The system base currency can be changed from USD in the
backstage view settings, but is a global change for the entire estimate
environment.

When you create a new job folder, all category labels defined in the Library Foundation Setup Data
Register will be copied to the new job folder automatically.

3 . 6 RESOURCES

VIDEO | Create a Unique Resource

InEight Estimate refers to labor, equipment and material items as Resources. You will use these
resources as the basic building blocks used to detail the costs in your estimates.

InEight Estimate organizes resources into seven types:

Resources

Name Description

Labor The human resources that perform direct or indirect work. Direct labor is
typically classified by trade (e.g., pipefitters, electricians, iron workers) and
title (e.g., foreman, journeyman, laborer).

Construction Owned construction equipment.
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Resources

Equipment

Rented
Construction
Equipment

Construction equipment rented from a third party.

Installed
Materials

Materials that will remain installed on site after the project is completed, (e.g.,
concrete, piping, aggregate).

Installed
Equipment

Equipment that will remain installed on site after the project is completed,
(e.g., boilers, heat exchangers, vessels, cooling towers).

Supplies Expendable items that will not be permanently installed (e.g., small tools,
consumables).

Unique Resources that are of a “unique” nature and do not fit well into the other types
(e.g., dump fees, hauling charges and equipment rented by the month).

After creating a new job folder, you can import a filtered set of resources from the Library into the new
project. This is done on the Cost Basis tab of the Job Properties form.

In the following section, you will learn more about the resources stored in your Library in the Library
Resource Rate Register.

3 .6 .1 L IBRARY RESOURCES REGISTER

To open the Library Resources Register, select Labor from the Master Resources ribbon.
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OVERVIEW – LIBRARY RESOURCE RATE REGISTER

Name Description

1 Tabs There are tabs along the top of the form for each of the seven resource
types, in addition to an All tab that holds the resources of all types.

l Notice that you are on the Labor Tab

2 Resource
Code

Each record (or row in the register) represents a single resource.

3 Description The Description provides more detail about the resource.

4 Resource
Rate per
Unit

This is the resource cost per unit.

5 Utilization
Count

Tells you how many units of that resource are being used in the job.

6 Unit of
Measure

Each resource is defined with a Unit of Measure.

7 Register This register includes columns for the resource attribute categories so you
can filter and group your resources.

SOURCE JOB AND SOURCE SYSTEM NAME FIELDS

The Source Job field provides visibility into the jobs from which the data may have originated from.

The Source System Name helps to see the source of the data when integrating with other systems.
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Resource rate add and search tips:

l You cannot add new resources on the All tab.
l You can search for resources in the Resource Rate Register using the ‘Find’ field.

Next you will take a look at the different types of resources and how they differ when we drill into
resource rate records from each category.

3 .6 .2 LABOR RESOURCES

Looking at your Labor resources more closely, you will see all the Resource Codes for the Labor
resources begin with an L. This is a best practice for naming and organizing your resources, but you can
also use another organizational method of your choice.

3 .6 .3 RESOURCE RATE RECORD

If you need to add cost to a resource, adjust a rate, or just view a more detailed breakdown, you can
open the resource’s rate record. From the Library Resource Rate Register, double click on the row
header for the resource you need to view in greater detail.
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OVERVIEW – RESOURCE RATE RECORD

Name Description

1 Record The record references the resource you are editing.

2 Charge Rate The Charge Rate tab is the tab the record defaults to and is where you
define the cost of the resource.

3 Scale Buttons The Scale buttons only show up on labor resources. They are used for
defining regular time, overtime and double time rates for the resource.

4 Cost
Category
Breakdown

The Cost Category Breakdown is where you enter the costs for the
resource. The categories will depend on what type of resource it is (e.g.,
equipment resources will have equipment cost categories and materials
will have material cost categories).

5 Special
Instructions /
Base Wage
Factors

The right side of the record will have additional options to help you define
the rate. These options change depending on what type of resource it is.
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Name Description

6 Setup There is also a Setup tab where you can define the resource’s attributes, plus
other settings. These attributes are used for filtering which resource rates to
load into a new estimate.

7 Cost
Driver

Labor resources default Cost Driver is CI Duration which means their costs
are driven by time.

8 Default
Quantity

The Default Quantity is typically set to 1 for most cases if you are bringing in
the resource you are using at least one.
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The following steps walk you through how to create a new labor resource.

STEP BY STEP — CREATE A LABOR RESOURCE

1. From the Library landing page, on the Setup tab, click on Resource Rates from the Master
Resources section.

l The Library Resource Rate Register opens

2. Select the Labor tab.

3. Right click on any row header and select New.

l A new Labor Rate Record displays

4. In the Code field, type L + [your initials].

5. Press the Tab key.

6. Fill in the Description field.

7. Click on the resource’s Setup tab and select Standard Labor Rate File from the Resource File
drop-down list.

8. Select a location for the Geographic Area.

9. SelectWage Zone A for Wage Zone.

10. Select a labor type for the Organizational Category.

11. For Tag 1, select a code.

12. For Tag 2, select a code.

13. On the Charge Rate tab, enter a dollar value for your Labor Base.

14. Expand Labor Burden and under Labor Fringes, type in a dollar value for Pension and
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Subsistence.

15. Define an overtime and double-time rate for the resource. Select the checkbox for Use Base
Wage Factors for Scales 2 and 3.

16. Set the Scale 2 Factor to 1.50 x Base Wage and Scale 3 Factor to 2.00 x Base Wage.
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17. Click OK, to close the record.

3 .6 .4 CONSTRUCTION EQUIPMENT RESOURCES

l Similar to Labor Resources, Construction Equipment Resources are also duration driven
resources by default

l They contain cost categories for ownership and operation costs

These resources are the fleet of construction equipment that you own.

3 .6 .5 RENTED EQUIPMENT RESOURCES

These resources represent the construction equipment that you rent.

l Rented Equipment Resources are also duration driven resources by default

l Contain cost categories for rental and operation cost as well as additional fees

l On the Rental Construction Equipment Record, you will notice a new tab named Quote

l Quotes will be discussed in detail in Lesson 8 – Quote Management

l You will also note the Tax section. You can check the box to Apply Standard Tax, which pulls the
Sales Tax percentage defined on the Cost Basis tab in Job Properties, or you can manually specify
a unique sales tax rate
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STEP BY STEP — CREATE A RENTAL EQUIPMENT RESOURCE

1. Open the Library Resource Rates Register.

2. Select the Rented Construction Equipment tab.

3. Right click on any row header and choose New; a new Installed Rented Equipment Rate Record
displays.

4. In the Code field, type RECR + [your initials], then press Tab.

5. In the Description field, type Crane 110 Ton.

6. Click on the resource’s Setup tab and select Standard Rental Rate File from the Resource File
drop-down list.

7. Select a resource from the Organizational Category drop-down list.

8. Move back to the Charge Rate tab to follow the step by step on the next page.

3 .6 .6 EQUIPMENT CONSUMPTION RATES

The Construction Equipment and Rented Construction Equipment Resource Rate Records include
consumption rates that will factor with the fuel cost you define on the Library Job Properties > Fuel
Cost tab to give a fuel cost for your equipment rate.
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The below figure shows where consumption rates are defined on the Construction Equipment
Resource Rate Record.

3 .6 .7 NON-HOURLY RATE CALCULATOR

For owned and rented construction equipment, the rate entered must be hourly. If your rate is weekly
or monthly, you can use the Non-Hourly Rate Calculator on the Construction Equipment Resource
Record to come up with the hourly rate.

STEP BY STEP — NON-HOURLY RATE CALCULATOR

1. Refer back to your last entry's rate amount. Under Non-Hourly Period Charge Rates on the right,
check the Calculate Non-Hourly Period Charge Rates checkbox.

2. On the resulting prompt, click OK.

3. In the Period field, selectWeekly.

4. In the Amount Per Period field, type in a number value.

5. Type in a number of hours in the Hours Per Period field.
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6. Click OK to close the record.

3 .6 .8 INSTALLED MATERIALS, INSTALLED
EQUIPMENT & SUPPLIES RESOURCES

l Comparing the Installed Material & Equipment resources to those covered so far, you will note
that the unit of measure is not Hour for materials, but it is specific to the kind of material. It is a
quantity-driven resource, as opposed to duration-driven like your labor and equipment
resources

l You will also note the tax field can pull your standard tax settings from the Cost Basis tab in Job
Properties, or a unique sales tax rate can be manually entered in each record

l On record for these resource types, you will notice a new tab named Quote. This tab shows up
here because you may have to shop around and get quotes for these resources

Page 142 of 411 InEight Inc.  |  Release 25.1

3.6 Resources Estimate Essentials User Guide



l Quotes will be discussed in detail in Lesson 8 – Quote Management

l In the Setup tab you will see a field named Waste % Add-on. Here you can account for
approximate waste percentages

l Cost categories will differ on each type of resource record

Above is an example of the Installed Material tab in the Library Resource Rate Register.

The following steps walk you through how to create a new material resource in InEight Estimate.

STEP BY STEP — CREATE AN INSTALLED MATERIAL RESOURCE

1. Select Resource Rates from the Library landing page.

l The Resource Rate Register displays

2. Select the Installed Material tab.

3. Right click on any row header and select New from the drop-down menu.

l A new Installed Material Rate Record displays

4. In the Code field, typeMGBP + [your initials], then press Tab.

5. In the Description field, type Brick Pavers.

6. Select a unit of measure from the Unit of Measure drop-down list.
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7. On the resource’s Setup tab, under Resource File select Standard Material Rate File.

8. On the Charge Rate tab, expand Materials and enter a number value in the Installed Materials
Amount field.

9. Click OK to finish adding this resource.

3 .6 .9 UNIQUE RESOURCES

The Unique resource type is a catch-all and can be used for anything from dump fees and security to
creating subcontractors as a resource.

l The Unique resources are the only resources that have all cost categories available, as well as all
units of measure

l You will also note the tax field which can pull your standard tax settings from the Cost Basis tab
in Job Properties, or a unique sales tax rate can be manually entered in each record

l Quotes will be discussed in detail in Lesson 8 – Quote Management
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3 . 7 RESOURCE ASSEMBL IES

A Resource Assembly is a group of resources. You can create an assembly once and then reuse it as
needed in multiple cost items whenever the same combination of resources is needed.

The most common use for an assembly is to group labor resources into crews (e.g., Pipe Crew,
Concrete Crew); however, any resource (equipment, materials, etc.) may be grouped into an assembly.
Utilizing assemblies allows you to estimate faster, since you can add and manage an entire group of
resources at once.

You can create assemblies in the Library and import them into job folders the same way you import
resources.

3 .7 .1 L IBRARY RESOURCE ASSEMBLY REGISTER

To open the Library Resource Assembly Register, select the Library icon, then select Resource
Assemblies from the Master Resources section of the Setup tab.

OVERVIEW – LIBRARY RESOURCE ASSEMBLY REGISTER

Section Description

1 Each row in the register represents a single resource assembly and is defined with
an Assembly Code and Assembly Description.

2 Each assembly can be expanded by clicking the plus icon next to its Assembly
Code.

3 Expanding an assembly reveals the list of resources that make up that assembly.
l Best practice for creating Assembly codes is to use C for Crew Assemblies, M
for Material Assemblies, etc., however you can have labor, equipment, and
materials in the same assembly
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3 .7 .2 RESOURCE ASSEMBLY RECORD

To open an existing Resource Assembly Record, right click on the row header of an assembly (row) on
the Resource Assembly Register and select Open.

OVERVIEW – RESOURCE ASSEMBLY RECORD

Name Description

1 Assembly
Code and
Description

Each assembly is defined with an assembly Code and an assembly
Description.

2 Quantity
and Unit of
Measure

Each assembly has a quantity and unit of measure. The default is 1 EA.
For crew assemblies with all hourly duration driven resources, it is a best
practice to change the Qty to Hour, so that when used on a cost item, it
will show you the assembly’s unit cost per hour.

3 Assembly
Details

The rows in the Assembly Details register represent the resources that
make up the resource assembly.

4 Notes An area where the estimators make notes for records related to the
resource assemblies for work orders which is commonly performed by a
type of crew.

Page 146 of 411 InEight Inc.  |  Release 25.1

3.7 Resource Assemblies Estimate Essentials User Guide



3.7.2 .1 PRODUCTIVITY RATE INDICATOR IN THE CBS
REGISTER

The Productivity Indicator shows the field that contains the as-entered value and is driving the
estimate for that cost item. This appears as an arrow aligned to the left of the cell as shown below.

Being able to see productivity drivers on the CBS register makes it easier to review and modify the
estimate as a whole while reducing the potential to accidentally overwrite a manually entered data.

Follow the step by step below to create a Resource Assembly.

STEP BY STEP — CREATE A RESOURCE ASSEMBLY

1. From the Library landing page, under the Master Resources section of the Setup tab, select
Resource Assemblies.

InEight Inc.  |  Release 25.1 Page 147 of 411

Estimate Essentials User Guide 3.7 Resource Assemblies



l The Resource Assembly Register is shown.

2. Right click on any row header and select New from the drop-down menu.

l A new Resource Assembly Record is shown.

3. In the Code field, type CEXC + [your initials] as the unique code for the assembly.

4. Add a description in the Description field.

5. In the Assembly Details register at the bottom of the screen, click in the Resource Code column
in the first blank row, and then select the Resource icon that appears in the cell.

6. On the Labor tab of the resulting register, select the resource with the Description: LL2Laborer
and click OK to add this resource to the assembly.

7. Add two additional resources.

You can use the Ctrl and Shift keys to select multiple resources at once.

8. Click OK to save and close the new assembly.
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EXERCISE 3.1 — CREATE RESOURCES & RESOURCE ASSEMBLIES

In this exercise, you will practice creating resources and assemblies in the InEight Estimate Library. In
the Library Resource Rate Register, create resources with the following variables:

Resource Code LSFA Wage Zone Wage Zone A

Resource
Description

Field
Administrator

Organizational
Category

Supervision

Geographic Area Southwest Scale 1 Labor Base $33.45

Scale 1 Premium 2 percent Scale 1 Subsistence $0.47

Resource File Standard Labor Rate File

Select the checkbox for Use Base Wage Factors for Scales 2 and 3.
Scale 2 Factor: 1.50 x Base Wage. Scale 3 Factor: 2.00 x Base Wage.

Labor Resource

Rented Construction Equipment Resource

Resource Code RPW3000 RE Rental Amount $3.40

Resource
Description

Pressure Washer 3000
PSI

Organizational
Category

Clean & Inspect

Resource File Standard Rental Rate File

Installed Material Resource

Resource Code MCCB Installed Materials Amount $300.00

Resource
Description

Pre-Cast Concrete
Catch Basin

Organizational Category Concrete

Resource File Standard Material Rate File

Unit of Measure Each

Uncheck the box for Apply Standard Tax and enter a Unique Sales Tax Rate: 6%

Rented Construction Equipment Resources
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In the Library Resource Assembly Rate Register, create resource
assemblies with the following codes, descriptions, and resources.

Assembly Code CBRIDGE

Assembly Description Bridge Crew

Resource File Standard Assembly File

Unit of Measure Hour

Select Wage Zone A Labor Resources for this Assembly.

Resources on Assembly Resource Description Resource Quantity

LC3 Carpenter Foreman 1

LL2 Laborer 2

LF2 Finisher 1

LC2 Carpenter Journeyman 2

Assembly #1

Assembly Code CRIPRAP

Assembly Description Rip Rap Replacement Crew

Resource File Standard Assembly File

Unite of Measure Hour

Select Wage Zone A Labor Resources for this Assembly.

Resources on Assembly Resource Description Resource Quantity

LT2 Teamster Foreman .5

LO3 Operator Class 3 1

LL2 Laborer 2

EX510 Backhoe JD 510 1

Assembly #2
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ETPU Pickup 1

EL950 Loader 950 1

Assembly #2 (continued)

You should end up with similar results:

Congratulations, you have completed this exercise!
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3 . 8 IMPORT ING RESOURCES

The following procedures inform you how to setup resources in InEight Estimate from an excel sheet.

Use of this lesson will draw from other sections of InEight Estimating Manual. Basic
understanding of the Sort, Group, Filter, Excel integration functionality in InEight Estimate
is required.

3 .8 .1 OPEN RESOURCE RATE REGISTER

You can create resources within the Resource Rate Register. This is the location to build out the
structure of those resources.

STEP BY STEP — OPENING THE LABOR TAB

1. Open the Job Folder or Library that you’re going to be working in.

2. From the Ribbon, select the Setup tab.

3. Under the Resources section, select Resource Rates. The Resource Rate Register opens.

4. Select the tab you want to add resources to.

The layout of this register and excel file is up to the organization and the decisions that are made
during the detail design phase. A basic excel file will be provided to your organization as a starting
point to work from. If that can’t be located, you can easily build one utilizing the views within InEight
Estimate.
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3.8.1 .1 CREATING A LABOR SAVED VIEW - RESOURCE RATE
REGISTER

You can create a view to mirror both the register and excel sheets to easily bring information back and
forth from the two applications.

Example of columns:

l User Defined 1
l Resource Code
l Description
l Resource File Description - Validated field
l Geographic Area - Validated field
l Wage Zone - Validated field
l Organizational Category - Validated field
l Tag 1 - Validated field
l Tag 2 - Validated field
l Currency - Validated field
l Default Quantity
l Use Base Wage Factors - Scale Factors
l Scale Factor 2 - Scale Factors
l Scale Factor 3 - Scale Factors

For more information on Validated Tags field, see Validated Tags topic. Scale Factors
aren’t required if you are manually applying rates to each cost category scale.

The view should appear as shown below with User Defined 1 in the first column. This field is used for
sorting and arranging data accurately moving between Estimate and Excel. You are not limited to UDF
1 and can choose to utilize a field of their choice for sorting.
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3 .8 .2 SETT ING UP THE EXCEL FILE

Go to the Excel sheet and make sure the information in the columns shown in the screenshot are filled
out. Basic concepts to keep in mind regarding the excel file:

Sort Code - This column needs to have a high sequential number such as 10000. This is very important
to assign as it will help us authenticate all the labor rates.

Resource Code - A unique Naming convention to be assigned to every labor resource. In this example
we have all labor resource starting with a L followed by the letters that represent the resource
description.

Labor Base - The base wage of the labor resource is entered here. Estimate does not allow $ sign to be
pasted, which is why the cells for the Base column are formatted to Number.

3.8.2 .2 CREATING THE RESOURCE

Follow this procedure once you have information filled out in excel.

STEP BY STEP — CREATING THE RESOURCE

1. Open the excel file.

2. Sort the sheet by sequential number in the Sort Code field.

3. Highlight the cells you want to bring into the estimate.

4. Copy the cells using right click and selecting Copy from the context menu.

Page 154 of 411 InEight Inc.  |  Release 25.1

3.8 Importing Resources Estimate Essentials User Guide



5. Open Estimate to the Resource Rate Register.

6. Select the User Defined 1 column in the Labor tab of the Resource Rate Register.

7. Right click the empty cell and select Paste from the context menu. A pop up will appear asking
Are you sure you want to insert the selected values?

8. Select Yes to confirm inserting the selected values.

9. The cells you copied from the excel sheet are now copied into the Resource Rate Register. The
Sort code data is pasted in the User defined 1 column. Resource Code & Resource description
data is pasted as well.
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10. For Make sure the sorting is on User Defined 1 column. This allows us to see the
information being sorted similar to our data in excel file. Base Wage Factors need
to be flagged to turn on with the check box. Your first copy and paste should have
activated them. You need to copy and paste again in order to apply the factors.

3.8.2 .3 RESOURCE COST DETAILS

Labor resources are now in the system a user can apply rates to those resources.
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STEP BY STEP — RESOURCE COST DETAIL

1. From the Ribbon, select the Actions tab.

2. Under the View section, select the Resource Cost Details option. The Resource Cost Details
Register opens.

3. Create a view to mirror the accompanying excel sheet or create one to bring in the
associated resource cost in the details register.

4. From the Saved views drop down, select the Labor view to filter down to only labor resources.

5. Right click a column header and select Column Chooser.

6. Drag and drop the columns into the view identified below.

Example of columns – The level of detail and utilization of specific cost categories is a decision for each
organization:

l User Defined 1 - Non editable fields from resource rates register
l Resource Code - Non editable fields from resource rates register
l Description - Non editable fields from resource rates register
l Resource File Description - Non editable fields from resource rates register
l Geographic Area - Non editable fields from resource rates register
l Wage Zone - Non editable fields from resource rates register
l Organizational Category - Non editable fields from resource rates register
l Scale - Non editable fields from resource rates register
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l Labor Base
l Travel
l Premium
l Holiday
l Savings
l Pension
l Vacation
l Subsistence
l Health & Welfare
l Apprenticeship
l Undefined Fringe 1
l Undefined Fringe 2
l Undefined Labor Fringes
l Bodily Injury & Property Damage
l Workers Compensation
l Undefined Insurance1
l Undefined Insurance2
l Undefined Labor Insurance
l FICA
l FUTA
l SUTA
l Undefined Tax1
l Undefined Labor Taxes
l Undefined Labor Burden
l Undefined Labor
l Construction Supplies
l Undefined Materials
l Undefined
l Billing Rate
l Billing Rate Markup
l Billing Rate Markup %
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3 .8 .3 F ILTER/SORT/PASTE - RESOURCE COST
DETAILS REGISTER

The Labor upload view brings in the columns required to enter Labor base, burdens etc. Every Labor
resource has three rows created with Scales 1,2,3. The Scale Column is used to setup Straight time,
Over time, Double time.

STEP BY STEP — FILTER RESOURCE COST DETAIL REGISTER

1. From the Scale column header, click the filter icon..

2. Set the From and To values to 1.

3. Back on the excel spreadsheet, highlight the base rates to bring in.

4. Right click and select Copy in the context menu.
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5. Go to Estimate. Right click and select Paste from the context menu.

6. You will be prompted with a Are you sure you want to insert these values?message as before.
Select Yes to continue.

3 .8 .4 MANUAL SET-UP OF SCALES 2 & 3 – OPTIONAL

If the organization wants to have more in-depth cost details for each scale rather than using scale
factors the same procedure will be utilized to copy Labor burden, fringes, and other add-ons to setup
Scale 2 & Scale 3.

For Base Wage Factor Columns will not be active if your organization is using method 2.
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3.8.4 .4 RESOURCE RATE REGISTER

3.8.4 .5 RESOURCE COST DETAILS REGISTER

STEP BY STEP — MANUAL SETUP OF SCALES

1. From the Scale column header, click the filter icon..

2. Set the From and To values to 2.
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3. Back on the excel spreadsheet, highlight the base rates to bring in.

4. Right click and select Copy in the context menu.

5. Go to Estimate. Right click and select Paste from the context menu.

6. You will be prompted with a Are you sure you want to insert these values?message as before.
Select Yes to continue.

7. Follow the same procedure for scale 3.

3.8.4 .6 NON LABOR RESOURCE SETUP

The same principles can be applied for the other resource types within InEight Estimate. This
procedure covers installed material, but can also be used for the other six resource types.

3 .8 .5 CREATING A MATERIALS SAVED VIEW -
RESOURCE RATE REGISTER

Create a view to mirror both the register and excel sheets to easily bring information back and forth
from the two applications.
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Example of columns

l User Defined 1
l Resource Code
l Description
l Resource File Description - Validated Tag field
l Geographic Area - Validated Tag field
l Wage Zone - Validated Tag field
l Organizational Category - Validated Tag field
l Tag 1 - Validated Tag field
l Tag 2 - Validated Tag field
l Currency - Validated Tag field
l Apply Standard Tax - Validated Tag field
l Unique Sales Tax
l Unit of Measure - Validated Tag field

3 .8 .6 CREATING A MATERIAL RESOURCE

Follow the step by step once you have information filled out in excel.

STEP BY STEP — CREATING THE RESOURCE

1. Open the excel file.

2. Sort the sheet by sequential number in the Sort Code field.

3. Highlight the cells you want to bring into the estimate.

4. Copy the cells using right click and selecting Copy from the context menu.
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5. Open Estimate to the Resource Rate Register.

6. Select the User Defined 1 column in the Installed Material tab of the Resource Rate Register.

7. Right click the empty cell and select Paste from the context menu. A pop up will appear asking
Are you sure you want to insert the selected values?
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8. You will be prompted with a Are you sure you want to insert these values?message. Click Yes
to continue.

3 .8 .7 CREATE A MATERIAL SAVED VIEW - RESOURCE
COST DETAILS REGISTER

Installed Material Resources are now in the system. You can apply rates to those resources. Create a
view to mirror the accompanying excel sheet or create one to bring in the associated resource cost in
the details register.

STEP BY STEP — MATERIAL SAVED VIEW

1. From the Ribbon, select the Actions tab.

2. Under the View section, select the Resource Cost Details option. The Resource Cost Details
Register opens.

3. Create a view to mirror the accompanying excel sheet or create one to bring in the
associated resource cost in the details register.

4. From the Saved views drop down, select the Installed material view to filter down to only
material resources.

5. Right click a column header and select Column Chooser.

6. Drag and drop the columns into the view identified below.

InEight Inc.  |  Release 25.1 Page 165 of 411

Estimate Essentials User Guide 3.8 Importing Resources



Example of columns – The level of detail and utilization of specific cost categories is a decision for each
organization:

l User Defined 1 - Non editable fields from resource rates register
l Resource Code - Non editable fields from resource rates register
l Description - Non editable fields from resource rates register
l Resource File Description - Non editable fields from resource rates register
l Geographic Area - Non editable fields from resource rates register
l Wage Zone - Non editable fields from resource rates register
l Organizational Category - Non editable fields from resource rates register
l Unit of Measure - Non editable fields from resource rates register
l Currency - Non editable fields from resource rates register
l Total - Non editable fields from resource rates register
l Installed Materials
l Undefined Materials
l Sales Taxes
l Undefined Fees
l Undefined
l Billing Rate
l Billing Rate Markup
l Billing Rate Markup %

3 . 9 QUANT ITY CHECK ING

The Quantity Checking feature allows you to compare the quantity of a superior cost item to the sum
of its relevant subordinate cost item quantities. This setting enables the use of the Quantity Check and
Quantity Warning columns in the Cost Breakdown Structure. The use of these columns can assist in
confirming whether or not your quantities are correct.

The subordinate cost item quantities need to have the same unit of measure as the
superior cost item before you are able to choose the Quantity Check column.

In the example below, break a concrete pour cost item into four subordinate parts. The Forecast (T/O)
Quantity of the superior item will be 156875.00 tons of concrete. Start by dividing each of the four
parts into 35000.00 tons each. Once you have broken out this concrete pour, determine if you need a
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fifth pour or if you should distribute the remaining quantity to the four pours. The factors you keep in
mind are the trips and time involved in the extra pour vs capacity of equipment.

STEP BY STEP — QUANTITY CHECKING

1. From the Ribbon, select the Setup tab.

2. Under the section Initialize, select Job Properties. Then select the Cost Basis tab.

Quantity checking starts by turning the feature on in the Job Properties. If you want
to have quantity checking turned on for all jobs in Estimate, then this setting needs
to be turned on in theMaster Job Properties. The Master Job Properties is located
in the Library.

3. From the Rules data box, select the Activate Quantity Checking check box.

4. Next bring a couple of columns into your view on the Cost Breakdown Structure (CBS) Register.
Right click on the column header and choose Go To Column.

5. The Go To Column dialog box appears. Have the Include columns that are not currently in the
view check box selected.
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6. Click OK when you have selected your preferred columns.

Next, toggle the check box for the Quantity Check column.

7. As you check Quantity Check for the four batches of Concrete, the superior cost
item Quantity Warning turns yellow. This is indicating a quantity warning. Hover
your mouse over the superior cost item Quantity Warning column. Then, an
overlay message appears showing the quantity discrepancy. Apply this discrepancy
to the Subordinate cost items. That way, the superior cost item with be the sum of
the parts.

8. The remaining quantity is 16875.00 tons which does not warrant a fifth pour.

3 . 10 SECUR ITY IN EST IMATE

3 .10 .1 ROLE BASED PERMISSIONS

Estimate uses a role-based security model, where users can be assigned to a role on a project. A role
identifies if a user has been granted access for various permissions to perform defined functions in
Estimate.
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A role is a collection of permissions that defines a user’s responsibilities on a project or in an
organization.

For example, Johny can be an Estimator on Job A and a Lead Estimator on Job B, giving him elevated
permissions to perform actions that a less responsible estimator may not permitted to perform.

Roles are created and managed in the Roles and Permissions page in the Suite Administration section
of InEight Platform (Suite Administration > Roles and permissions).
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The following image shows how the Estimator role has been defined with permissions to launch
Estimate, add and edit jobs, and view snapshots, but it does not have permissions to delete jobs or add
and edit snapshots.
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For more information on setting up roles in InEight Platform, see Roles & Permissions in the Knowledge
Library.

3 .10 .2 SECURITY IN ESTIMATE

The capacity to grant permissions in a job and what can be performed is accomplished with a
combination of permissions that exist in both Platform and Estimate.

Generally, permissions managed in Platform determine which users can launch Estimate and who can
manage jobs, snapshots, templates and access the Estimate library. Permissions managed in the
Estimate determine which users are granted permissions to specific commands and destinations solely
in Estimate.

For any user to use Estimate, they need to have a role that has been granted the Launch Estimate
permission, which is found in the Estimate blade of the Roles and permissions page when editing the
details of a role.
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3 .10 .3 GRANTING PERMISSIONS TO ACCESS JOBS
AND SNAPSHOTS

When creating jobs in Estimate, it is required to associate new estimates with existing Platform
projects and all the related OBS contents.

Multiple estimates can be assigned to a single Platform project. In this case, permissions
granted to users on a project will be the same permissions for all the estimates belonging
to that project.
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This Platform project is used to assign roles for the purposes of granting various permissions.

To grant permissions to a particular user on a Job, go to the User Management page in InEight
Platform, edit the user, and then assign the user a role on a project on the Roles tab of the Add or Edit
User slide-out panel.
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For more information on managing users, see the User Management section in Roles & Permissions in
the Knowledge Library.

In Estimate on-premise, roles are created and managed in the User Roles register. After
the role is created, users can be assigned to the role from the list in the Windows Active
Directory Users and Groups in Estimate. The Users assigned role as determined by the
currently logged in user is used to grant permissions at the application level. Because
Estimate on-premise uses the computer’s logged in user in determining the user’s role,
roles cannot be segregated by job. To enforce job-level security in Estimate on-premise,
populate the list of users allowed in the job on the Security tab of the Job Properties
form.
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3.10.3 .1 ORGANIZATIONAL BREAKDOWN STRUCTURE

Projects in Platform are required to have an Organizational Breakdown Structure (OBS) assignment.
The OBS assignments can be utilized for assigning roles and granting permissions to all jobs belonging
to a node in the OBS.

In the following example, Johny has been assigned as the Lead Estimator for the Site Work node of the
OBS, which grants him the permissions assigned to the Lead Estimator role for every estimate created
that belongs to the Site Work node in the OBS.

Permissions are cumulative, so if a user is assigned multiple roles on a single project, the
role with the most permissions is applied when attempting to access various functions.

3 .10 .4 GRANTING PERMISSIONS TO DESTINATIONS
AND COMMANDS

Estimate can grant permissions at a deep-rooted level by assigning which roles can access specific
forms. You can also assign certain roles that can perform specific commands or actions that can be
performed within those forms.
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Permissions are managed in the Access Control Register in the Setup tab of the Library.

This register is a list of accessible objects, which can be used to grant or restrict permissions to various
roles. By default, the register is organized by type, then by category. Removing the grouping lets you
search for key words using the search capabilities of the register.
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The Type of the accessible object is one of the following:

• Command: Actions that are in the main ribbon navigation.

• Destination: A form or location within the application. Restricting this type of permission means that
all the actions that are available in the form are unavailable.

• Register Command: These are the commands that appear for the specified register and are
commonly accessed either by using the actions menu in the navigation ribbon when the register is
active or using the right-click context menu commands on the records in a register.

Categories and subcategories can be used to further group and identify various accessible objects.

The Ribbon Name column provides the navigation path and name of the object as it appears in the
ribbon navigation. The Show Classic Navigation Accessible Objects button on the Actions tab of the
Access Control register can be used to identify accessible objects as they might have existed in the
legacy version of Estimate, and are still available to assist users who may have set up Access Control
prior to the newer ribbon navigation.

Follow these steps to set up Access Control on an Accessible object:
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1. Identify the role or roles in the User Roles register, then right-click to copy.

l In the Access Control register, you can filter on the Role Assigned field to help you see the
associated roles with Access Controllable objects.

2. Select one or more accessible objects in the Access Control register and right-click to paste.

3. Expand the detail records of the accessible objects to verify the role assignments have been
correctly made.
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You can drag and drop the Roles onto the accessible objects in these two registers.

If no roles are assigned to an accessible object, no restrictions are applied to the accessible object, and
anyone with access to the application will be able to access that destination or command. When
setting up Access Control, be sure to identify the commands and destinations in Estimate that you
want to restrict permissions to, and then assign the roles to explicitly grant permissions to those
accessible objects.

In the following example, both Estimators and Lead Estimators are permitted to invoke any of the
actions on the records in the PBS Changes Register, but only the Lead Estimator is permitted to
activate or deactivate the PBS Changes Log. Because no roles have been assigned to the Activate ‘View
Change Record’ prompt, anyone with access to the application will be able to perform that action.
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3.10.4 .2 ACCESS CONTROL REPORT

You can use the Access Control report to audit user permissions, command access, and various
restrictions without having to search through the Access Control register for this information.

The report makes it easier to find the role names along with their associated Yes and No access
permissions to each form in Estimate.
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STEP BY STEP — ACCESS CONTROL REPORT

1. Open a job, and then select the Setup tab.

2. Click the Reports icon.

You can access the Reports menu from the Setup, Estimate, Quote, Price, and
Execution tabs.

3. Expand Library Module, and then select Access Control (Excel).

4. Select a file name, or choose another file name path.

InEight Inc.  |  Release 25.1 Page 181 of 411

Estimate Essentials User Guide 3.10 Security in Estimate



5. Click Save, and then click Run.

What's Next: Open the Access Control Excel file to filter, sort, or perform any type of audit to help you
determine user or role access.
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3 .10 .5 GRANTING PERMISSIONS TO THE ESTIMATE
L IBRARY

In Platform, permissions relating to the Estimate library are found in the Master data libraries
permission section.

To grant Estimate library permissions to a role, the role must be an Administrator Level 3 - Account
Admin. If not, the permissions are not selectable on the Add/Edit Role setup page.
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The Master data libraries permission section is also where the permissions controlling which roles can
manage templates are found.

3 .10 .6 COMMON ROLES USED WHEN SECURING AN
ESTIMATE

The process of creating an estimate for a bidding opportunity commonly requires unrestricted access
to the capabilities of Estimate so that estimators can work efficiently. However, depending on the level
of data governance within an organization, you might want to preclude certain users from accessing
some of the more sensitive parts of Estimate. If changes were made, either accidentally or otherwise, it
could impose detrimental impacts on the organization.

Estimate’s security model is very detailed and robust. When designing a security model that restricts
certain features and functionality of Estimate, each company must weigh the benefit of the protection
of such restrictions which could bring unwanted or uncontrolled changes and negatively impact the
productivity of the estimating process. While it is possible to create a very detailed and robust security
model with many different roles for individuals within an organization, it is not necessary to set up and
maintain roles for all of Estimates accessible objects. It is likely a company can effectively secure their
sensitive data with no more than a couple roles granting permissions to a few commands and
destinations.

A common way to implement security on the Estimate application is to restrict access to certain
system level settings, such as who can modify data in the library, or who can change any company
specified custom column captions.
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The following are some of the more common Roles a company may set up, describing the purpose of
the role and typical permissions:

l Lead Estimator: Lead Estimators are commonly assigned to estimates based on their knowledge
and experience. They may be precluded from creating or deleting estimates themselves or
changing any system level settings, but commonly have full access to all the capabilities needed
to create and maintain the estimates they are assigned to.

l Estimate Manager: Estimate Managers are commonly responsible for identifying bidding
opportunities and determining which opportunities to pursue. Once it has been determined that
the company will pursue an opportunity, the Estimate Manager creates the estimate and assign
it to a Lead Estimator based on resource availability relative to all the bidding opportunities the
company will be pursuing. These roles manage the creation of estimates and assist in ensuring all
the necessary supporting data is available, such as assigning appropriate project attributes or
including needed resource libraries.

l Administrator: Administrators ensure accessibility and availability of the solutions utilized by
estimators. Typically, they control system level settings and activities that would affect company
standards, such as changing column captions, ability to define corporate views, list of job
statuses and ribbon settings. Other typical permissions restricted to only the Administrator level
roles are the ability to access the User Roles register and the Access Control register.
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LESSON 3 REVIEW

1. When you create a new job folder, all category labels defined in the Library Foundation Setup
Data Register will be copied to the new job folder automatically.

a. True

b. False

2. This resource type is a catch-all and can be used for anything from dump fees and security to
creating subcontractors as a resource.

a. Installed Materials

b. Unique

c. Labor

d. Construction Equipment

3. The Construction Equipment and Rented Construction Equipment Resource Rate Records include
consumption rates that will factor with the fuel cost you define where?

a. Library Foundation Setup Data

b. Library Resource Rates

c. Job Properties

d. Cost Breakdown Structure

LESSON 3 SUMMARY

As a result of this lesson, you can define, adjust and explain:

l Library Job Properties

l Library Foundation Setup Data Register

l Library Resource Rate Register

l Library Assembly Register
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LESSON 4 — PROJECT SETUP

LESSON DURATION: 45 MINUTES

LESSON OBJECTIVES

After completing this lesson, you will be able to:

l Create a new project

l Enter Job Properties

l Create pay items in the Pay Item & Proposal Register

LESSON TOPICS



4 . 1 JOB CREAT ION

4.1.0 .1 PLATFORM PROJECT ASSOCIATION

You can associate your estimates with additional master data, such as project data from the Project
details page in Platform. Associating Platform projects lets you organize estimates directly from
Platform’s Organizational Breakdown Structure (OBS). Your location assignment in the OBS determines
the access you inherit and the visibility you have to other areas of the OBS.

Extracting Platform project master data directly into Estimate promotes data consistency and helps
ensure that the data is being pulled from a single source of truth.

Platform project specific master data can be maintained in one place, then it can flow directly into
Estimate in the Cloud. Certain project data such as location and forecast start and finish dates are now
maintained in Platform which helps to enforce data consistency and reduce duplicate entries.

The fields that are located in Setup > Job Properties > Overview that are maintained in Platform and
integrate into Estimate consist of: Project ID, Organization, and Notes. The fields on the Estimate Cover
Sheet tab include Location, State, City, Country, and Latitude and Longitude, Forecast Start and Finish,
and Duration.

Page 188 of 411 InEight Inc.  |  Release 25.1

4.1 Job Creation Estimate Essentials User Guide



The Project ID field in Estimate is a hyperlink field that takes you directly to the project Details page in
Platform.

When modifications are made to any of the integrated fields in Platform, then saved, the changes
automatically show in Estimate. For example, if you need to change the name of the project in
Platform to show the year 2023 instead of 2020, this change is reflected in the in the Job Properties >
Project Name field form in Estimate.
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4.1.0 .2 JOB REGISTER MANAGEMENT

An advantage to associating Estimate with Platform project data is the capacity to manage multiple
versions of Estimates from one source project.

For example, if you have multiple addendums issued for the same project, you can maintain a version
of the estimate for each addendum you’ve received.

Grouping estimates together using a common project means there is no need to structure and enforce
a job coding schema in Estimate on the Job Code, or use tag fields or user defined fields to identify and
manage different versions of a project in the Job register.
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JOB REGISTER GROUPED BY PLATFORM PROJECT

Grouping by organization lets you see projects batched in an organizational breakdown level, and lets
you see a listing of projects in an organizational breakdown format and projects derived in Platform.

OBS FILTER TREE

You can use the organization tree filter to see where estimates exist in the OBS.
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When the Organization Tree Filter is enabled, you can see the jobs that are associated with an
organization tree node in the new OBS filter tree. This helps you locate and organize estimates to more
quickly inside of an organization hierarchy.

If you group by Project ID, and then select a node in the organization, you can see all the projects and
their associated estimates belonging to that part of the organization. For example, there are three
estimates associated with project 4985362 and one estimate associated with projects 4992404,
5013592 and 5013787. This view shows you the relationship between all the project and estimate
associations.
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DATA VERSION AND UPGRADE REQUIRED COLUMNS

There are two columns in the Job Register that help you identify a job’s current data version and
whether an upgrade is required for the job:

l Data Version - Identifies the current data version of the job which might be different from the
Estimate application version.

l Upgrade Required - identifies jobs that require an upgrade to match the current database
version before they can be used in the application. The jobs that require an upgrade have the
check box selected.
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STEP BY STEP — CREATE A NEW JOB

1. From the InEight Estimate Backstage view, under the Create a new Job from… section, select
Scratch, or select New > Scratch from the left sidebar menu.

2. On the New Job dialog, select a Core Project from the drop-down.

3. Modify the Code field.

4. Type in a description of the job in the Description field.

5. Determine if you want to check the "Auto-Update Job in Connected Analytics" box.

6. Click OK to create the new project.

4 . 2 PROJECT CREAT ION

You can create new projects in InEight Platform’s root and sub-organizations to which you can then
associate Estimates jobs. For example, you can create new projects in a node of the organization
dedicated to estimating, permitting estimators to create and manage projects for the opportunities
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they are pursuing while allowing the rest of the organization to maintain a higher level of security over
active projects.

For more information about project creation, see Project Initiation in Platform.

4 .2 .1 CONSIDERATIONS

You must have a Level 3-Account Admin role or the Add projects permission in your role.

4 . 3 JOB PROPERT IES

When you create a new project, the Job Properties form automatically shows. This is where you can
enter basic information about the project. You can access Job Properties on the InEight Estimate
landing page > Setup > Job Properties.

4 .3 .1 OVERVIEW TAB

The Job Properties form opens to the Overview tab. The image and table below show the Overview
options:
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Name Description

1 Code The name of the Estimate job. The
name cannot be changed.

2 Status Current state of the job, such as
Bidding, Awarded, or Completed.

l When searching for jobs in
the Job Folders list, you can
filter and sort jobs by their

Overview Tab
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Name Description

status.
l You can set statuses for jobs
to fit your company
requirements in the Jobs
Register > Actions > Tools >
Job Status.

3 Project ID Information in this field originates
from the Platform project the
estimate is associated with and
cannot be changed. You can click
the Project ID link to navigate to
the project in Platform.

4 Organization Information in this field originates
from Platform.

5 Description You can enter a job description.
You can edit the description any
time.

6 Project name Information in this field originates
from the Platform project the
estimate is associated with and
cannot be changed.

7 Notes Add estimate related information,
such as when creating multiple
versions of an estimate for the
same Platform project. For
example, you can enter This
version is per addendum #1 or This
version is per a specified design
change, or This version of the
estimate is incorporating last
minute changes.

Overview Tab (continued)
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Name Description

8 Project Notes Information in this field originates
from the Platform project the
estimate is associated with. The
notes can be added and edited at
any time in Platform to document
specific project-level details.

9 Job created by Indicates the user or entity that
initially created the job.

10 Source job The name of the original job that
the job was copied from.

Overview Tab (continued)

When you copy a job, the new job shows the name of the person who created the copied
job, and the name of the source job the job was copied from.

4 .3 .2 COVER SHEET TAB

The Cover Sheet tab is where you can define much of the general information about the project. It
includes fields to identify the job’s location, contacts, and bid details.

The following fields are available:

l Job Location

l City, County, Country, Province/State

l Job Type

l Engineer

l Owner

l Architect

l Forecast Start and Forecast Finish

l Bid Date and Bid Time

l Bid Location

l Estimator

l Opening Type and Proposal Type
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l Liquidated Damages (if applicable)

The fields on this tab can be helpful for historical reference and job classification. It is good practice to
complete as many of these fields as possible, so you can reference and find the project later. These
fields can be updated as needed at any time.

4 .3 .3 COST BASIS TAB

The Cost Basis tab has some important settings that will affect how costs are calculated in your
estimate. The settings reviewed below are the ones you need to consider.

Name Description

1 Standard Shift
Arrangements

The default standard shift arrangements are set up as 8 hours per shift,
1 shift per day, and 5 days per week; this can be changed if a project
requires a different standard shift arrangement.

2 Standard
Wage Rate
Composite:

Allows you to indicate what percentage of your labor hours will be
regular time (Scale 1), overtime (Scale 2) or double time (Scale 3). You
can enter these percentages manually, or you can use the Shift Rate
Calculator to obtain a more accurate figure.

3 Lock Cost
Items to Pay
Items:

For this sample job, you will check this box. When Cost Items are
locked to Pay Items, your level 1 estimate structure is controlled by your
list of pay items.

4 Default
Currency:

The default will be set to U.S. Dollar, but this can be changed if
needed.
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Name Description

5 Sales Tax
Rate:

This field is not required but may be used to automatically apply a sales
tax to all your material and rental items. The default is set to zero.

Cost Basis Tab Overview

4 .3 .4 SHIFT RATE CALCULATOR

Take a closer look at calculating your shift rates using the Shift Rate Calculator. For this example, you
will walk through setting up 2 shifts for your project.
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STEP BY STEP — SHIFT RATE CALCULATOR

1. On the Job Properties > Cost Basis tab, select the Shift Rate Calculator button.

2. For Shift 1, type a number value of hours in theMonday through Friday Work Hours fields.

l You can enter up to three shifts for the project

3. For Shift 1, type a number value of hours in the Scale 1 fields.
l Scale 1 will be your regular time and Scale 2 will be any overtime

4. Enter a number value for hours in the Scale 2 fields (just Monday through Friday).

5. For Shift 2, type a number value for hours as you did above in Step 3.

6. Click OK.

InEight Inc.  |  Release 25.1 Page 201 of 411

Estimate Essentials User Guide 4.3 Job Properties



l Now you have a blended shift arrangement, and your labor rates are a blend of
64.18% straight-time and 35.82% overtime

4 .3 .5 IMPORT FILTERED RESOURCES

You may have noticed the bottom portion of your Cost Basis tab called the Resource Filter.

The Resource Filter portion of the Cost Basis tab is the most important part of Job Properties. You use
it to import your labor, equipment, and materials from the Library. Until you import filtered resources,
you have no resources (labor, equipment, materials) in your project.

Updated resource rates can be imported into the Library on a regular basis. It is important to update
and have the “Latest & Greatest” rates available to import into your estimates.
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You will import the rates you need using a set of four filters called Resource Attributes. Especially for
labor rates, filtering by these attributes allows you to pare down the master list to just the resources
you need.

Each of the resource filter categories are open for use as determined best by your business. The
following are examples of common uses:

Resource Attribute Filters

Name Description

Resource File
Description

This attribute can be used to designate the rate type or the year to which the
rates pertain.

Geographic
Area

This attribute is used to designate regions, cities, or provinces based on
geographical location of a project.

Wage Zone This attribute is typically used specifically for labor resources. For example,
it may designate the trade and union agreements your labor resources
belong to.

Organizational
Category

This attribute can be used to designate what trade or work type your
resources pertain to.

Resource filters become more specific from left to right, so it makes sense to start with Resource File
Description and end with Organizational Category. The geographic area, wage zone and organizational
category attribute titles can be changed to meet your business needs for filtering resources.

You can sort the filter lists by clicking on the filter category titles.

The following steps walk through using the Resource Filter to import resources.

STEP BY STEP — IMPORT FILTERED RESOURCES

1. In your Job, go to the Job Properties > Cost Basis tab, select the Labor Rate resource type.

2. Under Resource File Description, select Standard Labor Rate File.

3. In the Geographic Area, select an Area.

4. For Wage Zone (Work Center), select aWage Zone.

5. For Organizational Category, select All.
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6. Follow the same steps for the remaining resource types.

7. Select the Import Filtered Resources button to bring your selected resources into the job.

l For this example, we'll select the following filters for the Labor resource type:

You must select “Import Filtered Resources” to import your resources. Clicking OK on the
Job Properties form will not import your resources.

4 .3 .6 FUEL COST TAB

On this tab you can enter the cost for fuel (or other energy sources). These unit cost will be multiplied
by the consumption rates entered on each equipment record to define the fuel operating cost of each
piece of equipment. The Cost per UM fields default to $0.00.

STEP BY STEP — ENTER FUEL COSTS

1. In your job, open the Job Properties > Fuel Cost tab.

2. In Cost Per UM column, enter a dollar amount into the following:

l Diesel

l Gas & Gasoline
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l Off Road Diesel

3. Currency should read U.S. Dollar and UM should read Gallon.

4 .3 .7 JOB FOLDER TAGS TAB

On this tab, you can enter tag fields to label your project, so you can reference it later.

Many of these fields are validated fields, meaning you can choose from options in a drop-down list.
The names of these tags and the drop-down values are defined at a master level within the Library
Foundation Setup Data. Some job folder tags are setup to be date fields or numerical fields. These tags
are used to sort and filter the job register as well as for selecting which past estimates to utilize for
benchmarking.
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4 .3 .8 SCHEDULE TAB

The Schedule tab is used to define the scheduling options for the integration of Estimate with InEight
Schedule, Microsoft Project, or Primavera. The settings you define determine what information is sent
to your scheduling application or tool, and how it’s structured.

l Integrated Schedule – Select your integrated schedule from InEight Schedule, Microsoft Project,
Primavera, or Manual.

l Schedule Currency – When you use Microsoft Project or Primavera, you can select the currency
type used for the integration. The InEight Schedule and Manual option is set to U.S. Dollar by
default.

l Plug Days - You can select Always use Plug Days when updating Estimate from schedule.

l Cost Item Roll Up – You can select to automatically calculate plug days when rolling up cost
items for scheduling purposes.

4 .3 .9 OTHER JOB PROPERTIES TABS

There are several additional tabs on the Job Properties form. The other tabs will not be discussed here
because they are either used for project controls, or they will be covered at another time.
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Other Job Properties Tabs

Name Function

Minority Setup Used to set up minority participation goals (for example, DBE or MBE) and
you want to track minority participation goal attainment status during the bid
process,

Job Tracking Used to select the code that will be used when tracking job progress, define
the planned production calculation, define the percent complete calculation,
define the forecast methods, and define markup rates for calculating earned
revenue on Time and Expense pay items.

Pricing Used to define how you want the Balanced Unit Price for each of the job's
pay items to be calculated when using the AutoPrice feature. You can also
choose form several options in determining how markup is defined.

Cash Flow Defines the cash flow rules (payment terms) that are used in the calculation
of Job Financing and cost/revenue realization to generate the curves that
display on the Cash Flow form.

Equipment
Maintenance

Used to define the calculation of maintenance labor man-hours based on
equipment utilization, to capture the impact on total man-hours when
changes are made that affect the job's total value.

Benchmarking Used to establish the historical data to be used for benchmarking the current
job, and to define the default benchmark graph display and calculations.

Alternates Used to define Alternate Scenarios, to assess the impact of those scenarios.
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EXERCISE 4.1 — DEFINE JOB PROPERTIES

In this exercise, you will continue to define your Job Properties from the job you have created in two
parts. Complete the following steps:
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1. On the Cover Sheet tab, fill out the following fields:

Job Location 90th Street & Shea

City Scottsdale

County Maricopa

Country United States

State Arizona

Type Infrastructure

Engineer Fred Jones

Owner Jerry Slate

Architect Robert Frost

Contract Duration 80

Time Measure Calendar Days

Forecast Start October 15, 2019

Duration (days) 70

Bid Date and Bid Time 10/1/2019 2:00 PM

Estimator Jim Sly

Bid Location 123 Main Street

Owner’s Estimate $500,000.00

Opening Type Public

Proposal Type Unit Price

Plan Holders 10

Liquidated Damages $1000.00 Per Day

RFQ Contact Jim Sly

In this part 2 of this exercise, you will continue to define your Job Properties from the Job you have
created. Complete the following steps:
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2. On the Cost Basis tab:

l Ensure the Shift Arrangement is 8 hours a day, 5 days a week

l Ensure theWage Composite is set to 100% Scale 1

l Ensure the Sales Tax is set to 8%

You should end up with similar results

The following Cover Sheet properties are defined:

The following Cost Basis settings are defined:
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Congratulations, you have completed this exercise!
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4 . 4 PAY ITEM CREAT ION

Pay items typically represent the owner required deliverables a contractor must submit pricing for.
Within InEight Estimate, pay items are used to distribute the cost calculated in the Cost Breakdown
Structure and all markup, fees or contingency calculated in the Price Breakdown Structure to a list of
defined items. This allows the total estimate value to be distributed to a structure that is different then
the CBS. Pay Items are predominantly used by Contractors to prepare a bid sheet. Owners may use pay
items to identify funding sources or for various reporting needs.

Many Bid Forms are organized by grouping bid items for related scopes of work. Pay items within the
Pay Item and Proposal screen can be grouped in a hierarchy by utilizing the Position Code column.

You can create pay items in the Pay Item & Proposal Register. Access this form by selecting the Setup
tab > Pay Item & Proposal.

Name Description

1 Proposal and Item
Recaps

Related to pricing during bid close-out. You can disregard them at
this time.

2 Pay Item Number Represents the bid item number from the client (if they give you
one) or can be a number you specify. This field is alpha-numeric

3 Position Code Controls the way pay items can be grouped, and provide you with
an efficient way to sort.

4 Description You can enter a pay item description.

5 Pay Quantity and
Forecast (T/O)
Quantity

The Pay Quantity is the quantity provided by the client.
The Forecast (T/O) Quantity is your measured quantity for the
item.
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4 .4 .1 OVERVIEW – PAY ITEM & PROPOSAL REGISTER

STEP BY STEP — CREATE A PAY ITEM

1. Open your job and select Setup tab >Pay Item & Proposal from the InEight Estimate landing
page.

l The Pay Item & Proposal Register displays

2. In the Pay Item Number column, in the first blank row, type a number value.

3. Use the Tab key to move to the Description column and type a description.

4. Leave the Pay Quantity at 1.00 and change the Unit of Measure to LS (Lump Sum).

l The Forecast (T/O) Quantity will auto populate to match your pay quantity, but can be
changed later

l You can tab to the next row to create additional pay items if needed
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4 .4 .2 PAY ITEM PRICES BY CATEGORY

Owners are increasingly requiring more information from contractors as part of their bid submissions.
Many times, this is a further breakdown of a bid price such as separating the price of an item based on
its labor cost, material cost or man-hours. Select columns in the Pay Item & Proposal register enable
users to summarize their pay item prices by up to 10 price categories.

In addition to seeing the price by category, these additional columns also give users better visibility
into how the price is established, including columns for the total cost, total distribution, total markup
and markup percent. These new columns make it easier to verify that the distribution of unassigned
cost and markup are calculated as intended by the estimator.

4 .4 .3 STANDARD PROPOSAL REPORT

The Pay Item Standard Proposal report is located in Execution > Reports > Pay Item & Proposal >
Standard Proposal, and is intended to be used as a bid form, and distributed to other clients, partners,
and contractors. In the Details box below, you can determine which key fields you want included and
shown on your standard proposal report.
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EXERCISE 4.2 — CREATE PAY ITEMS

In this exercise, you will practice creating pay items in the Pay Item & Proposal Register. Complete the
following steps, using a job of your own.

Position
Code

Pay Item
Number Description

Pay
Quantity

Unit of
Measure

1 200 SITEWORK
& ROADWAY

1.1 641 0100 Mobilization 1 LS

1.2 201 0102 Clearing & Grubbing 10 Acre

1.3 202 0183 Excavation 50,000 CY

2 400 WATER & SEWER

2.1 800 0220 10 PVC Pipe 1,000 LF

You should end up with the following results:

Congratulations, you have completed this exercise!
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LESSON 4 REVIEW

1. This is where you enter basic information about the job as well as define your cost basis.

a. Pay Item & Proposal

b. Job Properties

c. Library

d. Job Folder

2. On the Job Properties form, this tab is where you enter information such as the start
date, bid date, job type and location.

a. Overview

b. Cover Sheet

c. Cost Basis

d. Foundation Setup Data

3. These are the project deliverables; anything the owner agrees to measure and pay for.

a. Cost Items

b. Resources

c. Target Price

d. Pay Items

LESSON 4 SUMMARY

As a result of this lesson, you can:

l Create a new job

l Enter Job Properties

l Create pay items in the Pay Item & Proposal Register
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LESSON 5 — D IRECT COSTS

LESSON DURATION: 30 MINUTES

LESSON OBJECTIVES

After completing this lesson, you will be able to:

l Explain the Cost Breakdown Structure and its purpose

l Create cost items

l Add costs and production

l Manage cost item details

LESSON TOPICS



5 . 1 COST BREAKDOWN STRUCTURES

The Cost Breakdown Structure (CBS) is the main form where you will do your cost estimating.

l It is the hierarchy of work activities that make up the estimate

l Each row in the CBS represents a work activity or organizing category and is called a cost item

To access the Cost Breakdown Structure, from the InEight Estimate landing page select the Estimate
tab, then under the Breakdown Structure section select Cost Breakdown Structure (CBS).

Name Description

1 Actions
Menu

Shortcut icons allow you to edit cost items and import items from other
sources such as Excel.

2A CBS Tree
Filter Mode
(drop-
down)

The CBS Tree filter shows the CBS hierarchy and is used to quickly help
filter cost items, instead of scrolling the CBS to locate certain cost items.
The CBS Tree Filter lets you choose between a filter mode or a new
navigation mode.

2B CBS Tree
Filter or
Navigation
Mode

Both Filter and Navigation modes on the left side of the page provides you
with the visibility of your entire CBS structure, as well as giving you the
option to navigate and filter throughout the CBS estimate. The Cost Item
record can also be tiled next to the tree to make navigating and filtering
possible, while viewing all the cost item record details at the same time.

3 Left CBS
register

This side of the register contains all of the estimate activities (cost items)
that you create or import, organized into a parent-child hierarchy.

4 Right CBS
register

This side of the register contains numerous columns for cost detail,
production values, and user-defined tags and fields.

Overview – Cost Breakdown Structure (CBS) Register
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5 .1 .1 COST ITEM TERMINOLOGY

The CBS contains both direct and indirect costs.

l Direct Cost Items contain costs that pertain directly to the deliverables of the project. Therefore,
direct cost items are typically assigned to pay items

l Indirect Cost Items contain overhead costs that are not directly associated with particular
deliverable items but contribute to the total cost of the project (e.g., supervision, site office,
safety supplies, bid securities). Occasionally an indirect cost item may be assigned to a pay item
(e.g., Mobilization costs that are indirect but assigned to a Mobilization pay item).

InEight Estimate uses various terms to describe the parent-child relationships of the multiple levels in
the CBS:

Terms Description

Superior A Superior cost item has subordinate (child) items below it that determine
hours and costs.

Subordinate A Subordinate cost item is a child to a Superior cost item.

Terminal A Terminal cost item has no subordinate items. Resources, costs, and
production can only be added at the terminal cost item level.
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A Terminal cost item may or may not be a subordinate.

The levels of the CBS are referred to as Level 1, Level 2, etc., as you drill down in the structure. As costs
are defined on the terminal items, the sum of the terminal cost items roll up to the superior cost items.

A superior cost item can have no costs of its own; its costs are strictly the rolled-up total
from the subordinate cost items below it.

You can use superior cost items as buckets for organizing your work.

As hours and costs are defined on the terminal items, the sum of the terminal cost items roll up to the
superior cost items.

5 .1 .2 WORK BREAKDOWN STRUCTURES

The Work Breakdown Structure (WBS) allows you to reorganize the estimate using different formats
such as Construction Specifications Institute (CSI) MasterFormat or UniFormat. WBS formats are used
when you need multiple variations and summary reports of an estimate. The WBS retains the same
relationships between items as in the original estimate while only changing the view and items
arrangement in the WBS hierarchy.

To view the Work Breakdown Structure View Register, in the Ribbon select the tab Estimate > Work
Breakdown Structures.

Name Description

1 WBS
Tree

Use the WBS Tree to filter to a particular WBS item.

2 WBS
Grid

When a specific WBS item is selected in the WBS
Tree, all subordinate WBS items display in the WBS
grid.

3 Cost
Items

The Cost Items associated with the WBS
subordinate in the WBS Grid displays in this data
block.

Overview – Work Breakdown Structure (WBS) View
Register
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5 .1 .3 LOCKED VS. UNLOCKED APPROACH

There are two basic approaches to structuring your cost items and pay items. You can choose to work
in a “locked approach” or an “unlocked approach.”

In a locked approach, level one cost items are automatically created and assigned to pay items. This
locked approach works well when pay items adequately represent the work plan. Subordinate cost
items inherit the pay item assignment of superior cost items.
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If the Lock Cost Items to Pay Item rule is checked in Job Properties, InEight Estimate will
automatically create level 1 cost items in the CBS Register for each of your pay items.

The unlocked approach may work better when the pay items do not adequately represent the work
plan. You can then assign your cost items to your pay items in any arrangement. Companies looking to
standardize the way they estimate and use templates will want to use this approach as it allows you to
dictate the cost breakdown structure. Owners will also typically use the unlocked approach since pay
items are not necessary to their estimating process.

The option of working in a locked approach vs. an unlocked approach is available in the Job Properties
Form, on the Cost Basis tab under the Rules section. By selecting the checkbox for Lock Cost items to
Pay Item, you are choosing to work in a locked approach.
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5 .1 .4 TAKE-OFF QUANTIT IES

In the Cost Breakdown Structure, estimated quantities are entered into the Forecast (T/O) Quantity
field with a corresponding unit of measure. The quantity will default to 1 each when you create a new
cost item and should be updated to reflect the work being estimated.

Forecast (T/O) Quantities are only used for your cost items in the CBS Register.
Pay Quantities are used for final pricing in the PBS and Pay Item & Proposal forms.

Because the training project is a “locked” job, you already have level 1 cost items, and their default
take-off quantities are populated from their corresponding pay item quantities.

The following step by step walks you through adjusting the default take-off quantities on a couple of
your cost items.

STEP BY STEP — ADJUST TAKE-OFF QUANTITIES

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. In the Forecast (T/O) Quantity column, the Forecast (T/O) Quantity is brought over from the Pay
Item & Proposal Register, but here you can adjust it if needed. Practice adjusting the Forecast
T/O quantity of one of your cost items.

l For this example, we’ll change Clearing and Grubbing to 15.00 Acre and Excavation to
40,000 CY.
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5 . 2 COST ITEM CREAT ION

During estimate development, you will create new cost items to break down your work into specific
activities. You can create superior and subordinate cost items as needed to organize your work.

5 .2 .1 INSERT SUBORDINATE COST ITEM

You can add subordinate cost items in two different ways:

OPTION 1

Right-click on the row header of the superior cost item and select Insert Subordinate.
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The row header is considered the far left edge of the CBS row where the small arrow appear appears
above. It is used to open records and perform actions on items instead of clicking on cells within the
row which will allow you to directly type into the selected cell.

OPTION 2

Click on the Subordinate Cost Item icon on the Cost Breakdown Structure (CBS) Register toolbar.

5 .2 .2 INSERT COST ITEM

You can add cost items at the same level in two different ways.

OPTION 1

Right click on the row header of the superior cost item and select Insert.
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OPTION 2

Click on the Cost Item icon on the Cost Breakdown Structure (CBS) Register toolbar.
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Because the project you are working in is a “locked” job (where cost items are locked to pay items),
your CBS Register will already have level 1 cost items representing each of your pay items, and each
cost item will be assigned to its corresponding pay item.

The following step by step walks you through creating a subordinate (child) cost item for one of your
level-one cost items.

STEP BY STEP — CREATE A SUBORDINATE COST ITEM

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. Right-click on a cost item and select Insert Subordinate.

l This creates a new subordinate cost item below your selected cost item

3. For the subordinate cost item, enter a description.

4. Add a quantity and select your Unit of Measure.

l For this example, we’ll insert a subordinate under Clearing & Grubbing for Clearing

You can create a subordinate at the same level, by right clicking on an equal-
level cost item and selecting Insert.

5 .2 .3 MOVE COST ITEMS

As you develop your estimate, you may need to move cost items around in the Cost Breakdown
Structure. To move a cost item:

1. Select the row header of the cost item you wish to move. If you select a superior cost item, it will
bring the subordinates along with it.

2. Drag and drop the cost item to the right place in your structure. Notice one of two cursor
symbols appears:
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The symbol with three equal bars will drop the cost item at the same
level as the cost item you drop it on.

The symbol with a subordinate bar will make the cost item become a
subordinate to the one you drop it on.

Page 230 of 411 InEight Inc.  |  Release 25.1

5.2 Cost Item Creation Estimate Essentials User Guide



EXERCISE 5.1 — CREATE COST ITEMS

In this exercise, you will practice creating additional cost items. Create the following cost items,
using your own job.

Code Description Forecast (T/O) Quantity Unit of Measure

1.2.2 Grading 10 Acre

1.3.1 Excavate 40,000 CY

1.3.2 Haul 40,000 CY

4.1 Furnish Pipe Materials 1,000 LF

4.2 Excavate-Install-Backfill Pipe 1,000 LF

You should end up with similar results:

Congratulations, you have completed this Exercise!
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5 . 3 COSTS AND PRODUCT ION

For the cost items you’ve created, you can now add their costs and production. All information for a
cost item is contained in a Cost Item Record.

5 .3 .1 COST ITEM RECORD

You can open the Cost Item Record by either double clicking on a cost item row header, or right
clicking and selecting Open.

Cost Item Record Overview

Name Description

1 Cost Item
Header
Information

Provides general information about the cost item. It displays the cost
item’s take-off quantity, Unit of Measure, and Cost. It also indicates what
Cost Source is being used.

The Cost Segment drop-down is used to differentiate estimated costs in
the Direct Costs, Job Overhead or Business overhead categories.

2 Costing
Area

Section where costs are defined. There are three ways to enter costs:
Detail, Plug, and Quote. The Cost Summary tab summarizes whatever
costs are defined.
Under the Cost Segment drop down, you can choose

3 Data Blocks Contains a set of tabs for entering additional information including
production, shift arrangements, man-hour factors, notes, and scheduling
information.
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5 .3 .2 COST SEGMENTS

The Direct Costs, Job Overhead, and Business Overhead cost segments helps to classify the scope of
work so you can report on direct vs indirect costs, and accurately control how markup is spread
throughout your bid. This differentiation is necessary to effectively price work based on the risk profile
of each segment of cost.
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5 .3 .3 COST SOURCES

You can define costs on a cost item in one of three ways, called Cost Sources:

Tab Description

Detail This is the recommended costing method, where labor, equipment, and material
resources are defined, along with productivity, to determine costs.

Plug This method allows you to enter a unit or total cost directly, without needing to enter
resources or production. This should rarely be used, but does have a couple of use
cases:

l Place holder value until you get more information (from subcontractors or
designers)

l For preliminary estimates when limited information is available

Quote The Quote cost source is for contractors, subcontractors or vendor quotes.
l Creating and managing quotes is covered in Lesson - Quote Management

On each Cost Item Record, InEight Estimate gives you the option to define both Plug and Detail values
on each respective tab.
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5.3.3 .1 PLUG TAB

The Plug tab allows user to input unit or total cost to any of the listed cost categories which can be
customized based on company requirements.

5.3.3 .2 DETAIL TAB

Entering both a detailed and plug cost allows you to define costs at a higher summary level initially
(Plug tab), and then define more detail as the estimating process progresses (Detail tab). You can
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review and compare your plug and detail values by toggling between tabs, but your cost item will only
contribute the total cost from one of the tabs based on which cost source is selected.

You control which cost is used by selecting Detail or Plug in the Cost Source field on the Cost Item
Record.

The Quote Cost Source can only be selected from the Quote Comparison & Award form.
See Lesson 8 – Quote Comparison.

5 .3 .4 PLUG COSTS

The following steps walk you through defining a plug cost on a cost item.

STEP BY STEP — DEFINE A PLUGGED COST

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. Right-click on the row header for a cost item and select Open.

3. In the Cost Source drop-down field select Plug.
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4. In the left section of the cost item, select the Plug tab.

5. Click in the Unit cost or Total cost field for a cost category and type in a Numeric Value.

l For this example, on the Mobilization cost item, we’ll add $10,000 in the Total Cost field
for both Labor and Owner Equipment.

5 .3 .5 DETAIL COSTS

The Detail cost method is also defined on the Cost Item Record. On the Detail tab, you can add
resources (labor, equipment, and material) and define production.

On the Production tab (right side of screen), define production by entering one of the following:

l A duration, or

l A unit per duration, or

l A duration per unit

When you enter a production value, all the other production fields will auto-fill based on what you
entered.
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The hours defined on the Production tab drive the labor and equipment resources you employ on the
left, multiplying their unit costs by the production hours.

When you employ material resources, their costs are driven by the quantity you enter into the quantity
field.

The Total Cost of each resource is added together to give you the Total Cost for the cost item.

STEP BY STEP — DETAIL COSTS

1. On the Detail tab, add resources (labor, equipment, and material).

2. On the Production tab, define production (duration, unit per duration, or duration per unit).

3. The hours defined on the Production tab drive the labor and equipment resources on the left,
multiplying their unit costs by the production hours.

l With material resources, their costs are driven by the quantity entered in the quantity field.

5.3.5 .3 ADD COST DETAIL

The following steps walk you through adding resources and production on a cost item.
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STEP BY STEP — ADD COST DETAIL

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. Right-click on row header for a cost item and select Open.

3. Select the Detail tab.

4. A blank row is available to define your costs. With your cursor in the code field, click the
Resource Selection icon to open the Resource Selection Register.

5. Select a resource tab (e.g., Labor).

6. Select a resource.

7. Select OK.

8. Repeat the steps to add additional resources as needed.

9. Click in each resource’s quantity field to change their quantity as needed.

10. From the lower-right section of the form, select the Production tab.

11. Type a numeric value in the Days field, then press Tab.

12. Click OK to close the record.

l For this example, we’ll add cost detail to the Clearing cost item, adding the following labor
and equipment resources and production value:
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5.3.5 .4 ADD ASSEMBLY

STEP BY STEP — DEFINE COST DETAIL BY ADDING AN ASSEMBLY

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. Right-click on the row header for one of the cost items and select Open.

3. Select the Detail tab.

4. With your cursor in the Resource Assembly field, click the Resource Assembly Selection icon to
open the Resource Assembly Selection Register.

5. Select an assembly, then click OK.

6. Because this crew includes duration-based resources, you need to enter a Production value.
Select the Production tab.

7. Type a numeric value in one of the production fields (e.g., UoM/day), then press Tab.

l For this example, on the Grading cost item, we’ll add a Grading assembly with a
production value of 1 Acre/Day.
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EXERCISE 5.2 — DEFINE COST DETAIL

For cost items you create in InEight Estimate, you need to add resources, assemblies and production
to define their costs. In this exercise, you will practice defining cost details. Complete the following
steps, using your job:

Code Description Quantity

LO1 Operator Class 1 1

LL2 Laborer 2

LL3 Labor Foreman 1

EX225 Excavator 225 1

CY/Hour 400

Add the following or similar resources and production to your 1.3.1 Excavate cost
item.

Code Description Quantity

LO1 Operator Class 1 1

LL2 Laborer 2

LL3 Labor Foreman 1

LT1 Teamster 1

EL950 Loader 950 1

ETDT Dump Truck 1

EX225 Excavator 225 1

CY/Hour 400

Add the following resources and production to the 1.3.2 Haul cost item.
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Code Description Quantity

MPP10 Pipe 10” PVC SDR21 1,000 with 5%Waste % Add-on = 1,050 LF

Add the following resource and quantity to the 2.1.1. Furnish Pipe Materials cost
item.

Code Description Quantity

CPIPE Pipe Crew 1

Add the following assembly to the 2.1.2 Excavate-Install-Backfill Pipe cost item.

Days 3

Add the following production value to cost item.

You should end up with the similar results:

Congratulations, you have completed this exercise!
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5 . 4 COST ITEM DETA ILS

The Cost Item Record contains other tabs (called Data Blocks) in addition to the Production tab, for
storing and calculating information specific to that cost item.

You can add to or adjust the information on these tabs as needed, based on the cost item’s
circumstances. In this section, you will review three of the tabs (in addition to the Production tab) you
will likely use most often: Cost Item Setup, Notes, and Man-Hour Factors.

5 .4 .1 COST ITEM SETUP

On the data block where the Production tab was found, there is also a Cost Item Setup tab where you
can adjust wage scale and shift arrangements for a specific cost item.
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The composite wage scale and work and pay hours are used in the calculation of the cost of employed
labor resources. The data reported on the Default Pay Rules tab is, by default, the composite wage
scale and work and pay hours defined on the Job Properties - Cost Basis tab for the current job.

These settings can be modified from the default on a cost item-by-cost item basis.

The Pay Rules for cost items can also be defined or modified on the Cost Breakdown Structure (CBS)
Register in the Scale 1, Scale 2, Scale 3, Work Hours Rules, and/or Pay Hours Rules columns in the row
of the subject cost item.

5.4.1 .1 COST CURVES

Cost curves are used to determine how the cost of a cost item is distributed over time. The main
benefit of defining the cost curve for a cost item is to create a more accurate estimation of the cash
flow over the life of a project.

The schedule dates entered on a Cost Item are used to define the periods across which a cost item will
incur its costs. A cost item’s start and finish dates can be entered manually by the user or established
using Schedule Integration, and the time periods (day, week, month, quarter, year) are determined in
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the Cash Flow settings in Job Properties. For more information on scheduling, see topics Microsoft
Project and Primavera.

By default, Cost Items have a linear cost curve, which distributes the cost of the cost item equally
across all periods for the Cost Item. There are 5 different types of cost curves that can be selected from
in the Cost Item Record > Cost Item Setup page.

Cost curve type Definition

Back Loaded Costs are low for most of an activity's
timeline, but then increase towards the end.
This curve type starts out with a lower slope
and gradually becomes steeper as the work
progresses. Most resources are assumed to
be consumed later in the activity and may be
more characteristic of subcontracted work
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Cost curve type Definition

where costs are incurred as the work nears
completion.

Bell Shaped Expenses are low at the start of an activity,
increase during construction, and decrease
as the project approaches completion. Bell
shaped cost curves incur the majority of their
costs towards the mid-point of the work and
exponentially increase and decrease from
the beginning to the end of the activity. This
type of curve can be characteristic of larger
portions of work that start with a few
resources, ramp up to a peak, incurring
more costs during the ramp up, then ramp
back down as the work nears completion.

Front Loaded A front-loaded cost curve is when costs are
incurred early in a activity. This can happen
for several reasons such as early
procurement of materials to take advantage
of lower prices or to address long lead times.

Linear Linear cost curves take the total cost of the
activity and spreads it equally amongst the
specified periods.

Cost Item Periods Invoked by using the Period Quantities
feature (described below). Cost Item Periods
are used to customize cost curves based on
the quantities consumed in various periods.
In comparison to the other curves which
spread the items total cost proportionally
based the chosen cost curve, the Cost Item
Periods option can generate a more precise
distribution of costs to specific periods
because the user can simply define how
much quantity of work is getting completed in
each specific period.

(continued)
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You can also choose to create your own custom cost curve by clicking on the add button in the Cost
Curve drop-down menu.

Custom cost curves let you define your own from and to durations along with their associated values,
which need to add up to 100%.
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CASH FLOW

All cost curves, regardless of type, impact the generation of the cash flow graph. The Cash Flow form
provides a graphical representation of the cash flow and resource utilization of your project, so you can
quickly assess financing and resource needs.

You can open the Cash Flow form by selecting the Estimate tab from the Estimate landing page, then
selecting Cash Flow from the Schedule section.

To generate a cash flow curve, the estimate must be populated with schedule dates either directly
from integration with Primavera, Microsoft project, or input manually.
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CASH FLOW OPTIONS

The Cash Flow Options are used to define the cash flow rules (revenue timing, cost timing, cost of
money, and quantities) needed to calculate the finance expense and cash flow for your project.

Cash flow rules (revenue timing, cost timing, cost of money, and quantities) describe how cash flow
occurs between a contractor and a client, and between contractors or owners and
vendors/subcontractors. Cash flow is then calculated based on both the earning and payment terms
you specify, and the job's schedule and pay item prices.
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CASH FLOW DISPLAY SETTINGS

The Cash Flow Display Settings allow you to control what information displays on the Cash Flow graph.
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CASH FLOW EXAMPLE

Using the Period Quantities cost curve type as an example, on the Cash Flow graph, you can see that
50% of the total cost for this cost item, represented by the red line, is incurred in the first period of the
project. Half of the project’s cost is incurred during the first period of the project’s lifespan as
determined by what is entered in the cost item’s period quantities.

A reason why half of the project’s cost is being used during the first period could be that resources
available to perform the project happen to be mostly available during the front end of the project.
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After the first period, the project incurs the remaining balance of the total project cost of $95,000. This
is spread equally with quantities of $5,625 amongst the last three periods. This information helps you
to better understand when the owner provides payment, in addition to deciding if more project
funding or financing is needed.
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Perhaps most costs on this one item will be incurred at the end of the activity, such as a subcontractor
billing for most of his work as it nears completion. If it’s determined costs are incurred towards the end
of the activity, you can attribute most of the cost items quantity in the last period. You can add any
number of additional periods to a custom cost curve or to a cost curve defined by period quantities
curve and the costs will be proportionally spread across the actual number of periods defined by the
Cost Items start and finish dates and cash flow settings. Be aware reducing the number of periods in a
front or back end loaded curve may show a steeper total cost in some periods.

Using period quantities as the cost curve helps you determine how much of a cost item’s cost is going
to be spread in different durations of time.

PERIOD QUANTITIES

Like the other four cost curves, Period Quantities are used to customize cost curves, which show you a
graphical representation of the cash flow and resource utilization so you can assess the proper
financing and resource project needs. When the Period Quantities check box is selected, the Cost
Curve automatically changes to Cost Item Periods.
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The Period Quantity calculator uses the cost item quantity assigned to various periods to calculate the
specific percentages attributable to each range of periods covered by the cost item. The purpose of
using period quantities is to spread costs via the cost curve in the cash flow analysis. For example, if
you have an item where 50% of the cost is incurred when you start the work because you have to buy
all the material first, then you would want a customized cost curve to reflect that this is how the costs
will be incurred over time when building that work.

In the example below, since 50% of the cost is incurred when the project starts, period one's quantity
is 50% of 45,000 Forecast (T/O) Qty which is 22,500. The remaining costs are then spread equally
across the remaining three periods.
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You can also choose to select the Re-spread quantities button to spread the quantities equally among
the periods entered in the Number of Period Quantities field.
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STEP BY STEP — ADJUST SHIFT ARRANGEMENTS

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. Right-click on the row header for a cost item and select Open.

3. Select the Cost Item Setup tab in the lower-right portion of the form (the tab name may be
abbreviated).

4. In the Default Pay Rules data block, adjust your Composite Wage Scale as needed.

5. Under the Composite Wage Scale, adjust the number of hours and paid as needed

6. In the Default Shift Arrangements data block, make changes as needed.
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l For this example, we’ll make the following changes on the Clearing cost item:

l Composite Wage Scale – 80% Scale 1, 20% Scale 2.

l For every 10 hours worked, pay 10 hours.

l Default Shift Arrangements – Change Work Hours per Shift to 10.

5 .4 .2 NOTES

On the Cost Item Record, you can enter any cost item-specific instructions, parameters, or general
information on the Notes tab. Below are a few examples of the kinds of notes you might enter:

l For a Hauling cost item:  There should be very little waste. If so, we can spread it out in the right
of way at MP 111

l For a Structural Excavation and Backfill item:  The backfill cannot be the native material. Have
to use clean base rock

l For an Underground Pipe cost item:  The average depth is close to 10 ft.

You can use the Notes tab to reference cost item changes (e.g., changing shift
arrangements, changing a resource rate).
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5 .4 .3 MAN-HOUR FACTORS

For items that have known risks or potential resource concerns, you can apply a Man-Hour Factor to
take those risks into consideration.

Man-Hour factors are applied on the Man-Hour Factors tab on the Cost Item Record. Factors are
applied in relation to 1, where slower production is greater than 1 and faster production is less than 1.

Man-Hour Factors affect both Labor and Equipment Hours.

For example, if you predict production to be 20% slower due to weather concerns, you would type 1.2
in the weather factor field.

Even after defining a Man-Hour Factor, the Production tab will still display the original Production
values.

l To see the factored Production values, click the Customize Display link on the Production tab
and select Show Man-Hour Factors

l Both original and factored production are then displayed on the Production tab
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You can apply Man-Hour Factors to multiple cost items at once by Multi-Editing selected
cost items on the CBS Register.

5 .4 .4 UNIQUE IDENTIF IER

You may have noticed when you made changes on the Cost Item Setup tab, that the fields you changed
and the Cost Item Setup tab became highlighted, indicating they were altered from their original state.

InEight Inc.  |  Release 25.1 Page 259 of 411

Estimate Essentials User Guide 5.4 Cost Item Details



On the CBS Register, the cost item you edited now has a Unique Identifier in the row header indicating
the cost item was altered from the default values set in the project job properties or in the project
library of resources rates.

If you hover over the identifier, a pop-up menu appears indicating what data points were changed.
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This same identifier will show up for resources as well, if you make changes to the employed resource’s
cost to be different than the original resource rate imported from the Resource Rate Register.

5.4.4 .2 HIGHLIGHT UNIQUE (DELTA) TOGGLE

You can turn the highlighting of unique resource and cost item fields off and on from the Actions menu
of the Cost Item Record, under the View section.
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5 .4 .5 COST DRIVERS

Each type of resource has a default cost driver. For example, Labor resources are duration driven so
the cost driver is CI Duration, meaning their costs are driven by the duration of the cost item. If you
want an Operator to only be assigned to a specific cost item or work activity for half the time, you can
change its quantity to .5 and it will be driven by half of the cost item’s hours.

To enter work hours manually for the employed resource, you can change the Cost Driver option to CI
Quantity or Fixed.

With CI Quantity as your cost driver for the Operator, you can adjust the Work Hours manually, where
previously that column was read-only.

Let’s say you want your Operator to work specifically 80 hours.

However, since the resource is now quantity driven, if you change the Forecast (T/O) Quantity to 50
you will see that the work hours will still adjust from 12 to 40.
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If you want it set at 80 hours no matter what changes you make to your quantity, you can change the
cost driver to Fixed. Then when you change the Forecast Quantity to 500, the work hours for the
Operator will not change and will remain at 80 hours as shown below.

If you followed along and made any adjustments to cost item 2.1 Clearing, change the Cost Driver for
the Operator resource back to CI Duration and the Work Hours back to 100.

5 .4 .6 SUSPEND COST ITEMS

The Suspend feature allows you to turn cost items on and off in order to perform “what-if?” analysis or
evaluate alternative approaches to the work.

A cost item can be suspended in InEight Estimate for various reasons including the following:

l Manually suspended cost items

l Suspended parent

l Parent with cost source that is not Detail (plugged or quoted)

l Parent cost item with a zero quantity

l Pay item is suspended

l Allocated cost items

l Alternate scenarios:
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l Overridden by another alternate

l Alternative is not active

Suspended cost items do not contribute any cost to the job's total value. Suspended items can be un-
suspended at anytime in order to be included in the total project value.

STEP BY STEP — SUSPEND A COST ITEM

1. On the Cost Breakdown Structure (CBS) Register, select a cost item.

2. Right click on the selection and select Toggle Suspended from the menu.

l You can also select Toggle Suspended under the Edit section of the Actions tab up above

l You can also suspend cost items by checking the Suspend checkbox on the Cost Item Setup
tab of a cost item record

l If a superior cost item is suspended, its subordinate cost items are automatically
suspended as well

l The costs associated with these cost items will no longer contribute to the estimate
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5.4.6 .3 EDITABLE MAN-HOUR FACTORS IN SUSPENDED COST
ITEMS

You can edit Man-Hour Factors for a suspended cost item by creating and maintaining cost items,
including Man-Hour Factors. This can be accomplished in a suspended state while having the scope of
work included in your estimate. The cost to contribute is excluded from the scope of work until you are
ready to make it part of your estimate.

5.4.6 .4 UNSUSPEND A COST ITEM

Follow the step by step below to unsuspend a cost item.

STEP BY STEP — UNSUSPEND A COST ITEM

1. On the Cost Breakdown Structure (CBS) Register, select a cost item.

2. Right click on the selection and choose Toggle Suspended.

l You can also select Toggle Suspended from the Edit section of the Actions tab

l You can also unsuspend cost items by unchecking the Suspend checkbox on the Cost Item
Setup tab of a cost item record

5.4.6 .5 SUSPEND COLUMN

Within the CBS Register, the Suspend column indicates which cost items are suspended.
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l Hover over the checkmarks to see why the cost item is suspended

l You can suspend and unsuspend cost items by checking and unchecking the checkboxes in the
Suspend column as well

5 .4 .7 ADDING COST ADJUSTMENTS

Total Cost and Billing Adjustments can now be made in the CBS register which can be viewed either
from the Standard view of the CBS register, or a saved view affiliated with change.
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Adjustment fields have been added to the CBS to view and modify the adjustment amount and
adjustment percent without going into each individual cost item.

Any adjustment made to the Adjustment Amount fields on the CBS register will then have the
Adjustment Percent field automatically calculated. Changes made to those fields will be highlighted in
yellow signifying an adjustment has been made.

Other adjustments fields in the CBS register include the many adjustments fields that have been added
to the Billing Rates View.

A new Saved view called Cost Item Adjustment View has been added to the Cost Breakdown
Structure.
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EXERCISE 5.3 — MANAGE COST ITEM DETAILS

In this exercise, practice adjusting your cost item details. Complete the following steps, using your
Job:

1. Open the Cost Item record for cost item2.2 Grading.

2. From the Cost Item Setup tab, change the Composite Wage Scale to 80% Scale 1,
20%Scale 2. Also adjust for every10 hours worked, pay 10 hours.

3. Change the Default Shift Arrangements to 10Work Hours per Shift, 1 Shift per Day, 5Days
per Week.

4. From the Man-Hour Factors tab, apply a Man-Hour Factor of 1.1 to the same cost item.

5. On the Notes tab, type Added man-hour factor due to hard soil conditions.

You should end up with similar results.

Congratulations, you have completed this exercise!
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LESSON 5 REVIEW

1. Resources, costs, and production can only be added to what type of cost item?

a. Superior

b. Terminal

c. Parent

2. What Cost Source is used for defining resources and production?

a. Plug

b. Detail

c. Quote

3. On the Cost Item Record, what tab is used for changing the cost item’s Default Shift
Arrangements?

a. Cost Item Setup

b. Production

c. Man-Hour Factors

d. Notes

LESSON 5 SUMMARY

As a result of this lesson, you can:

l Explain the Cost Breakdown Structure and its purpose

l Create cost items

l Add costs and production

l Manage cost item details
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LESSON 6 — IND IRECT COSTS

LESSON DURATION: 45 MINUTES

LESSON OBJECTIVES

After completing this lesson, you will be able to:

l Explain how indirect costs are defined in InEight Estimate

l Estimate default indirect cost items

l Estimate user-defined indirect cost items

LESSON TOPICS



6 . 1 IND IRECT COSTS OVERV IEW

Indirect costs such as the cost of prime bond, mobilization, or site supplies are typically overhead costs
that are not directly associated with a particular project deliverable but contribute to the total cost of
the project. However, indirect costs can be assigned to a pay items. This gives you the flexibility to
more accurately control the cost basis of bid items and strategically price the work to maximize cost
recovery and profit.

Once your direct costs are defined, you can add indirect project costs. Estimate provides two ways you
can create indirect costs:

1. Default Indirect Cost Items:  These are pre-built cost items created by InEight Estimate, located
at the top of the CBS Register.

2. User-Defined Indirect Cost Items:  Any cost item you create in the CBS Register that is not
assigned to a pay item is considered indirect cost.
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The Cost Breakdown Structure (CBS) located in the Library under the Estimate tab,
Master Breakdown Structures section, controls which of the default indirect cost
items to copy into new job folders.

6 .1 .1 NAVIGATION TO INDIRECT COSTS

From the Estimate tab of the InEight Estimate landing page, you can quickly access indirect costs from
the Indirect Cost section.

l Select Indirect Cost Items to open the Cost Breakdown Structure Register filtered to only your
indirect costs

l You can select Prime Bond, Price % Add On, and Job Financing to access those indirects

The following section takes a closer look at the default indirect cost items.

6 . 2 DEFAULT IND IRECT COST ITEMS

InEight Estimate contains various default cost items to help you calculate your indirect costs.

6 .2 .1 INDEPENDENT INDIRECT COST ITEMS

Independent indirect cost items function very much like the direct cost items you defined previously:

l Job Management & Equipment

l General Expense

6.2.1 .1 JOB MANAGEMENT & EQUIPMENT

The sample Job Management & Equipment Record below shows that you can add resources and
production just like in your direct cost items. Supervisory staff resources were added, and the
production duration is set to 100 days.
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The following Step by Step walks you through defining resources and costs for your Job Management &
Equipment indirect cost item.

STEP BY STEP — ADD JOB MANAGEMENT & EQUIPMENT COSTS

1. In your job, from the Estimate landing page, select the Cost Breakdown Structure (CBS).

2. Double-click on the row header of the Job Management & Equipment indirect cost item.

3. Add resources by clicking in the Code column and selecting the Icon.

4. Select the Production tab.

5. Enter a production value.

6. Click OK to close the record.

l For this example, we'll add the following resources and production:
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STEP BY STEP — ADD GENERAL EXPENSE COSTS

1. From the Estimate tab, select the Cost Breakdown Structure (CBS).

2. Right-click the row header of the General Expense row header and select Open.

l You could add existing resources here, but in this case, you will create an ad hoc resource.

3. In the first blank row, enter a description, quantity and unit of measure.

4. Click on (highlight) that row, and then click the Resource Employment Breakdown tab.

5. Type a numeric value in the Undefined Supplies cost category.

6. Click Ok to close the record.

l For this example, we’ll add General Office Supplies, 1 Lump Sum, $1,000 in the Supplies
category.

6 .2 .2 DEPENDENT INDIRECT COST ITEMS

The other default indirect cost items are dependent indirect cost items, meaning their costs depend
on other costs, prices or hours. They include:

l Direct and Indirect Cost Add-On

l Direct and Indirect Cost Escalation

l Prime Bond

l Price % Add-On

l Job Financing
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l Man-Hour Add-On

It’s possible to assign any assigned or dependent cost Item to any of the 3 cost segments and provides
greater control over where costs exist in the Price Breakdown Structure (PBS).

6.2.2 .2 DEFAULT DEPENDENT COST ITEM DELETION

If you need to use additional dependent cost items, you can create your own, but you
must delete all the existing default dependent cost items first.

The following steps walk you through deleting your existing default indirect costs so you can create
your own.
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STEP BY STEP — DELETE EXISTING DEFAULT DEPENDENT COST
ITEMS

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. Select an Indirect Cost Item by clicking on its row header.

3. Press and hold the Ctrl or Shift key to select multiple indirect cost items.

4. Right-click on the selection and select Delete.

5. Select Yes to confirm you want to delete the selected cost items.

6.2.2 .3 PRIME BOND

The following steps walk you through adding and defining your prime bond for the job.

STEP BY STEP — DEFINE PRIME BOND

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. Right-click on the row header for any cost item and insert Dependent cost Item.

3. On the resulting Attention prompt, select Based on Bond Table.

4. Click OK.

5. Right-click on the Prime Bond row header and select Open.

6. Use the Table Name drop-down to choose a table (e.g., Example: General Construction).

7. Click OK to close the record.

MULTIPLE BOND RATE DEPENDENT ITEMS

For certain projects, it may be desirable to calculate costs for bond or insurance premiums based upon
multiple different rate tables. It is now possible to add multiple bond/rate table based dependent
items in the CBS.

For example, in addition to having a prime bond, the job may also require insurance coverage where
the premium is calculated using a rate table-based approach. This can now be accomplished by adding
another Bond/Rate-table based dependent cost item to the job.
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DELETING BOND TABLES

Delete bond tables that are not applicable to your estimate by selecting them and then clicking the
Delete button. You can customize the Bond Table window to only view the tables that are relevant to
your estimate from the Table Name drop-down list.

6.2.2 .4 PRICE % ADD-ON

The following steps walk you through defining the Price % Add-On.
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STEP BY STEP — DEFINE A PRICE % ADD-ON

1. From the Cost Breakdown Structure (CBS) Register, right-click on the row header for any cost
item and select Insert Dependent Cost Item.

2. On the resulting Attention prompt, select Based on Job’s Price.

3. Click OK.

4. Double-click on the Price % Add On row header to open the record.
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5. The Price % Add-on Record opens to the Description tab. Type a description in the Description
field and enter a numeric value for rate.

6. Click OK to close the record.

l For this example, we’ll enter a description of Office Overhead and a rate of 4%.

6.2.2 .5 DIRECT COST ADD-ON

The following steps walk you through creating a Direct Cost Add-On dependent cost item.

STEP BY STEP — DEFINE A DIRECT COST ADD-ON

1. From the Cost Breakdown Structure (CBS) Register, right-click on the row header for any cost
item and select Insert Dependent Cost Item.

2. On the resulting Attention prompt, select Based on Direct Costs.

3. Click OK.

4. Double-click on the Direct Cost Add-On row header.

5. On the Description tab, type a description in the Description column.
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6. Press the Tab key (you can define additional rows for other add-on costs as needed).

7. Click on the Dependency tab to see what contributes to your subject cost.

8. For this activity, leave the default (lower) button selected.

9. On the Cost Breakdown tab on the right, add an add-on rate (percentage) or cost at any of the
cost category levels you need.

l This updates the Total Cost (Forecast) of your item on the Description tab

10. Click OK to close the record.

l For this example, we’ll create a new Direct Cost Add-On, giving it a description of Small
Tools with a rate of 10% on the Labor cost category
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6.2.2 .6 REPOSITIONING DEPENDENT COST ITEMS

Repositioning dependent cost items creates a simpler way to manage the hierarchy of your project by
placing items of more importance ahead of other line items.

Since dependent cost items can now be repositioned, a Position Code field has been added with the
functionality similar to column remaining the same. The below listed dependent cost item fields are
now exposed in the CBS register so you can more easily see the various percentages used in dependent
items.

• Subject Cost

• Subject Cost Rate

• Subject Billing Amount

• Subject Billing Rate

These columns can also be found in the new saved view Bid Review.
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6 . 3 USER-DEF INED IND IRECT COST ITEMS

You may prefer to create your own indirect cost items. You create user-defined indirect cost items the
same way you create direct cost items. The only difference is that your indirect cost items will not be
assigned to pay items. One advantage of creating your own indirect cost items is the ability to create a
parent-child structure for your indirect costs.

Here is an example of user-defined indirect cost items, expanded to show their employed resources:
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STEP BY STEP — ADD USER-DEFINED INDIRECT COST ITEMS

Let’s walk through a specific scenario for this step by step.

1. At the bottom of your CBS, create an indirect cost item called Job Overhead with a Forecast
(T/O) Quantity of 1 and Unit of Measure of Each.

2. Add two subordinates under the new cost item named Job Trailer and Utilities. Job Trailer is 1
Each but change Utilities to 1 Lump Sum.

3. Open the Job Trailer cost item by double-clicking on the row header.

l Assuming there is no Job Trailer in our Resource Rate Register, you will create this
resource “on the fly”.

4. In the Detail grid, click on the Resource Register icon in the Code field as if you were going to
select from the Resource Rate Register.

5. On the Resource Rate Register, click the Rented Construction Equipment tab.
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6. Right-click on one of the Line Items and select New to add a new resource.

7. Enter a Resource Code of RJT and description of Job Trailer.

8. In the Amount column enter 25 for the Rented Equipment category.

9. Click OK to close the Resource Rate Record.

10. Select the new resource you created, then click OK to return to the cost item record.

11. On the cost item record, adjust the Job Trailer quantity to 2.

12. On the Production tab, enter 70 days.

13. Click OK to close the record.

14. On the CBS register, select the Utilities cost item by double-clicking on the row header.

15. Create an ad hoc resource on this cost item called Electricity, which will be 1 Lump Sum.

16. Finally, go to the Resource Employment Breakdown tab and enter 1500 in the Custom Category1
row.

17. Click OK to close the record.

6 . 4 COST ALLOCAT ION

The Cost Item Record - Allocation tab lets you to spread costs from a single Cost Item Record to one or
more other cost items in the Cost Breakdown Structure (CBS) Register.

l Allocation Item - The cost item to be allocated, where you define the quantities, resource
employments and the logic that determines how to allocate the item throughout the bid.

l Allocation Target - A cost item to be the recipient of allocated cost, as defined within the
Allocation Item. There may be one or many Allocation Targets for one Allocation Item.
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l Distribution - A read-only cost item in the CBS representing an Allocation Target's
proportional share of the Allocation Item.

You can choose from several methods to determine specifically where and how much cost to spread:

l Quantity - Specify the amount of the Allocation Item to be spread to each Allocation
Target.

l Proportionately based on another field - Allocate proportionately by one of many
available cost item values, usually based on time or cost.

l Percentage - Specify the percentage of the Allocation Item to spread to each Allocation
Target.

l Unit Cost - Use the unit cost from the Allocation Item and the quantity of each Allocation
Target to drive the Forecast (T/O) Quantity of the Allocation Item.

Cost Item Allocation is a good means of spreading costs throughout a bid for the purpose of
determining appropriate bid prices.

Only Level 1 cost items can be allocated, including Add-On and Escalation dependent cost
items. A subordinate cost item cannot be allocated, and a cost item that is assigned to a
pay item cannot be allocated.

6 .4 .1 COST ALLOCATION

With Cost Item Allocation, you can track the cost of one broad cost item by distributing the cost of that
item to other cost items, so that the cost can be tracked on a more detailed level. This gives better
visibility into the cost that makes up an item. For example, you can spread ST&S from one cost item to
multiple cost items that will use ST&S.

Imagine that a large portion of your scope of work for the job you are bidding has concrete. You face
the options of batching your own raw materials or purchasing the materials from a supplier. You can
use cost allocation to create the cost of a batch plant and allocate it to different items, and then
compare this unit cost to the unit cost of purchasing the materials from a supplier.

The Allocation tab allows you to spread costs from an Allocation Item to one or more Allocation Target
(s).

In the Allocation Target list, the [Unit of Measure] Quantity column caption displays the
Unit of Measure of the Allocation Item. For instance, if the Allocation Item's Unit of
Measure is Cubic Yards (CY), then the caption displayed for this column is CY Quantity.

A Distribution cost item is created as a read-only subordinate cost item under each Allocation Target. It
is copied proportionally with the quantity/cost defined to each different item in CBS.
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6 .4 .2 V IEW FILTER EXCLUDES COST ITEM
ALLOCATION DETAILS

A View Filter option is added to show only the level 1 cost item distribution in the allocation
destinations to provide you with a clear and comprehensive view of the CBS register, especially when
there are many allocations. When you are allocating cost items, the allocations are created in the
destination cost item by creating a copy of the entire allocated cost items structure. This filter allows
you to simplify the view by displaying only the parent level allocation cost item.

STEP BY STEP — COST ALLOCATION

1. From the Ribbon, select the Estimate tab.

2. Under the Breakdown Structures section, select Cost Breakdown Structure (CBS). The
Cost Breakdown Structure Register opens.

3. Select the Concrete Batch Plant cost item.
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4. From the Ribbon, select the Actions tab. Under the Edit section, select Open. The Cost
Item Record opens.

5. Select the Allocation tab.

6. Check the box for Allocate this Item’s Cost. Keep the By Quantity option selected.

7. Check the Include box for the cost item Box Culvert Footing to allocate cost to it.
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Take note of the Allocation Percentage and Total Cost to be Allocated columns.
This shows the percent of the total allocation qty allocated to that cost item and
the total cost to be allocated to that item (notice that is the total cost of the
Concrete Batch Plant).

8. The Box Culvert Footing item just gained all of the Concrete Batch Plant’s distribution
cost items (highlighted in purple). Navigate back to the CBS Register.

9. Find the Box Culvert Footing cost item. The distribution cost items are added as its
subordinates.
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10. In the Cost Item Record, check the Include box for the cost items, Box Culvert Walls and
Box Culvert Deck.

11. In the Account Code column, click on the Filter icon. Filter to account code 13 for all of the
concrete items. Once done, click OK.
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12. Select the Erect and Strip Deck code, hold <Shift>, and select the Footer code to muli-
select all of the codes in between. Then, tight click and select Toggle Included.

13. Check the Include box in the Include column for the cost item Column, round. The CY
Quantity is now highlighted yellow. This is because this cost item’s UoM is Each and not
CY.

14. Right click on the Account Code column, and select Clear Filter from the context menu.

15. Under the cost item Column, round, the subordinate cost item Place Column Concrete
has a UoM of CY. Manually enter that cost item’s Forecast (T/O) Quantity into the Column,
round’s CY Quantity field.

16. Select the Account Code filter and reselect the option 13.

17. In the Include column, check the Include box for all of the remaining cost items with this
filter. Then, remove the Account Code filter.

18. Fix the CY quantity for the other Column, round cost item.
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19. Fix the CY quantity for the Drilled Shaft Foundation (60”) cost item.

20. 20. Fix the CY quantity for the Drilled Shaft Foundation (72”) cost item.

21. Notice in the Allocation Details section, that we have over-allocated this cost item. The
Concrete Batch Plant quantity is 1,000 CY, whereas we have allocated 1,172.59 CY.
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6 .4 .3 COST ALLOCATION TO BY UNIT COST

Having an under allocation or over allocation is ok, but it can be fixed by updating the Forecast (T/O)
Quantity of the Concrete Batch Plant. To do this, change the cost allocation to by Unit Cost.

STEP BY STEP — COST ALLOCATION BY UNIT COST

1. Change the cost allocation to by Unit Cost. When the Attention dialog box appears, click
Yes to continue.

2. Now the Allocation Details warning states the quantities are fully allocated.
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3. Notice also that the Forecast (T/O) Quantity of the Concrete Batch Plant has updated to
1,172.59 CY to match the allocated quantity, and the Total Cost has updated to
$96,030.20 to keep the unit cost at the original $81.90/CY.

4. Return to the CBS Register. The distributed cost items all have a unit cost of $81.90.

5. The original “Concrete Batch Plant” cost item has a total cost of $96,030.20.
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6. Navigate to the CBS Register. Double click the Project Indirect Costs cost item to open it.

7. Select the Allocation tab. Check the box for Allocate this Item’s Cost.

8. Select the proportionately based on radio button. From the drop down, select Shifts
(Total).
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9. Filter the Account Code column to 13. Once done, click OK.
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10. Select all of the cost items. Then, right click on the selected cost items and select Toggle
included. Ensure that all of the Included boxes are checked.

11. On the CBS Register, verify that all of the items have cost items distributed proportionately
by shifts.
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6 . 5 DEPENDENT COST ITEM ALLOCAT ION

STEP BY STEP — DEPENDENT COST ITEM ALLOCATION

1. From the CBS Register, right click on the first cost item and select Insert Dependent Cost
Item from the context menu.

2. When the Attention dialog box shows, select Based on Direct Costs. Once done, click
OK.
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3. Find your new cost item. Then double click to open the cost item record.

4. In the CBS Position Code Description, enter the description Small Tools & Supplies.

5. Enter in the cost item, “ST&S”.
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6. In the Cost Breakdown default data block, set the labor rate as 5%.

7. In the Cost Item Record, select the Cost Categorization tab.

8. Under the Cost Categorization Method, select the Use Custom Categorization radio
button.

9. Find the Supplies Cost Category and check the box next to Supplies.

10. Select the Allocation tab. Then, check the box for Allocate this Item’s Cost.

11. Select the proportionately based on radio button. From the drop down, select Labor Total
Cost.
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12. In the Cost Item Record, filter the Account Code column to 13. Once you are done
selecting the filter, click OK.
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13. In the Cost Item Record, check the Include box in the Include column for every cost item.

14. Return to the CBS Register. The ST&S is distributed to all of the selected cost items.
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6 .5 .1 TURNING OFF COST ALLOCATION

If you determine that you no longer want to spread the cost of an Allocation Item, you can turn off cost
allocation for that cost item. The logic that you created to spread the costs are retained, so you can
easily turn it back on later.

Distributions cannot exist in the CBS when a job is published for Job Tracking. To remove
Distributions, either break the Cost Allocation link or uncheck the Allocate this Item’s
Cost check box on the Cost Item Record - Allocation tab.

STEP BY STEP — TURNING OFF COST ALLOCATION

1. From the CBS Register, select the Concrete Batch Plant Cost Item Record.

2. From the Ribbon, select the Actions tab. Under the Edit section, select Open. The Cost
Item Record opens.

3. Select the Allocation tab. Uncheck the box for Allocate this Item’s Cost.
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4. Once done, click OK to return to the CBS Register.

5. All of the distribution cost items are gone, but the quantity and the total cost of the
Concrete Batch Plant has not changed.

6 .5 .2 BREAKING A COST ALLOCATION LINK

To make a Distribution a permanent part of the CBS, and permit its costs and quantities to be directly
editable under the cost item(s) to which it has been distributed, break the Cost Allocation link.
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STEP BY STEP — BREAKING A COST ALLOCATION LINK

1. From the CBS Register, select the Project Indirect Costs Cost Item Record.

2. From the Ribbon, select the Actions tab. Under the Edit section, select Open. The Cost
Item Record opens.

3. Select the Allocation tab. Then go to the CBS Register in the record.

4. Select the cost item with a Cost Allocation Link. Then from the Ribbon, select the Actions
tab.

5. Under Tools, select Break Cost Allocation Link.

6. When the Attention dialog box shows, click Yes to continue.

7. The original cost item still exists and is now becomes editable. All the distribution cost
items are now editable as well. They are now permanent items and are no longer
highlighted in purple either.

InEight Inc.  |  Release 25.1 Page 307 of 411

Estimate Essentials User Guide 6.5 Dependent Cost Item Allocation



6 .5 .3 PAY ITEM ASSIGNMENT FOR ALLOCATION
DISTRIBUTION IN AN UNLOCKED JOB

In the Cost Item Record - Allocation tab, the check box Allocation distributions inherit target Pay
Item Assignment was added. When the check box is selected in an unlocked job, the system uses the
same allocation distribution for the cost item’s costs anytime the cost item is copied and added to a
job. For a locked job, this is the normal system behavior. This option is always selected and cannot be
edited.
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EXERCISE 6.1 — DEFINE INDIRECT COSTS

In this exercise, you will practice entering Indirect Costs. Complete the following steps, using your
Job:

1. Double click on the Price % Add On row header.

2. You already have Office Overhead as your first line item. In the next blank row type
Corporate Insurance in the Description field and enter a rate of .10.

3. Click OK to close the record.

4. Double click on the Direct Cost Add-On row header.

5. You already have Small Tools as your first line item. On the Description tab, type Safety &
Training in the next blank row’s Description field, then press Tab.

6. The Dependency Cost Breakdown appears on the right. Enter a rate of 5 for Labor Costs
only.

7. Click OK to close the record.

You should end up with similar results like below:
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Congratulations, you have completed this exercise!
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LESSON 6 REVIEW

1. Default indirect costs are pre-built _____ ______ created by InEight Estimate, located
within the CBS Register.

a. billing rates

b. cost items

c. pay items

2. By default, any cost item you create in the CBS Register that is not assigned to a pay item
is considered indirect cost.

a. True

b. False

3. The cost segment field in the CBS is used to indicate:

a. Whether your costs will be considered job overhead, business overhead, or direct
cost.

b. The source of your costs (Detail, Plug or Quote).

c. What pay item your cost item is assigned to.

LESSON 6 SUMMARY

As a result of this lesson, you can:

l Explain how indirect costs are defined in InEight Estimate

l Estimate default indirect cost items

l Estimate user-defined indirect cost items
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LESSON 8 — QUOTE MANAGEMENT

LESSON DURATION: 60 MINUTES

LESSON OBJECTIVES

After completing this lesson, you will be able to:

l Create and publish RFQs

l Define quote pricing

l Compare and award quotes

l Create and analyze scope items

LESSON TOPICS



8 . 1 QUOTE MANAGEMENT OVERV IEW

8 .1 .1 QUOTE MANAGEMENT WORKFLOW

When you make the decision to send out RFQs (Requests for Quote), as the estimator you will outline
the specifications for the request, select the vendors you wish to contact, and issue the request for
quotes.

When you receive quotes back from vendors, you can enter their pricing into InEight Estimate, where
you can compare them, award them, and update your CBS costs in one fluid process without the need
to re-enter data in multiple locations. InEight Estimate lets you enter multiple vendor quotes to enable
price comparison.

Awarding a quote in InEight Estimate does not mean the vendor is awarded the contract,
but rather that their price is selected as the carrying cost in the bid.

InEight Estimate provides a built-in workflow for managing your quotes, consisting of three steps:

1. Creating and publishing Requests for Quote (RFQs)

2. Updating quotes with vendor/subcontractor pricing

3. Comparing and awarding quotes

InEight Estimate has a separate form to manage each step:

1. Request for Quote (RFQ) Register

2. Quote Register

3. Quote Comparison & Award

8 .1 .2 QUOTES AND QUOTE GROUPS

Typically, an estimate contains two types of quotes:
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1. Quotes for resources (materials, equipment) purchased or rented from suppliers.

2. Quotes for subcontracted work.

In InEight Estimate, quotes from suppliers are managed at the resource level. In other words, you can
use material resources to represent the items purchased from the supplier.

For the cost items in your project that you plan to subcontract, you can manage quotes at the cost
item level, using the cost items themselves as the descriptions on the quote request.

You can use Quote Groups to group together multiple resources or cost items that will be sent in an
RFQ package. Using quote group tags can save a great deal of time generating packages of items to
request quotes for.

8.1.2 .1 RESOURCE LEVEL QUOTE GROUPS

When sending out quotes, you may want to organize your resources into groups based on the type of
material, such as pipe, aggregate, or concrete. When creating Requests for Quote, you will be able to
select your pre-defined quote group and it will bring all the related resources along with it. You can
assign quote groups using a pre-defined tag called a Quote Group in the Resource Rate Register.

Below is an example of resources with a quote group assigned:

8.1.2 .2 CBS LEVEL QUOTE GROUPS

For your subcontracted items, you can assign quote groups at the cost item level to group together
subcontractor work, such as Commercial Work or Landscaping Work. These labels are assigned using a
pre-defined tag called Quote Group in the Cost Breakdown Structure register.
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8 . 2 REQUESTS FOR QUOTE

Requests for Quote (RFQs) are invitations to sellers that include a requested list of items or
services/pricing and terms. When you create an RFQ in InEight Estimate, you are able to indicate the
line items you want to include in the quote, and the vendor(s) to whom you want to send it.

8 .2 .1 REQUEST FOR QUOTE (RFQ) REGISTER
OVERVIEW

To access the Request for Quote (RFQ) Register, from the InEight Estimate landing page, select the
Quote tab, then click on Request for Quote (RFQ).

l The RFQ register lists all of the RFQs you’ve created, with a Description, a Status, and a Response
Deadline Date
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8 .2 .2 REQUEST FOR QUOTE (RFQ) RECORD

You can double click on the row header, or right-click on any request for quote in the Request for
Quote Register and choose Open to access an existing Request for Quote (RFQ) Record.

Name Definition

1 RFQ
Description

Each record contains a Description, Deadline Date and Deadline Time
fields to identify the RFQ and indicate when a response is due.

2 RFQ Tabs The record is organized into tabs where you can define the items for the
quote, terms & conditions, and the seller companies to receive the RFQ.

3 Status and
Published
Data

The Status and Published Date let you know if it is new or published (sent
out), and when it was published.

Overview – Request for Quote (RFQ) Record
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8 .2 .3 CREATE AN RFQ

When putting together your RFQs, you will be able to select the appropriate material resources and
cost items for which you need quotes in your estimate. To create a new RFQ, you have a few options:

l Create RFQ from scratch:  This creates an empty RFQ Record for you to define

l Create RFQ from Quote Group Tag(s):  This option lets you create an RFQ from a quote group so
you can add multiple materials or subcontract items at once

l Create RFQ using Default Seller data:  In your address book you can store vendors with a list of
their default materials. This option lets you select the vendor and have it automatically find their
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materials in the job

The rest of this section walks through each tab on the RFQ Record in more detail.

8.2.3 .1 LINE ITEMS

The Line Items tab lists the resources or cost items selected for the RFQ, including the Description,
Quantity, Quote Group, Currency and other user-defined tags.
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8.2.3 .2 TERMS & CONDITIONS

This tab provides ample space for you to enter terms, conditions and instructions that need to be
included on the RFQ.

8.2.3 .3 VENDOR COMPANIES

You will use the Vendor Companies tab to select the suppliers or subcontractors that will be receiving
the RFQ. This is done by selecting them from the Estimate Library Address Book. This tab will store all
of the pertinent contact information for each seller, including their fax number and/or email address
so that you can send them the RFQ.
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The following options are particularly noteworthy:

l Publish Item Quantities:  If you want the RFQ to specify your take-off quantities, select this
checkbox. If you want to keep that information to yourself and let the vendors or contractors
determine their own quantities, deselect this checkbox

l Publish by Fax:  If you choose to publish by fax, InEight Estimate creates a Word document with
a template filled out. It is ready to print and send, but you have the opportunity to double-check
the information before emailing the RFQ

When RFQs are generated for multiple vendors using the Publish by Fax option, be
sure to separate the MS Word document pages and send only the correct pages to
each vendor.

l Publish by Email:  If you choose to publish by email, the Word document is created, the
template is filled out, it is attached to an email, and automatically sent to the email address
listed for that vendor in the Address Book

When using the Publish by Email option, the process is automatic and it does not
give you the opportunity to double check your information before the RFQ is
emailed. For this reason, it is recommended to Publish by Fax, review the
information, and then email the RFQ manually.

8 .2 .4 ATTACHMENTS

This tab allows you to specify any electronic files that need to be attached to the RFQ, such as drawings
or specifications for the work.
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8 .2 .5 SETUP

The Setup tab lets you indicate what information will display on the published RFQ template, including
custom tags. In addition to selecting tags and adding notes on the Setup tab, you can also specify your
RFQ Publication Settings and can choose whether you want to include the instructions, special terms
and conditions, notes and attachments.
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8 .2 .6 PUBL ISH AN RFQ

Once created, InEight Estimate allows you to generate a Microsoft Word RFQ template that can be
faxed or manually sent via email to the supplier or subcontractor.

When you complete all of the fields that are required for this RFQ, you are ready to publish the RFQ, To
do so, select all of the vendors that you want to receive the RFQ and click Actions > Publish on the RFQ
Record ribbon.

STEP BY STEP — CREATE AND PUBLISH AN RFQ

This exercise walks through a specific example using the Training Job.

1. From the Estimate landing page, select the Quote tab.

2. Select Request for Quote (RFQ).

3. From the Actions tab, click on the New icon to create a new RFQ.

4. Select Create RFQ from Quote Group Tag(s), leaving the checkboxes checked to only show
quote groups and resources that are being used.

5. Select the Aggregates quote group from the right panel.

6. Click OK.

7. In the Response Deadline Date field, select a date two weeks from today, and for the Response
Deadline Time, type a time stamp (e.g. 11:00 am).

8. Select the Terms & Conditions tab.

9. Create and type Prices are good for the duration of the contract in the Buyer’s Special Terms &
Conditions field.

10. Type in All items to be delivered to jobsite by supplier’s trucks in the RFQ Instructions field.

11. Select the Vendor Companies tab and click in the first blank row in the Company Name column.
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12. Click on the Address book icon, and then select the following example vendors:

l Example Vendor 1: Pat Roberts

l Example Vendor 2: Stan Mark

l Example Vendor 4: Lester Slim

13. Click OK.

14. Make sure Publish to File is checked for all vendors.

15. Uncheck Publish by email for each vendor.

16. Select the sellers to whom you want to send the RFQ.

l Word opens the file automatically for you to review; and from here you can either print it
or send it in an email as an attachment
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l

17. On the Actions tab of the record, select Publish to create your RFQ document.

18. Select the folder to publish to.

19. Click OK to save the RFQ Record.

8 .2 .7 RFQ EMAIL DRAFT

When sending out Requests for Quotes (RFQ) on a bid, it is essential to be able to effectively
communicate the project requirements to potential subs or suppliers to ensure you have good quote
coverage within your estimate. Email RFQs open as a draft email message, giving you, the sender, the
opportunity to control specifically what is sent and customize the message before sending it out to
subs and suppliers.
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8 . 3 QUOTES

When you receive responses to your RFQ, the next step is to enter their pricing in the Quote Register.
The Quote Register stores all of the quotes you have for that job. Each quote has a Description and a
Quote Status, and each quote displays seller contact information.

In this case, an estimator in charge of receiving quotes would need to determine how best to input
these quotes within the Quote register.

Page 326 of 411 InEight Inc.  |  Release 25.1

8.3 Quotes Estimate Essentials User Guide



8 .3 .1 SAMPLE RECEIVED QUOTE SCOPE SHEET

Name Description

1 Section one Scope item one includes 4 items the subcontractor has considered as
work to be done onsite. You may want to consider adding all 4 items as
individual quotes. Then creating a package identifying these quotes as
on-site work, totaling $203,000.

2 Section two Scope item two includes 3 items the subcontractor has considered as
work to be done offsite. You may want to consider adding all 3 items
as individual quotes. Then creating a package identifying these quotes
as offsite work, totaling $24,650.

3 Exclusions The subcontractor is showing 9 items they excluded from their scope of
responsibility.

4 Qualifications The subcontractor has included 3 stipulations pertaining to this bid. If
selected all 3 are considered accepted terms.

Overview – Received Quote Scope Sheet
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8 .3 .2 QUOTE REGISTER OVERVIEW

To access the Quote Register, choose Quote > Quotes on the main InEight Estimate menu or click the
Quotes icon on the toolbar.
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8 .3 .3 QUOTE RECORD OVERVIEW

The Quote Record establishes who the vendor is, along with quoted prices and all terms and
conditions. Once a requested quote returns, you can either create the quote in InEight Estimate from
scratch or convert the original RFQ to a quote and enter the supplier or subcontractor pricing. Each
Quote Record contains additional fields and options for managing the quote.

Quote Records utilize data blocks allowing you to reposition tabs, detach tabs into individual windows,
and redock tabs in new locations. Using the data blocks layout, you can input and maintain important
quote data like Vendor Qualifications and Special Terms & Conditions.

Right click on any existing quote in the Quote Register and choose Open to access the Quote Record.

Name Description

1 Header
block

You can include detailed contact information about the supplier or
subcontractor. This automatically fills when you select the seller from the
Address Book. The External Ref field can be used to access information
specific to the bid/quote.

2 Price
block

The Price data block contains a breakdown of pricing information for the
quote, including taxes, item conditions, and special conditions.

3 Quote
tabs

The tabs at the bottom of the screen hold detailed information regarding the
quote.

4 Default
Data
Blocks

Data blocks include Special Terms & Conditions, Qualifications, Packages,
Taxes, Vendor's Profile, Setup, and Minority.

Overview – Quote Record
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8 .3 .4 HEADER BLOCK

The Header block portion of the screen is where you enter in description information pertaining to the
quote, along with vendor/contractor information.

There is an External Ref field you can use as a hyperlink for attaching any supporting bid quote
attachments from the vendor/contractor.

On the right portion of the header block is where you enter optional information related to:

l Optional Code – a code used to reference the received quote.

l Date – date the quote is received.

l Source – this is the method by which the quote was received. The options are email, fax, hard
copy, phone, and other.

l Currency – system of money in general use for a particular country..

l Ignore – by ignoring the quote, and providing a reason, the quote will turn grey in the Quote
Comparison & Award screen.

8.3.4 .1 QUOTE RECORDS

The Quote record header block includes a vendor field with a searchable address book library register
drop-down list. You can select shared vendor data to populate your quote header record with
Platform’s shared master data.
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Using Platform’s shared data also reinforces accurate Estimate quote reporting. For example, you can
report on which vendors and contacts have been awarded quotes or run a report on how many RFQs
have been sent to select vendors and how many RFQs were returned for certain jobs. Additionally,
using Platform shared vendors makes it possible to report on all activity related to a particular vendor.
Examples include seeing how many subcontract agreements have been executed in InEight Contract,
or how many claims/issues a vendor has been involved with in InEight Change. The predominant value
for Estimate using Platform vendors, along with other InEight applications, ensures that the same
vendors are being used by all applications.

8 .3 .5 PRICE BLOCK

The Price block includes the quotes extended price, along with any additional taxes, bonds, item
conditions, and special conditions.

8 .3 .6 QUOTE RECORD TABS

8.3.6 .2 RESOURCES & COST ITEMS

The Resources & Cost Items tab displays the resources or cost items quoted, along with their estimated
quantities and units of measure.
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l A Unit Price column is included on this tab for entering the quoted pricing from the seller, either
manually or by pasting from an electronic format

l If a Package code is entered, the Unit Price field is greyed out, and the Package code amount is
used

l Additional columns are provided for making conditional amount or percentage adjustments to
the quote to manage last-minute changes

l A note field is included for explanation changes

l A No Split option indicates that the seller will only provide the quoted goods or services if they
are selected to provide all listed items. They will not provide one quoted item without you
procuring all others from them as well.

l You can check an item as Free for circumstances where the vendor will include the price of one
item with another. Marking the included item(s) as free reminds you there is no quoted price for
that item

COST ITEM TAGS AND USER DEFINED FIELDS

There are 25 tag fields in the Quote Record register cost items tab. There are also 15 user defined
fields that let you sort, filter, and group on selected quote records more efficiently.

For example, you can use tags and user-defined fields to isolate certain cost items, or group cost items
together.

Page 332 of 411 InEight Inc.  |  Release 25.1

8.3 Quotes Estimate Essentials User Guide



8 .3 .7 DATA BLOCKS

The Quote Record utilizes data blocks that allows you to customize the layout and focus on data block
tabs that matter most to you. You can select the default data block action in the ribbon to revert back
to the default setting, which shows all six data blocks.

Data Block tabs include:

l Special Terms & Conditions

l Qualifications

l Packages

l Taxes

l Vendor's Profile

l Setup

l Minority

The seven data blocks appear at the bottom right of the screen.
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It’s possible to move the entire data block, or individual data blocks to other parts of the screen. For
example, select the Special Terms & Conditions header row, and drag to the desired part of the screen.

Drop the data block on top of an arrow where you wish to land the data block.
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The data block will now reside on the left side of the screen.

You can also close a specific tab if it’s not commonly used. In this example, you can right click on a tab
(like Special Terms & Conditions) and select close.
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8 .3 .8 DATA BLOCK TABS

8.3.8 .3 SPECIAL TERMS & CONDITIONS

Special Terms & Conditions is where you can include buyers and sellers special terms, add fixed cost to
the quote, and include/exclude scope items.

8.3.8 .4 QUALIFICATIONS

This tab allows you to include bond. You can enter the bond rate and the system will calculate the total
Bond Cost or vise versa. This tab also allows you to enter insurance contact information and seller
license information. If the vendor in the address book already had this information, then this
information will get pre-filled when the seller is assigned to the Quote.
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8.3.8 .5 PACKAGES

Using the Packages feature lets you logically organize quotes into an arranged collection of like
grouped packaged quotes. You can determine how to enter quotes from subcontractors and classify
them into a package grouping. When you create a package within the Packages block, and give it a
monetary value, you can then assign that package code to one or more quote records. The package
code is limited to three characters.

When comparing various vendor quotes in the Quote Comparison and Award form, with each quote
containing its own scope of work, you can easily distinguish which items belong to each package. This
helps to identify which quotes to award in your decision-making process.

As an example, the following Civic Center Parking Structure quote has three packages defined in it. The
P1, P2, and P3 on the left represent the grouped package numbers that will be used to determine the
package structure in the quote record. The vendor that submitted this quote shows detailed estimates
defined for each of the three packaged items, but there is no breakdown provided in the quote of how
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much each line item is worth. Rather, this quote is showing a package price for each collection of items
(scope of work).
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Estimate's Package feature lets you pick all the cost items that belong to a particular package, then
assign the price to that collection of packages. It then proportionally distributes the total package price
across all of the corresponding cost items when comparing and awarding.

STEP BY STEP — CREATE A MULTI-PACKAGED QUOTE

1. From the InEight Estimate landing page, select the Quote tab.

2. Click on the Quotes icon under Quote Management.

3. Double click on an item (e.g. Pipe Materials).
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4. In the Description field, type in or replace the description.

5. In the Contact field, select a contact.

6. Click OK

7. Select the Cost Items tab on the left side of the screen.
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8. Add a cost item under Cost Items.

9. Then, add another cost item under Cost Items.

10. On the Packages tab, enter the following 2 new records:

l Code: P1

l Description: On Site

l Amount: $200,000

l Code: P2

l Description: Off Site

l Amount: $300,000
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11. Type in P1 under Package for cost item 7.

12. Type in P2 under Package for cost item 8.

13. Select OK.

14. Under the Quote Comparison and Award ribbon, select Cost Items.

15. Under Quote Groups, select Pipe Materials.

l Quote Comparison and Award shows the newly created quote with the associated
package quotes.
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l The Package Price can quickly be modified in the Quote Comparison and Award form by
selecting the Edit Package action in the Actions tab or by using the right click context
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menu.

8.3.8 .6 TAXES

Item Tax and Quote Tax have been combined to display on a single data block called Taxes. Using the
taxes feature allows you to add item taxes to each item's price. You can also add taxes to the quote.
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8.3.8 .7 SELLER’S PROFILE

The Seller’s Profile tab populates with address book notes and alternate contact information.

8.3.8 .8 SETUP

This tab provides extra space for any additional notes and tags to be assigned to the quote.
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8.3.8 .9 MINORITY

This tab allows you to determine if the seller qualifies for any type of minority business, and the ability
to apply a certification number.
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If any of your Data Blocks become deleted on a Quote Record, simply click the
Default Data Block icon.

8 .3 .9 CREATE A QUOTE FROM RFQ

Walk through the steps of creating a quote from an RFQ.

To create a quote from scratch, click the New icon on the Quote Register and fill in the
quote details and seller fields manually.

STEP BY STEP — CREATE A QUOTE FROM RFQ

This exercise walks through a specific example using the Training Job.
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1. From the Estimate landing page, select the Quote tab.

2. Select Request for Quote (RFQ).

3. Open the RFQ record for which you’ve received quotes.

4. Select the Vendor Companies tab and select the vendors for whom you need to create quotes.
In this case, select all the vendors.

5. From the Actions menu, select Create Quote.

6. Click OK on the Quotes created prompt.

7. Close the RFQ record and the RFQ register.

8 .3 .10 ENTER QUOTE DETAILS

Now that you have quotes created, you can enter pricing.

STEP BY STEP — ENTER QUOTE DETAILS

This exercise walks through a specific example using the Training Job.

1. To open the Quote Register, select Quote from the Estimate landing page.

2. Select Quotes from the Quote Management section.

3. Open the Aggregates Quote Record for Vendor 1 – Pat Roberts.

4. On the Resources tab, make sure No Split is unchecked for all items.

5. Also on the Resources tab, enter the following unit prices:

Resource Code Description Unit Price

MBR Aggregate Base Rock $8.00

MDIRTB Dirt Class B $6.00

6. Click OK to close the Quote Record.
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STEP BY STEP — CREATE A MULTI-PACKAGED QUOTE

1. From the InEight Estimate landing page, select the Quote tab.

2. Click on the Quotes icon under Quote Management.

3. Double click on an item (e.g. Pipe Materials).

4. In the Description field, type in or replace the description.

5. In the Contact field, select a contact.

6. Click OK

7. Select the Cost Items tab on the left side of the screen.
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8. Add a cost item under Cost Items.

9. Then, add another cost item under Cost Items.

10. On the Packages tab, enter the following 2 new records:

l Code: P1

l Description: On Site

l Amount: $200,000

l Code: P2

l Description: Off Site

l Amount: $300,000
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11. Type in P1 under Package for cost item 7.

12. Type in P2 under Package for cost item 8.

13. Select OK.

14. Under the Quote Comparison and Award ribbon, select Cost Items.

15. Under Quote Groups, select Pipe Materials.

l Quote Comparison and Award shows the newly created quote with the associated
package quotes.
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l The Package Price can quickly be modified in the Quote Comparison and Award form by
selecting the Edit Package action in the Actions tab or by using the right click context
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menu.

8 .3 .11 USE UNIT PRICE OR EXTENDED PRICE ON
QUOTE RECORD ITEM

It's possible to enter the Extended Price for a Quote Item, and the Unit Price is then calculated, which
makes entering quotes more efficient and results in less errors.
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8 .3 .12 DUPLICATING AN EXIST ING QUOTE

You can create a new quote by duplicating an existing quote from the Quote Compare & Award form.
Duplicate Quotes will contain the same scope as the quote that you previously copied.

STEP BY STEP — DUPLICATE AN EXISTING QUOTE

1. From the InEight Estimate landing page, select the Quote tab.

2. Select the Resources icon under Quote Comparison & Award.

3. Highlight any row under the Quote column you want to duplicate.

4. Select the Actions tab.

5. Under the Quotes section, select the Duplicate Quote icon.
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l The resources and prices from the quote you previously selected have been copied
into a new Quote Record.

6. From the Header block, enter in any missing information.

l The information listed in the Header block will not copy over to the duplicated quote.

7. Enter additional Cost Items in the Quote tabs data block.

l Check the default data blocks for any information you want to add to your duplicate
quote.

8. Once done, click OK.
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EXERCISE 8.1 — QUOTE MANAGEMENT

When you receive quotes from vendors, you will need to record their pricing and conditions in their
Estimate quote records. In this exercise, you will practice entering quote details. Enter the following
quote record details, using the Training Job:

Quote Name:
Aggregates

Seller Name: Example Vendor 2 - Stan Mark

Resource
Code

Description Unit Price

MBR Aggregate Base Rock $7.45

MDIRTB Dirt Class B Not Quoted (delete)

Special Instructions Seller is NOT willing to split items.

Quote
Name:
Aggregates

Seller Name: Example Vendor 4 - Lester Slim

Resource
Code

Description Unit Price

MBR Aggregate Base Rock $8.15

MDIRTB Dirt Class B FREE

Special Instructions Seller is NOT willing to split items.

You should end up with similar results like below:

Congratulations, you have completed this exercise!
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8 . 4 QUOTE COMPAR ISON & AWARD

Now that you’ve received quotes and entered pricing information, you will compare them to
determine which is the preferred vendor or contractor to carry their pricing in your estimate. The
Quote Comparison & Award forms improve visibility into comparative analytics, while increasing
efficiencies in populating the estimate with quoted values.

The Quote Comparison & Award screen is designed to closely match the layout of a vendor comparison
sheet. It’s designed to show all scope items with prices provided by multiple vendors and substitute
pricing where items have been excluded.

Now that you’ve entered contextual quote information in the Quote Register, the Quote Comparison &
Award screen provides you with the ability to make better, and more efficient determinations for
awarding the quote.

8 .4 .1 QUOTE COMPARISON & AWARD OVERVIEW

To open the Quote Comparison & Award form, select Quote > Quote Comparison & Award.

Name Definition

1 Resource and
Cost Item Filter

You can show either your quoted resources or cost items.

2 Quote Group
Filter

This section provides checkboxes to further filter your items. The
Quote Group Filter allows you to mark the quotes as reviewed.

3 Quote
Description and
Vendor

Your quotes display with the vendor name plus the quote description.

l Awarded items have an award symbol
If an item is designated as No Split, it has a chain link icon

l Awarded and Locked items have a lock symbol next to the award

symbol

4 Cost Source
Type

The cost source can either be a Plug or Detail type.

Overview – Quote Comparison and Award Form
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8 .4 .2 EDIT MODE

You can make last minute modifications to the quote price directly in the Quote Comparison and
Award form.

When in Edit mode, the quote item's price, unmodified by the quote's bond cost or special conditions,
can be updated. You can modify the Unit price or the Extended price for each of the quote items that
are not part of the package or marked as Free.

The updates made to quote items in Quote Compare and Award will update the estimate in real time
allowing you to see the impact of the changes in the estimate.

8 .4 .3 SUBSTITUTE VALUES

You can display a substitute value by selecting Actions > Substitute Values.

Notice the entered quotes. One of the vendors did not give pricing for three of the CBS items.
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When you compare this quote to the others, it can be difficult to see if the total cost of the quote is
high or low because it is missing some of the pricing. InEight Estimate can help you make an “apples to
apples” comparison by filling in a substitute price for items that are missing.

You can tell when it’s a substitute value because the price displays in italics.

InEight Estimate grabs the substitute value from one of four places:

1. Awarded splittable quote

2. Lowest splittable quote you’ve received

3. Detail (this only applies to quoting cost items)

4. Plug cost (the rate defined for that resource in InEight Estimate)

You can set the order for a substitute value by selecting Actions > Set Substitute Ranking.

On the resulting Substitute Ranking window, you can use the up and down arrows to change the
selection order. It will look from the top to the bottom of the list. The plug being in red represents the
most risk, while the Awarded Splittable Quote is the least risk. Users can modify the color coding of
these Substitute values by navigating to System Customize dialog and then selecting Substitute Quote
Ranking in the colors sections.
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Note that the substitute values are color-coded so that back on the Quote Comparison & Award form
you can see the source that your substitute value comes from. When you hover- over a substitute
value it displays the vendor whose substitute value has been used.

When you use a substitute value, it is included in your Comparable Total so you can have a more
realistic comparison of your quotes.
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8 .4 .4 D ISPLAY IGNORED QUOTES

You can view ignored quotes by selecting Actions > Ignored Quotes.

You can ignore a quote by right clicking on the subcontractor header, then selecting Edit Quote.

From the Quote Record screen, select the Ignore check box and also a Reason, then select OK.
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If the quote record is already awarded, you will not be able to select the Ignore option.

If the Ignored Quotes button is pressed, the ignored quote will display in grey. An ignored Quote
cannot be awarded. The ignored quotes get appended to the right end of the QC&A form.
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8 .4 .5 EXPORT QUOTE COMPARISON AND AWARD TO
MICROSOFT EXCEL

The Microsoft Excel file generated when you export the Quote Comparison & Award form closely
resembles the form in Estimate, so users of this output can more clearly understand what the
estimators knew when they made determinations on which numbers to carry.

The Quote Comparison & Award form changes frequently in the closing hours of a bid, which can
prompt estimators to keep track of what the subcontractor and supplier quotes might have looked like
at any point throughout the bid closing. Some estimators rely on such bid leveling information but do
not want to access live information directly in the application, making it crucial to produce an identical
output file of the Quote Compare & Award form at any given time.

To create the Quote Comparison & Award Excel file, click on the Export to Excel icon. Enter a file name
for the Excel file, and then click Save.
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8 .4 .6 ADDIT IONAL QUOTE COMPARISON AND AWARD
FUNCTIONS

The Quote Comparison and Award form contains other notable functions which improves the process
of selecting the quote that brings the greatest value to the estimate.

Name Definition

1 Asterisk next to
Quote Item

An Asterisk (*) is displayed on a quote to indicate when that quote
includes quote items appearing in other Quote groups.

2 Zero value
Plug/Detail

Award quotes to Plug or Detail when its value is zero.

3 Updated Quote
Items Tool tip

Quote Item Tool tip displays details including:
l Unit Price
l Extended Price
l Bond
l Taxes
l Special Conditions
l an indicator for a delta quote item

Overview – Additional Quote Comparison and Award Functions
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8 .4 .7 CONFIGURE TOTALS

You can display and sort additional Summary Totals, Special Conditions, and Last Updated fields by
selecting Actions > Configure Tools.
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The Options radio button give you better control for viewing totals at the tops of the screen or after
the quotes.

After selecting additional captions, the new fields appear at the bottom of the Quote Comparison &
Award screen. Notice that the caret symbol next to the Comparable totals in the below screenshot
indicates that the Quotes are sorted based on Comparable totals in an ascending order.

8 .4 .8 ADDING NOTES TO QUOTE COMPARISON &
AWARD

The Notes feature within the Configure Totals tool, allows you to quickly add, edit, and view notes for a
quote in the Quote Comparison & Award form. Having visibility into the notes such as phone
conversations with vendor/supplier, quotes that need clarification, or notes on other attributes will
help you in making better decisions on who to consider when awarding a particular quote.
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STEP BY STEP — ADD THE NOTES SECTION TO QUOTE COMPARISON
& AWARD FORM

1. From the InEight Estimate landing page, select the Quote tab.

2. Select the Resources icon under Quote Comparison & Award.

l Notice the absence of the Notes section. This is the default option until you follow the
next steps.

3. Select the Actions tab.

4. From the View section, select the Configure Totals icon.

5. Select the check box in the Visible column for the Notes caption.
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6. Select OK.

l The Notes section displays on the Quote Comparison & Award form.
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8 .4 .9 ALL QUOTE GROUPS LAYOUT

The All Quote Group icon, located within the Quote Comparison and Award ribbon, allows you to see
all the quote groups at the same time.

You can make appropriate quote group selections based on understanding how choosing a quote
group impacts the entire estimate. In addition, the quote groups layout provides you with the visibility
and flexibility in aligning scopes, and being able to perform an efficient comparison of various quotes.

Features of this layout include:

Name Definition

1 Totals per Quote
Group

Ability to see the Awarded Total Plug, Detail and Quote amount per
Quote Group

2 Total Awarded
Amount

Visibility into the Total Awarded Amount per Quote Group

3 Comparable totals Better visibility into the Comparable totals per Quote Group

4 Expand/Collapse Expand/Collapse individual or All Quote Groups to display the
quote items

Overview – Quote Groups Layout
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You can scan through all the quote groups in the estimate and see if you are carrying the most
appropriate quote. You can also review the Totals per Quote Group and better analyze the risks in the
estimate based on whether the cost is a plug number, detailed estimate or a quoted value.

8 .4 .10 COMPARE AND AWARD QUOTES

To award an item, right click on that item and select Award.
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The Award icon displays next to the awarded item(s).

Once you award a quote in InEight Estimate, you can see it adds the Awarded Total on the comparison
screen, and the pricing updates automatically in the Cost Breakdown Structure.
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You can award multiple Quote items by selecting all the items and then using the right
click context menu to award.

8.4.10.1 OPEN STATUS

If a quote is yellow, this indicates that the quote record is open in another screen. Closing out of the
quote record, will turn the record back to gray.

8.4.10.2 AWARD STATUS

The Award Status indicates whether or not all quotes are awarded within a quote group.
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8.4.10.3 REVIEW

You can keep track of what quote groups have been reviewed by checking the Reviewed check box.

This can be helpful when there are many quotes to track and several users managing them. If any
changes are made to quotes within a quote group after the quote group is marked as Reviewed, the
quote group will be highlighted in yellow to indicate something changed since the last review.

Once reviewed again after the changes, you can uncheck and check the Reviewed checkbox again to
indicate it is up to date, and the yellow highlighting disappears.

The following steps walk you through comparing and awarding the Aggregate quotes.

STEP BY STEP — COMPARE AND AWARD QUOTES

This exercise walks through a specific example using the Training Job.

1. From the main Estimate landing page select Quote>Quote Comparison & Award.

2. Select Resources on the Quote Comparison & Award ribbon.
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3. Under Quote Groups, select Aggregates.

4. Review the quotes to determine the lowest bidder:

l MDIRTB is marked as Free for Example Vendor 4 and their quote is not splitable.

l Vendor 2 Stan Mark did not give a quote for MDIRTB, so a substitute value is being used.

5. Vendor 2 has the lowest comparable amount for MBR Aggregate Base Rock and Vendor 1 has
the lowest comparable amount for MDIRTB, so you decide to award each respectively. Award
each of them by right-clicking on the value and selecting Award.

6. On the attention prompt click Yes.

8 .4 .11 PACKAGE ENTIRE QUOTE

The Package Entire Quote function allows you to mark an entire quote as a package. This is beneficial if
you are attempting to quickly update an existing detailed quote to a lump sum quote from the Quote
Record or Quote Compare and Award form.
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8 .4 .12 INCOMPLETE QUOTES

The Incomplete quotes status indicates if a quote includes quote items that do not yet have a price.
This is often the case when vendors respond to an RFQ expressing interest in bidding but do not
provide their prices until right before the bid is due. These quotes display in gray in the Quote Compare
and Award form.

Incomplete Quotes that are Scope Only can be viewed in the Quote Compare and Award form using
the Zero Items toggle. These are quotes that have none of the Items priced. These quotes are
displayed to the right of all the Comparable Quotes.
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8 . 5 SCOPE ITEMS

During the bidding process, it’s common for subcontractors and suppliers to provide a quote(s) for
work during the tail end of the bidding process. These last-minute offers make it extremely difficult for
you to evaluate and compare the various quotes and your ability to award them. With scope items,
you can create and evaluate checklists and quote group exclusions, and account for them within the
Quote Comparison and Award form.

You can view scope items as a checklist of items that break down the quote’s scope of work into
individual tasks to aid in the process of evaluating subcontractor and supplier quotes in greater detail.
This can be used to ensure that certain items of work are included or excluded. If excluded, the scope
items need to be properly accounted for by contractor awarding the quote.

Section Description

Seller’s
Special
Terms &
Conditions

By default, all scope items are considered included in the quote, and the Special
Conditions amount is $0.00. On the quote record, by selecting the checkbox, you
can indicate scope items and uncheck items that are not included. The amount
associated with these items will then total up in the Special Conditions subtotal.
The person responsible for awarding quotes needs to update the Inclusions field
to correspond with what the subcontractor has agreed to include in the quote.

Overview – Quote Record – Scope Items
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Section Description

1 Scope Items Quote Comparison and Award checklist items for your quote that help
with evaluating subcontractor and supplier quotes in greater detail. This is
used to ensure certain items are either included (inclusion) or excluded
(exclusion) in the quote and accounted for by the entity awarding the
quote.

2 Scope Item
Inclusions

Maintained in Quote Record form. These are the Seller’s Special Terms
& Conditions scope items that the subcontractor is including in their
quote price. When the scope item contains a value, the subcontractor is
agreeing to perform the work. 

3 Scope Item
Exclusions

Maintained in Quote record form. These are the Seller’s Special Terms &
Conditions scope items price. If the Inclusions checkbox is blank, the

Overview – Quote Comparison and Award – Scope Items

InEight Inc.  |  Release 25.1 Page 377 of 411

Estimate Essentials User Guide 8.5 Scope Items



Section Description

subcontractor is NOT agreeing to perform the scope items.

4 Scope Item
value

An entered value means that the subcontractor is excluding this scope of
work. However, you may add an amount because this scope could incur
a cost. Once the bid is awarded, you may find another subcontractor to
perform the work. You are simply accounting for a cost for this scope of
work. In the example below, HD Engineering is not going to paint the
electrical equipment, but you know the cost is $150.00. You are showing
this cost to account the cost for this scope of work that needs to happen.

5 Seller’s
Special
Terms &
Conditions

By default, all scope items are considered included in the quote, and the
Special Conditions amount is $0.00. On the quote record, by selecting
this checkbox, you can indicate scope items and uncheck items that are
not included. The amount associated with these items will then total up in
the Special Conditions subtotal. The person responsible for awarding
quotes needs to update the Inclusions field to correspond with what the
subcontractor has agreed to include in the quote.

Overview – Quote Comparison and Award – Scope Items (continued)

The example below in the Quote Register form shows quotes from two subcontractors, both with
different quote prices. It is important to understand all scope of work the subs are quoting. By just
viewing these quotes alone, it’s difficult to understand which quote will provide you with the best
value. In other words, just because Example Sub #3 is the lowest priced quote, does not mean it is the
best quote to go with.
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The example below in Quote Comparison and Award shows that HD Engineering Group is excluding 3
scope items in their quote that totals $950. This provides a more granular picture for what is being
included within each subcontractor’s scope of work. It also displays how much each scope of work
costs, so you have the option to find another subcontractor to perform this scope work.

Utilizing Scope Items enables you to more effectively compare quotes from subcontractors and
suppliers by providing a deeper comparison of quotes. Moreover, it provides clearer visibility of what a
proposal may or may not be including at the time you are attempting to make an award.

You can make a more informed decision on whom to award the quote to, now that the vendor quotes
and associated scope items are all visible on one screen.

8 .5 .1 SCOPE ITEM SETUP

Scope items are stored within each quote group tag in the Foundation Setup Data form. On each
Quote Group Tag Record, you can list out scope items that break down the work into smaller scopes of
work, along with the estimated cost amount associated with each scope item.
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STEP BY STEP — SET UP SCOPE ITEMS

This exercise walks through a specific example using the Training Job.

1. Open your job.

2. Select the Setup tab.

3. Click on Foundation Data Setup in the Initialize section.

4. Select the Quote group tags tab to set up scope items within a quote group.

5. Create a new Quote Group Tag called Electrical Work and click Ok.

6. Open Electrical Work and add the following scope items:

l Permits

l Surveying and Layout

l Temporary Traffic Control Devices

l Trench and Backfill for Electrical Work
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l Painting Electrical Equipment

l Temporary Power and Lighting

7. Enter 500 in the Amount field for Survey and Layout, and a 300 for Temporary Power and
Lighting.

8. Click Ok.

STEP BY STEP — SET UP QUOTES FOR SCOPE ITEMS

This exercise walks through a specific example using the Training Job.

1. From the Estimate tab, click on Cost Breakdown Structure (CBS).

2. Change your saved views to Quote Group Setup view.

3. Create a cost item Entry Gate with a subordinate Electrical Work.

4. Assign the Electrical Work quote group to the Electrical work cost item.

5. From the Quote tab, click Request for Quote (RFQ) to open the RFQ register.

6. Create an RFQ by selecting the New icon on the Actions tab.

7. Select Create RFQ from Quote Group Tag(s) and select Electrical Work.

8. Click Ok.

9. Click on the Seller Companies tab and select the following company names:

l Architectural Designs

l HD Engineering Group
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10. Highlight both companies and select Publish.

11. Assuming you’ve already received quotes back from both companies, create a quote from this
RFQ for both companies by selecting the companies and selecting Create Quote.

12. Click Ok to close the RFQ record.

8 .5 .2 SCOPE ITEM CREATION AND AWARD

The following Step by Step assumes you are putting out an advertisement for bids for some electrical
work on a project. You will add scope items with some fixed costs as a special condition, then will
compare quotes in order to decide which vendor quote is the best deal.

STEP BY STEP — MANAGE AND AWARD SCOPE ITEMS

This exercise walks through a specific example using the Training Job.

1. Click the Quote tab and then click the Quotes icon to open the Quote register.

2. Open the Quote Record for HD Engineering Group and enter a Unit Price of 3,500 which is based
on the quote you received.
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3. Select the Special Terms & Conditions tab and select the Seller's Special Terms & Conditions
radio button.

4. Assuming the HD Engineering is excluding certain scope items from this quote, click on the
Included checkbox to exclude (uncheck) the following scope items:

l Surveying and Layout

l Painting Electrical Equipment

l Temporary Power and Lighting

5. Type 150 in the Amount field for Electrical Equipment.

l Notice how the 3 scope items you just excluded are now added to the Special Conditions total
for the quote.

6. Click Next to move to the other Quote record for Architectural Designs.

7. Enter a Unit Price of 3,700.

8. Press Tab to move to the Special Terms & Conditions tab and select the Seller's Special Terms &
Conditions (at right) radio button.

9. Uncheck the inclusions checkbox for Surveying and Layout.

10. Add the amount 500.

11. Click Ok.

12. Select the Quote tab.

13. Open the Quote Comparison and Award form, and select the Cost Items tab.

14. Under Quote Groups, select Electrical work.

15. Right-click on the quoted amount for Architectural Design and select Award to award the work
to them.

16. Click Yes on the resulting prompt to mark the quote group as reviewed.

8 . 6 QUOTE ITEM ADJUSTMENT

Quote items can be adjusted even after a quote has been awarded. This could happen on closing day
when a vendor sends in a last minute discount. For example, vendor 3 has sent in a 10% discount on
piping materials. This percentage discount is applied to the vendor 3 quote by entering the 10% in the
Condition Adjustment column.
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STEP BY STEP — QUOTE ITEM ADJUSTMENT

From the Ribbon, select the Quote tab.

1. Under the Quote Comparison and Award section, select Resources.

2. Locate a Vendor column.

3. Select the quote you want to edit under the vendor column. In the Ribbon, select the Actions
tab.

4. Under the Quotes section, select Edit Quote. You can also right-click and select Edit Quote. This
launches the Quote Record.

5. You can make Condition Adjustments by a percentage or an amount. Select the field to adjust
the percentage or amount of the Condition Adjustments.

6. Items adjustments can be applied individually or by using the multi-edit function. Select multiple
resources in the Quote Record, then right-click and select Open. This opens the Quote Resource
Item Record.

7. If you populate a 10% discount adjustment to all of the items selected using the multi-edit tool,
the amount value changes to “Varies”. This is because of the variance in the unit rates for each
selected item.

8. Click Ok to save the changes to the line items in the Quote record and to save the Quote.
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LESSON 8 REVIEW

1. When you receive responses to your RFQ, the next step is to enter their pricing in the
__________________.

a. CBS Register

b. PBS

c. Quote Register

d. RFQ Register

2. On a Quote Record, No Split means

a. The quote must be combined with other quotes from the same vendor

b. All items on the quote must be purchased from that seller

c. You can’t split the quote into multiple quotes

3. When a quote group is highlighted in yellow on the Quote Comparison & Award form, it
signifies that

a. The quote group has changed since it was last marked as Reviewed

b. No quotes have been awarded for that quote group

c. There are some quotes in the quote group that contain substitute values

LESSON 8 SUMMARY

As a result of this lesson, you can:

l Create and publish RFQs

l Define quote pricing

l Compare and award quotes

l Create and analyze scope items
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LESSON 9 — F INAL IZE THE
EST IMATE

This lesson is primarily suited towards contractors who must add profit or markup to their total
estimated cost, which will be submitted in the form of a bid or proposal. Most owners can divert from
this lesson as it's more geared towards adding profit and markup. There are a few use cases in which
an owner may wish to use the price breakdown structure. For example: to add risk, contingency, or
reserves if it is preferred, these are not shown directly in the budget line items. The price breakdown
structure also provides a summary level review of the total estimate and is a great reference during
estimate reviews.

LESSON DURATION: 45 MINUTES

LESSON OBJECTIVES

After completing this lesson, you will be able to:

l Add job markup (profit)

l Use tools on the PBS form to review your estimate

l Spread Target Price over pay items

l Make bid adjustments

LESSON TOPICS



9 . 1 JOB MARKUP (PROF IT )

On the Data Map  notice how the different segments within the pyramid coincide with the
percentage amounts that make up Direct Costs, Indirect Costs and Target Profit. Illustrations below
show how the Data Map values correspond to the values that make up the cost and profit.

To open the Data Map, select the Price tab, then Data Map from the Overhead and Profit section.

9 .1 .1 TARGET PRICE

For contractors building the price of your project is like building a pyramid. The foundation of your
price consists of the direct costs of the job.

The images below represent a default examples.

On top of your direct costs, you can decide if costs with a cost segment of business overhead should be
indirect costs or markup. You estimate your direct and indirect costs in the CBS Register.
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At the top of the pyramid you add an amount for profit. You add profit in the Price Breakdown
Structure (PBS) form. There is a very small block at the top of the Data Map, which comprises 0.22% of
Indirect Cost Markup.

The total of the direct cost, indirect cost, and profit in the project is referred to in InEight Estimate as
the Target Price. This is the final price that you want to submit as your proposal.
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9 .1 .2 PRICE BREAKDOWN STRUCTURE

As you already practiced, your direct and indirect costs are estimated in the CBS. Your project’s profit
needs to be defined in the Price Breakdown Structure (PBS) form.

The main purpose of the Price Breakdown Structure (PBS) is to add markup (profit) to the estimate.
The Price Breakdown Structure is a visual run-down of the costs and profit that make up your Target
Price. It helps you analyze how your costs contribute to the price you are targeting, including the
amount of profit you would like to include.

You can open the PBS from the InEight Estimate landing page by selecting the Price tab, then Price
Breakdown Structure (PBS) from the Overhead and Profit section.

Name Definition

1 PBS
Description

The left side of the screen displays several cost classifications:
l Target Profit
l Business Overhead
l Job Overhead
l Direct Cost

2 Various
Columns

The Assigned and Unassigned columns show which costs are either
assigned or not assigned to pay items. Unassigned costs are spread back
to pay items based on the distribution logic set in Job Properties > Pricing.
The Total columns represents a summation of both columns.
Each layer displays with an amount, and the percentage of the Target

Overview – Price Breakdown Structure
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Name Definition

Price that this amount represents.

3 PBS Menu The right side of the screen holds several tabbed pages of information.
This information is useful in analyzing the job at a summary level.

4 Refresh
Data

To ensure that you are always reviewing the most up-to-date factors and
ratios, click the Refresh Summary Data button whenever you are
reviewing the data.

Overview – Price Breakdown Structure (continued)

All costs in the Price Breakdown Structure are based on pay quantities (not forecast take-
off quantities).

9 .1 .3 MARKUP VS. MARGIN

Let’s look at the difference between Markup and Margin.

l Markup is a function of cost, while margin is a function of price

l Markup indicates how much you are marking up the cost

l Margin indicates what percentage of your price the markup represents

The percentages on the main PBS screen are margin, so you can see what percentage each category in
the PBS represents compared to the total price. If you enter 10% in the Target Profit field, your profit
will be 10% margin of your total price.
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When you open the Direct or Indirect Markup Records, the Rate percentage there indicates markup of
the cost. If you enter 10% markup on $100, the markup will be $10.

Within Job Properties, you can choose if costs with a cost segment of business overhead should be
indirect costs or markup. If selecting markup, then Business Overhead will be spread within the
Markup category of the Price Breakdown Structure. The Total Markup will be the sum of Target Profit
and all Items categorized as Business Overhead.

This lets you see the true total cost of the job, including the total markup inclusive of the business
overhead. You can also create cost items and categorize them as business overhead, then possibly
include overhead costs such as estimating or home office expenses. This provides you with added
flexibility in marking up your job.

9 .1 .4 DEFINE PROFIT

Before you define profit, review the PBS. You estimated your direct cost items, and you also estimated
some indirect cost items in the CBS. You can view your direct and indirect cost totals on the Price
Breakdown Structure. Notice you have not defined profit yet.
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You can define profit by entering a profit percentage directly on the PBS, or by modifying the Direct or
Indirect Cost Markup Records.

The following steps walk you through plugging a Target Profit percentage directly on the PBS form.

9.1.4 .1 PROFIT AS A PERCENTAGE OF TARGET PRICE

STEP BY STEP — ADD PROFIT AS A PERCENTAGE OF TARGET PRICE

1. Open your job.

2. Select the Price tab.
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3. Select Price Breakdown Structure (PBS) from the Overhead and Profit section.

4. On the Target Profit row, enter a numeric value in the % of Target Price column; press Tab.

l For this example, we’ll add 10% for the Target Profit.

9.1.4 .2 PROFIT THROUGH DIRECT COST MARKUP RECORD

The following steps walk you through how to add profit as markup on the Direct Cost Markup record.

STEP BY STEP — MODIFY THE DIRECT COST MARKUP RECORD

1. On the PBS form, double-click on the Direct Cost Markup row.

2. In the record, overwrite the Default entry with Direct Cost Markup in the description field.

3. In the Rate column on the Dependency Cost Breakdown, add a numeric value in Labor, Owned
Equipment, Materials and Fees categories. Then reset other categories back to 0.

4. Click Ok to save your changes and return to the PBS.

5. Click the Refresh Summary Data button to see the changes reflected.

l For this example, we’ll add a rate of 15 for Labor, 10 for Owned Equipment, 8 for Materials, and
2 for Fees, then zero out all other categories.

9 . 2 COST EST IMATE AUD IT /REV IEW

InEight Estimate offers built-in reports to double check your estimate and review different aspects of
your project, including material costs, quotes, man-hours and production.
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9 .2 .1 PRICE BREAKDOWN STRUCTURE TABS

The purpose of the tabs on the Price Breakdown Structure is to assist with estimate reviews.

9.2.1 .1 MARKUP ANALYSIS

On this tab, you can compare your profit to your costs for labor, subcontract and other cost groupings.
By seeing the ratios of your markup compared to your different cost categories, you can gauge if you
have the right balance of costs in your estimate.

For example, if your markup is more than 100% of your Labor cost, it may indicate that you don’t have
enough labor cost in your estimate to cover the work, which could indicate labor cost overruns during
execution that would eat into your profit margin.

9.2.1 .2 COST SOURCE

The Cost Source tab shows the breakdown of Detail, Plug and Quote cost sources, as well as the
amounts and percentages of each that are attributable to Direct and Indirect cost. Your Plug cost
source should be the lowest percentage.

InEight Inc.  |  Release 25.1 Page 395 of 411

Estimate Essentials User Guide 9.2 Cost Estimate Audit/Review



9.2.1 .3 RESOURCE UTILIZATION

The Resource Utilization tab shows a breakdown of the man-hours and equipment hours utilized on
the job, based on take-off quantities.

9.2.1 .4 SUBCONTRACT STATUS

The Subcontract Status tab displays a breakdown of subcontractor amounts, costs, and percentages for
quoted cost items. This is a good place to review how much of your estimate is subcontracted.

9.2.1 .5 VENDOR STATUS

The Vendor Status tab displays a breakdown of vendor information, including amounts and
percentages of the Target Price represented by vendors. This is a good place to review how much of
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your estimate costs come from vendor quotes.

9 . 3 SPREAD TARGET PR ICE OVER PAY ITEMS

In the Cost Breakdown Structure you generated your direct and indirect costs, and in the Price
Breakdown Structure you added profit to come up with a Target Price for the bid, but you still haven’t
decided how to spread the Target Price over your pay items.

In Lesson 4 you created pay items for the project in the Pay Item & Proposal Register. You can now go
back to the Pay Item & Proposal Register to distribute your Target Price over those pay items.

9 .3 .1 CURRENT PRICE VS. TARGET PRICE

In InEight Estimate, Current Price means the total price that is currently assigned on your pay items.
Open the Pay Item & Proposal Register to see what the Current Price is for your pay items (Price > Pay
Item & Proposal).

At this point there is no pricing on your pay items, so your Current Price is $0.00. This is because you
have not yet spread your Target Price (the total of your cost and profit) over your pay items.
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9 .3 .2 PROPOSAL RECAP

On the Pay Item & Proposal Register, there is a Proposal Recap table where you can compare your
Current Price to your Target Price to see if there is any variance.

Ideally, you want to add pricing to your pay items until your Current Price equals your Target Price, so
that your Variance equals zero. That way you know you are covering all your costs and getting the
profit you want.

Notice the Variance column will indicate if you need to ADD or CUT pricing on your pay items to hit
your Target Price.

9 .3 .3 SPREAD THE TARGET PRICE

For lump sum contracts, spreading the Target Price may be as simple as spreading it to a single pay
item that represents the entire project. However, most jobs will have at least a few pay items defined
by the owner, and Unit Price contracts will have many pay items.

There are two main ways to distribute pricing onto your pay items:

1. Define pay item prices manually, by entering a unit or total price, or a margin percentage.

2. Use InEight Estimate’s AutoPrice feature to distribute pricing automatically.

9 .3 .4 DEFINE PRIC ING FOR PAY ITEMS MANUALLY

First, you will walk through the process of defining pricing manually. This method requires filling in
each item’s price based solely on your own judgment.
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STEP BY STEP — DEFINE PRICING MANUALLY

1. From the Estimate landing page, select the Price tab.

2. Select Pay Item & Proposal from the Pay Items section.

3. Select a Pay Item row.

4. In either the Unit Price (current), Total Price (current), or % Margin field of a pay item, type a
numeric value.

For this example, we’ll do the following:

l Mobilization pay item – change Total Price (current) to $20,000.

l Clearing & Grubbing pay item – change % Margin to 5%.

9 .3 .5 USE AUTOPRICE TO BALANCE AND HIT THE
TARGET TOTAL

Perhaps you want to get a head start and have InEight Estimate spread your Target Price
proportionately over your pay items for you. This can be done using the InEight Estimate AutoPrice
feature.

Once distributed, you will still have the ability to adjust your pricing on pay items
manually as needed.

Look at how you can use the AutoPrice feature.

STEP BY STEP — USE AUTOPRICE TO BALANCE AND HIT THE
TARGET TOTAL

1. Open the your job in Estimate.

2. From the Estimate landing page, select the Price tab.

3. Click on Pay Item & Proposal to open the Pay Item & Proposal Register.
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4. On the Pay Item & Proposal Register menu, choose Actions > Balanced Bid > Hit Target Total.

5. Review the Proposal Recap and see that the Variance is now $0.00. Now that the job is balanced,
you can see that the Current Price and the Target Price are the same, indicating that the costs
and profit are spread proportionately over your pay items.

9 .3 .6 USE AUTOPRICE TO UNBALANCE AND HIT THE
TARGET TOTAL

The Autoprice to Unbalance feature in InEight Estimate can automatically distribute profit to account
for your over- and underrun items.

InEight Estimate will take profit from your underrun and put it on your overrun by using the Actions >
Unbalanced > Hit Target Total feature. The purpose is to maximize your profit by spreading it
strategically between these items.

STEP BY STEP — UNBALANCE HIT TARGET TOTAL

1. You may encounter overrun and/or underrun items in the Pay Item & Proposal Register of your
job.

2. If you do, highlight the row for each item to view it’s current balanced item recap.
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3. On the Pay Item & Proposal Register menu, choose Actions > Unbalanced Bid.

l You will see the changes reflected and how the profit was spread to your overrun and
underrun items

l In the example shown, highlighting each item will show that all your overhead and
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profit from Excavation was put onto Clearing & Grubbing.

9 . 4 SELECT IVE PAY ITEM MARKUP

Estimate has a streamlined process to estimate the cost of a project and price the work to ensure all
unassigned costs and markup are included in the final price of the project. For markup to be spread to
pay items, a weighted distribution method is used as determined in the Job Properties, Pricing tab. It
might be desirable for markup percentages to not be distributed, but rather directly applied to the
costs assigned to any particular pay item.

This option can be set to keep markup with assigned costs for establishing a pay item price.
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Additionally, this option can be used to isolate the markup and apply it only to specific pay items. The
following is an example of a dependent cost item being used to mark up the labor of select site work
pay items by 25%.
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EXERCISE 9.1 — MANUALLY PRICE PAY ITEMS

To finalize your bid proposal, you will apply final pricing (costs and profit) to your pay items either
manually or using the AutoPrice tool. In this exercise, you will practice entering prices manually for
your pay items. Complete the following steps, using your job.

1. Continue manually pricing items in the Pay Item & Proposal Register.

2. Type 2.75 in the Unit Price (current) column for pay item Excavation.

3. Type 2 in the % Margin field for pay item 4000 – 10” PVC Pipe.

4. Check your variance to see if you need to add or cut your current pricing to hit your
Target Price.

You should end up with similar results

Congratulations, you have completed this exercise!
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9 . 5 B ID ADJUSTMENTS

Often you will want to continue adjusting certain pay items and then rebalance to hit the target total.

9 .5 .1 LOCK PRICE

You can lock down a pay item price and it will not factor in future rebalancing.

STEP BY STEP — LOCK PRICE

1. Select the Lock Price checkbox on an item's row.

2. After making further adjustments in the next step by step, you will return to the Pay Item &
Proposal to rebalance.

l You can continue to adjust at previous levels aside from solely in the Pay Item & Proposal
Register

l For example, you could make a last-minute adjustment in the PBS or CBS. You can make
adjustments anywhere, but for this example an adjustment will be made in the Direct Cost
Add-On record at the CBS level

STEP BY STEP — MAKE LAST MINUTE BID ADJUSTMENTS

1. With your job open, select the Estimate tab.

2. Click on Cost Breakdown Structure to open the CBS.

3. Double click on the row header to open the Direct Cost Add-On dependent cost item record.
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4. Under the Description tab on the left, click in the blank row under the Description column.

5. Type in a description.

6. Make the adjustment by typing a numeric value in the Cost column of the Materials Cost
category under the Cost Breakdown section on the right.

l To make a cut, enter a negative value, i.e. -1000

7. Press the Tab key, and your adjustment will be reflected on the left-hand side.

8. Finally, return to the Pay Item & Proposal.

9. On the Actionsmenu, select Balanced Bid > Hit Target Total.

10. An Auto Price Warning may display, informing you of rounding variances. After reading the
details, click the Close button.

InEight Inc.  |  Release 25.1 Page 407 of 411

Estimate Essentials User Guide 9.5 Bid Adjustments



l Note on the proposal recap that a variance may still exists because there are limited
number of pay items to spread the rounding error over

l Note that the locked item did not adjust, but the other pay items were updated

l Note that you can overwrite locked items for spreading your price by checking the
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Overwrite Locked Pay Items option on the Actions menu

9 .5 .2 SUSPEND PAY ITEMS

Like suspending cost items in the CBS Register, you can suspend pay items in the Pay Item & Proposal
Register. Suspending a pay item causes it to no longer contribute quantities and pricing to the
estimate.

This can be helpful when considering alternate items on a bid submission. Should the client decide to
not require a pay item, you can suspend it, causing the pay item and any of its assigned cost items to
no longer contribute any cost or price. It will no longer show up on your bid and no longer contribute
to the overall total price.

You can suspend/unsuspend pay items in one of three ways:

l Right click on the pay item and select Toggle Suspended
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l Select the pay item and click Toggle Suspended under the Edit section of the Actions Tab

l Open the pay item record and checking/unchecking the Suspend box
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LESSON 9 REVIEW

1. Markup is a function of cost, while margin is a function of _________.

a. billing

b. price

c. job overhead

d. indirect costs

2. When adding profit, it must be the same amount for direct and indirect costs.

a. True

b. False

3. What options do you have to enter profit on the PBS?

a. %Mark-Up, % Margin, and Fixed Dollar Amount

b. %Mark-Up or % Margin

c. Fixed Dollar Amount Only

4. Once distributed, you still can adjust your pricing on pay items manually as needed.

a. True

b. False

LESSON 9 SUMMARY

As a result of this lesson, you can:

l Add job markup (profit)

l Use tools on the PBS form to review your estimate

l Spread Target Price over pay items

l Make bid adjustments
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